
Thermo

TraceFinder 
Version 1.1

User Guide

XCALI-97357 Revision A June 2011

http://www.surveymonkey.com/s/PQM6P62


© 2011 Thermo Fisher Scientific Inc. All rights reserved.

LCquan and TSQ Vantage are trademarks, and Xcalibur and TSQ Quantum are registered trademarks of 
Thermo Fisher Scientific Inc. in the United States.

NIST is a registered trademark of the National Institute of Standards and Technology in the United States.

Windows, Excel, and Windows Vista are registered trademarks of Microsoft Corporation in the United States 
and other countries. Adobe, Acrobat, Flash, and Reader are registered trademarks of Adobe Systems Inc. in the 
United States and other countries.

All other trademarks are the property of Thermo Fisher Scientific Inc. and its subsidiaries.
Thermo Fisher Scientific Inc. provides this document to its customers with a product purchase to use in the 
product operation. This document is copyright protected and any reproduction of the whole or any part of this 
document is strictly prohibited, except with the written authorization of Thermo Fisher Scientific Inc.

The contents of this document are subject to change without notice. All technical information in this 
document is for reference purposes only. System configurations and specifications in this document supersede 
all previous information received by the purchaser. 

Thermo Fisher Scientific Inc. makes no representations that this document is complete, accurate or error-
free and assumes no responsibility and will not be liable for any errors, omissions, damage or loss that might 
result from any use of this document, even if the information in the document is followed properly. 

This document is not part of any sales contract between Thermo Fisher Scientific Inc. and a purchaser. This 
document shall in no way govern or modify any Terms and Conditions of Sale, which Terms and Conditions of 
Sale shall govern all conflicting information between the two documents.
Release history: Revision A, June 2011

Minimum software requirements: Thermo Xcalibur 2.1.0 SP1; Microsoft Windows XP Professional SP3; 
(optional) Thermo LC Devices 2.5

For Research Use Only. Not for use in diagnostic procedures.



C

Contents
Preface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
Related Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
Special Notices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .viii
System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .viii
System Activation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .ix
Contacting Us  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xi

Chapter 1 Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1
About the TraceFinder Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
TraceFinder Summary of Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
TraceFinder Workflow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Reporting Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Standard Report Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Custom Report Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Target Screening Report Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Chapter 2 Getting Started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7
Installing the TraceFinder Application  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Installing the QED and NIST Libraries. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Launching the NIST Library Browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Launching the Qual Browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Converting Legacy Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Choosing a Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Chapter 3 Using the Configuration Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .27
User Administration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Choosing User Roles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Project Administration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Working with Drives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Working with Projects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Compound Datastore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Opening and Saving a Datastore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Adding Compounds, Quan Peaks, and Confirming Ions to a Datastore  . . . . 51
Choosing Experiment Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Thermo Scientific TraceFinder User Guide iii



Contents
Application Configuration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Specifying the Reports Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Specifying User Security  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Enabling a Compound Datastore  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Specifying Configuration Defaults. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Specifying Multiplexing Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Specifying Detection Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Enabling Target Screening. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Chapter 4 Using the Method Development Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .85
Working with Master Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

Creating a New Master Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
Editing a Master Method. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Creating a Method Template  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188
Importing Published Master Methods  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 198
Exporting SRM Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 199

Working with Instrument Methods. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
Working with Development Batches  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207

Creating a Development Batch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207
Editing Samples in a Development Batch  . . . . . . . . . . . . . . . . . . . . . . . . . . 210
Acquiring Samples in a Development Batch  . . . . . . . . . . . . . . . . . . . . . . . . 212
Viewing Raw Data Files in the Qual Browser  . . . . . . . . . . . . . . . . . . . . . . . 213

Chapter 5 Using the Acquisition Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .215
Working with Batches  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216

Opening and Navigating the Acquisition Mode  . . . . . . . . . . . . . . . . . . . . . 216
Creating Batches . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 218

Real-time Display  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
Acquisition Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
Instrument Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 248
Devices Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249
Queues Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253
Real-time Trace Display  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 257

Sample Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259

Chapter 6 Using the Data Review Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .261
Working in the Batch View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 262

Batch View Panes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263
Creating a New Batch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 264
Editing a Batch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 271
Editing Report Output Formats  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
Setting Compound Active Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276
Submitting a Batch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 278
iv TraceFinder User Guide Thermo Scientific



Contents
Working in Data Review View  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284
Samples List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 285
Quan Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 295
Qual Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313

Working in Report View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325
Viewing Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 326
Generating Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330
Working with Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333
Working with Active View  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 336

Working in the Local Method View  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 351

Appendix A Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .353
Specifying Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 353

Standard Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354
Custom Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355
Target Screening Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355

Report Flags  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 356
Sample Standard Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357

Batch Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 358
Batch Report Rev 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 359
Blank Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360
Calibration Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 361
Calibration Density Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 364
Check Standard Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 365
Chromatogram Report  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 366
Compound Calibration Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 367
Compound Calibration Report - Alternate  . . . . . . . . . . . . . . . . . . . . . . . . . 369
Confirmation Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 371
Confirmation Report 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 372
High Density Calibration Report  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 373
High Density Internal Standard Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . 374
High Density Internal Standard Report Long . . . . . . . . . . . . . . . . . . . . . . . 375
High Density Sample Report 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 376
High Density Sample Report 1 Long. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 377
High Density Sample Report 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 378
High Density Sample Report 2 Long. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 379
High Density Sample Report 3 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 380
High Density Sample Report 3 Long. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381
Internal Standard Summary Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 382
Ion Ratio Failure Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 383
LCSLCSD Report (Environmental and Food Safety only)  . . . . . . . . . . . . . 384
Manual Integration Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 385
Method Detection Limit Report (Environmental and Food Safety only) . . . 386
Method Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389
Method Validation Report (Environmental and Food Safety only) . . . . . . . 392
Thermo Scientific TraceFinder User Guide v



Contents
MSMSD Report (Environmental and Food Safety only) . . . . . . . . . . . . . . . 395
Quantitation Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396
Quantitation Report - 2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397
Solvent Blank Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399
Surrogate Recovery Report  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 400
TIC Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401
TIC Summary Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 402

Appendix B Using Copy Down and Fill Down . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .403

Appendix C Using Filter Criteria. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .407
Enter Filter Criteria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 408

Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .409
vi TraceFinder User Guide Thermo Scientific



P

Preface 

The TraceFinder application is the newest application in the series of Thermo Scientific 
LC/MS analytical software.

 To suggest changes to documentation or to Help

Complete a brief survey about this document by clicking the link below.
Thank you in advance for your help.

Related Documentation
The TraceFinder documentation includes Help that you can access from the application and 
also includes the TraceFinder User Guide and four quick reference guides as PDF files that you 
can access from the TraceFinder Help menu and the Windows Start menu.

 To view the TraceFinder user guide or quick reference guides

Go to Start > All Programs > Thermo TraceFinder > Manuals and choose one of the 
following documents:

– TraceFinder User Guide

– TraceFinder Administrator Quick Reference Guide

– TraceFinder Acquisition Quick Reference Guide

– TraceFinder Data Review Quick Reference Guide

– TraceFinder Shortcut Menus Quick Reference Guide

– TraceFinder Custom Reports Tutorial

Contents

• Related Documentation

• Special Notices

• System Requirements

• System Activation

• Contacting Us
Thermo Scientific  TraceFinder User Guide vii
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Preface
 To open TraceFinder Help

From the TraceFinder window, choose Help > TraceFinder Help. 

To find a particular topic, use the Help Contents, Index, or Search panes.

Special Notices
This guide includes the following types of special notices:

System Requirements
Your system must meet these minimum requirements.

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.

System Requirements

Computer • 2.33 GHz processor dual core with 2 GB RAM
• CD/R-ROM drive
• Video card and monitor capable of 1280 × 1024 resolution (XGA)
• 75 GB available on the C: drive
• NTFS format

Instruments 
(supported or 
required)

• AS3000 autosampler

Software • Microsoft™ Windows™ XP Professional SP3 
• Microsoft Office 2007 SP2 or Excel™ 2007 SP2
• Microsoft .NET Framework 3.5 SP 1
• Thermo Foundation™ 1.1 (available on the Xcalibur 2.1.0 CD)
• Thermo Xcalibur™ 2.1.0 SP1
• Adobe™ Reader™ 9.0
• NIST™ 2008
viii TraceFinder User Guide Thermo Scientific



Preface
System Activation
When you first start the TraceFinder application, a dialog box displays the number of days 
remaining on your 30-day free trial. If your free trial has expired, the License Activation 
window opens. 

Two types of licenses are available:

• 30-Day Evaluation Version (free of charge)

• Full Version Single License 

The evaluation version is full-featured and automatically expires 30 days after activation. Any 
attempt to set back the system date automatically terminates this version. You can purchase 
and then activate the full version of the TraceFinder application at any time, during or after 
the free evaluation, without reinstalling the software. 

Each activation key is valid only for a single license. Any additional installation generates a 
different license and requires a different activation key.

For questions regarding activation, contact Thermo Fisher Scientific Technical Support in 
San Jose, CA:

• E-mail: ThermoMSLicensing@thermofisher.com

• Fax: 408-965-6120

Note  You can open the License Activation window at any time during your trial period by 
choosing Help > License Activation from the TraceFinder menu. If you already have a 
permanent license, a message tells you that your product is fully licensed.
Thermo Scientific TraceFinder User Guide ix



Preface
 To request an activation key

1. In the License Activation window, enter your information in the User Info area.

As you type, the License Text box creates an XML text string with your information.

2. In the barcode box, type the barcode printed on the TraceFinder CD.

The form of the barcode number is either xxxx-xxxx-xxxx or xxxx-xxxx-xxxx-xxxx.

3. When you finish entering all your information, click Copy.

The application copies this XML text to the Clipboard.

If you have not completed all the information, a pop-up box opens, identifying the 
missing information.

4. Paste this XML text in the body of an e-mail and send the e-mail to 
ThermoMSLicensing@thermofisher.com.
x TraceFinder User Guide Thermo Scientific



Preface
 To use your activation key

1. When you receive your activation key, copy it from the e-mail.

2. Choose Help > License Activation from the TraceFinder menu.

The License Activation window opens.

3. Click Paste.

The application pastes the contents of the Clipboard to the License Text box.

4. Click Set.

The application is activated according to the type of authorization your license gives you. 

Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

 To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

 To contact Customer Service for ordering information

 To get local contact information for sales or service

Go to www.thermoscientific.com/wps/portal/ts/contactus.

 To copy manuals from the Internet

Go to mssupport.thermo.com, agree to the Terms and Conditions, and then click 
Customer Manuals in the left margin of the window. 

Note  You must run the TraceFinder application with ITAdmin or LabDirector rights 
when entering the activation key.

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site www.thermo.com/ms
Thermo Scientific TraceFinder User Guide xi
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 To suggest changes to documentation or to Help

• Fill out a reader survey online at www.surveymonkey.com/s/PQM6P62.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.
xii TraceFinder User Guide Thermo Scientific
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Introduction

This chapter describes the general features of TraceFinder software.

About the TraceFinder Application
The TraceFinder application targets general quantitation and environmental markets, creating 
the workflows that laboratories use. It supports a focused workflow for specific 
non-bioanalytical laboratory use, instrument control, and method development functionality 
in a single software package. The TraceFinder application is the primary application for the 
TSQ Quantum™ XLS triple quadrupole mass spectrometers.

The TraceFinder application can export SRM data in .xml format so that other applications 
can import the files into their databases. 

The TraceFinder application can import the following file types:
• Sample lists in .csv or .xml format
• Processing (.pmd) and instrument (.meth) method files from the Xcalibur data system 
• Compounds from files that use the datastore (.xml) format
• Batches or methods from the TraceFinder 1.0.1 application

The TraceFinder application checks the accuracy and precision of data against systems that 
have previously been certified against a standard processing program, such as the Statistical 
Analysis System (SAS).

Contents

• About the TraceFinder Application

• TraceFinder Summary of Features

• TraceFinder Workflow

• Reporting Features
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About the TraceFinder Application
Supported File Types

The TraceFinder application supports the following file types:

• Comma-separated values (.csv): A set of file formats used to store tabular data in which 
numbers and text are stored in plain textual form that can be read in a text editor. Lines in 
the text file represent rows of a table, and commas in a line separate fields in the tables 
row.

• Extensible Markup Language (.xml): A generic framework for storing any amount of text 
or any data whose structure can be represented as a tree. The only indispensable 
syntactical requirement is that the document has exactly one root element (also called the 
document element). This means that the text must be enclosed between a root start-tag 
and a corresponding end-tag.

• Instrument method (.meth): A proprietary file format for the Xcalibur software suite with 
specific instructions that enable scientific instruments to perform data acquisition.

• Processing method (.pmd): A proprietary file format for the Xcalibur software suite with 
specific instructions on processing data that was acquired through the instruments 
attached to the system.

• Raw data (.raw): The file type for acquired samples on the system.

TraceFinder Directory Structure

The TraceFinder application creates folders for projects/subprojects/batches and templates in 
the …\Thermo\TraceFinder directory. Within each batch folder, the application creates 
folders for data, methods, and reports.

Figure 1. Example batch directory structure

IMPORTANT  You cannot rename or move the folders created by the TraceFinder 
application.
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TraceFinder Summary of Features
The TraceFinder system provides a workflow-oriented approach to high-throughput 
quantitation. The system uses a batch-centric approach and tools to automate and speed up 
the processes of method creation, loading samples, automatically generating data, manually 
reviewing and editing results, and finalizing the data review and reporting process. 

The TraceFinder software package includes data acquisition, processing, reviewing, and 
reporting capabilities designed to assist analysts in both the general quantitation and the 
environmental and food safety applications. The application has a fully automated acquisition 
mode and a manual data review mode. You can use the data acquisition system to create and 
submit batches and monitor real-time review of results. 

The TraceFinder application uses a comprehensive processing method to provide improved 
handling of ion ratio calculations, reviewing, and reporting. In addition, it can compare the 
mass spectra and integrate the processes of data review and reporting. 

Key features include the following: 

• Role-based authorization for LabDirector, ITAdmin, Supervisor, Technician, and QAQC 
(quality assurance) roles

• Configuration mode for user administration, project administration, datastore 
administration, and application administration

• Method Development mode for editing instrument methods, setting processing and error 
flag parameters, and setting report options

• Acquisition mode that acts as a wizard to guide you in creating batches and running 
samples

• Data Review mode with batch views, data review, local method views, and report views

• Database-capable method development

• Quantification workflows, supporting capabilities present in the LCquan and LabForms 
applications

• Standard and customized report formats

Features of the common workflow core include the following:

• Acquisition and processing

• Peak detection

• Quantification to include calibration

• Error analysis and flag setting

• Reporting

• Data persistence

• Raw data file handling
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TraceFinder Workflow
The TraceFinder application is structured with a typical laboratory workflow in mind. The 
user creates a batch and the system injects samples into the instrument, runs the samples, 
analyzes the data, and generates a report. You can set up a master method for specific 
compound groups or assays that you expect to run in your lab. When you are ready to run a 
particular type of sample, select the appropriate method and begin. 

When using the TraceFinder application, follow these basic steps:

1. Create and save a master method in the Method Development mode. 

A master method combines the instrument method and processing method that define 
how the raw data is acquired and processed, how the error checking information evaluates 
the results, and how the results appear in reports. 

2. Create and submit a batch in the Acquisition mode. 

A batch lists samples for processing and reporting using a specified method. Each row of a 
batch represents a unique sample. 

3. Monitor the status of the batch in the Real Time Status view. 

The real-time display is visible from the dashboard and all the TraceFinder modes. You 
can begin another batch while you watch the real-time display of the currently acquiring 
batch.

4. Evaluate the data in the Acquisition mode. 

The Acquisition mode includes views where you can review batches, batch data, reports, 
and local methods.

5. View and print reports in the Report View of the Acquisition mode. 

Use the Report View to view or print the reports for the currently selected batch.

Note  At any time, you can quickly view the system status by looking in the lower 
right corner of the TraceFinder window. This area displays a green, yellow, or red LED 
and a description of the number of samples in the queue (if any). 
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Reporting Features
The report engine can generate several different types of reports designed to meet the needs of 
the laboratory, the laboratory's customers, and key regulatory agencies that might review the 
results. The TraceFinder application can produce both standard reports and custom reports. 
The following types of reports meet the requirements of various methods and worldwide 
regulatory agencies, helping to track the performance of LC systems and methods. The 
reports divide into three groups: Standard, Custom, and Target Screening.

For additional information about standard, custom, and target screening reports and a sample 
of each standard report type, see “Reports” on page 353. Examples of standard reports (as 
PDFs) are also located in the C:\Thermo\TraceFinder\1.1\ExampleReports folder.

Standard Report Types

• Batch Report 
• Batch Report Rev 1
• Blank Report 
• Calibration Report 
• Check Standard Report 
• Chromatogram Report 
• Compound Calibration Report 
• Compound Calibration Report - Alternate
• Confirmation Report 
• Confirmation Report 2
• High Density Calibration Report 
• High Density Internal Standard Report
• High Density Internal Standard Report Long
• High Density Sample Report 1 
• High Density Sample Report 1 Long
• High Density Sample Report 2 
• High Density Sample Report 2 Long 
• High Density Sample Report 3 
• High Density Sample Report 3 Long
• Internal Standard Summary Report 
• Ion Ratio Failure Report 
• LCSLCSD Report (Environmental and Food Safety only)
• Manual Integration Report 
• Method Detection Limit Report (Environmental and Food Safety only)
• Method Report 
• Method Validation Report (Environmental and Food Safety only)
• MSMSD Report (Environmental and Food Safety only)
• Quantitation Report 
• Quantitation Report - 2
• Solvent Blank Report 
• Surrogate Recovery Report 
• TIC Report 
• TIC Summary Report 
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Custom Report Types

• AltCalibrationReport
• Alternate BatchReport
• Alternate CalibrationReport
• Alternate ConfirmationReport
• Alternate MatrixSpikeReport
• Alternate SampleReport
• Alternate SummaryReport
• BatchReport
• BlankReport 
• CalibrationDensityReport 
• CalibrationReport 
• CheckStandardReport 
• CompoundCalibrationReport 
• ConfirmationReport 
• ConfirmationReport2
• HighDensitySampleReport1Long
• HighDensitySampleReport2Long
• HighDensitySampleReport3Long
• HighDensitySampleReport4
• HighDensitySampleReport5
• QuantitationReport
• SteroidAnalysisReport

Target Screening Report Types

Target Screening reports are available only when you enable the Target Screening features. See 
“Enabling Target Screening” on page 83.

• Target Screening Long Report
• Target Screening Summary Report
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Getting Started

This chapter describes the procedures for getting started with the TraceFinder application.

Contents

• Installing the TraceFinder Application

• Installing the QED and NIST Libraries

• Launching the NIST Library Browser

• Launching the Qual Browser

• Converting Legacy Data

• Choosing a Mode
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Installing the TraceFinder Application
Installing the TraceFinder Application
Follow these instructions to install, start, and log on to the TraceFinder application.

 To install the TraceFinder application

1. Follow the instructions on the included CDs to install the Xcalibur 2.1 data system and 
your instrument drivers.

2. Install the driver for your LC device and autosampler.

3. Insert the TraceFinder CD in the drive, and follow the on-screen instructions.

If the install windows do not automatically open, navigate to the Xinstall.exe file and 
launch it.

 To start the TraceFinder application

1. Configure your instruments.

You cannot configure your instruments while the TraceFinder application is running.

2. Double-click the TraceFinder application icon on your desktop, or go to Start > All 
Programs > Thermo TraceFinder > TraceFinder or TraceFinder EFS. 

By default, user security is not enabled and the application does not require a password. 
To enable user security, see “Specifying User Security” on page 66.

 To log on to the TraceFinder application (when user security is enabled)

1. Enter your assigned user name.

Before you can log on to the TraceFinder application, a system administrator must set up 
a user account for you. The administrator assigns you a user name and password and gives 
you permission to access specific modes. 

2. Enter your password.

If your user name or password do not match, the system reports this error:

Correct the user name or password, or contact your system administrator.

3. Click Login.

The TraceFinder dashboard opens. See “TraceFinder Dashboard” on page 25. 

4. To exit the TraceFinder application without logging on, click Exit TraceFinder.

IMPORTANT  If you are the administrator logging on for the first time with user 
security enabled, use Administrator/Password as the username/password. 
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Installing the TraceFinder Application
Figure 2. TraceFinder logon screen

Table 1. Logon screen parameters

Parameter Description

Username The user’s assigned user name.

Password The assigned password for the user name.

Login Verifies the user name and password, and displays the dashboard.

Exit TraceFinder Closes the TraceFinder application without logging on.
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Installing the QED and NIST Libraries
When you are using triple quad instruments, follow these instructions to install the NIST and 
QED libraries.

 To install the NIST library

1. Launch the XInstall executable file.

2. Click the NIST button.

The NIST 08 MS Search and AMDIS Setup wizard opens.

3. Follow the instructions in the setup wizard.

4. When the wizard prompts you to select a program folder, select C:\Thermo.

 To install the QED library

1. On your desktop, double-click the Xcalibur icon, .

The Thermo Xcalibur Roadmap opens.
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Installing the QED and NIST Libraries
2. Select Tools > Library Manager.

The Thermo Library Manager dialog box opens. The NIST library is displayed in the 
NIST Libraries list.

3. Click Add.

The Add Library dialog box opens.

4. Click Browse, and locate your QED library in the C:\Thermo folder.

5. Click OK.

The Xcalibur application reports that it has added the library to the NIST software.

6. Click Dismiss to close the message box.

The application adds the QED library to the NIST Libraries list in the Library Manager 
dialog box.
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Installing the QED and NIST Libraries
7. Click Exit in the Thermo Library Manager dialog box.

8. Start the TraceFinder application.

9. Go to the Method Development mode.

10. Click Method View in the navigation pane.

11. Choose File > New > Method Template from the main menu.

The QED NIST Library is listed in the Use These Libraries list in the Method Template 
Editor.
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Launching the NIST Library Browser
Use the NIST MS Search tool to search the NIST library.

 To open the NIST library browser

1. Choose Go > Launch Library Browser from the main menu.

The NIST MS Search window opens.

For detailed instructions about using the library browser, refer to the NIST MS Search 
window Help.
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Launching the Qual Browser 
Use the Qual Browser to view chromatograms and spectra from raw data files or qualitative 
processing results. 

 To open the Qual Browser

1. Choose Go > Launch Qual Browser from the main menu.

The Thermo Xcalibur Qual Browser opens.

For detailed instructions about using the Qual Browser, refer to the Qual Browser Help.
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Converting Legacy Data
Use the TraceFinder Legacy Data Converter to convert methods, batches, method templates, 
or batch templates from a previous version of TraceFinder to the current version.

To open the TraceFinder Legacy Data Converter, choose Go > Launch Legacy Data 
Converter from the main menu.

Use the following procedures:

• To convert a method

• To convert a batch

• To convert a method template

• To convert a batch template

 To convert a method 

1. In the Data Type list, select Method.

The TraceFinder Legacy Data Converter displays the interface for converting methods.

2. In the Source Version list, select a legacy version.

The legacy version defaults to TraceFinder 1.0.1.

3. In the Target Version list, select TraceFinder 1.1.

4. In the Target Drive list, select a fixed drive.

You cannot write the converted files to a mapped drive.

5. Click Add Method and browse to a method folder.

6. Select the method folder and click OK.

The application adds the method to the Methods to be Converted list:
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7. Repeat step 6 for each method you want to convert.

8. (Optional) In the New Name column, type a new name for each method that you want 
converted.

If you leave this column blank, the converted method keeps the old name.

9. Select the check box for each method you will convert, and click .

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the method that is currently 
converting.

When the Status column reports that the method is successfully converted, the 
application writes the converted file to the C:\Thermo\TraceFinder\1.1\Methods folder.

10. To view a log of the conversion, click View Log.

The application opens a log file for the session in a Notepad text editor window:

 To convert a batch

1. In the Data Type list, select Batch.

The TraceFinder Legacy Data Converter displays the interface for converting batches.

2. In the Source Version list, select a legacy version.

The legacy version defaults to TraceFinder 1.0.1.

3. In the Target Version list, select TraceFinder 1.1.
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4. In the Target Drive list, select a fixed drive.

You cannot write the converted files to a mapped drive.

5. Do one of the following to create a project and subproject for the converted batch:

In the Target Default Project and Subproject boxes, type the name of a project and 
subproject.

–Or–

Select the Replicate Original Project/Subproject check box.

6. Click Add Batch and browse to a batch folder.

7. Select the batch folder and click OK.

The application adds the batch to the Batches to be Converted list:

8. Repeat step 7 for each batch you want to convert.

9. (Optional) In the New Name column, type a new name for each batch that you want 
converted.

If you leave this column blank, the converted batch keeps the old name with “_1” 
appended.

10. Select the check box for each batch you will convert, and click .

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the batch that is currently 
converting.

When the Status column reports that the batch is successfully converted, the application 
writes the converted batch to the C:\Thermo\TraceFinder\1.1\Projects folder using either 
the original project and subproject names or the new names you entered.

11. To view a log of the conversion, click View Log.

The application opens a log file for the session in a Notepad text editor window.
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 To convert a method template

1. In the Data Type list, select Method Template.

The TraceFinder Legacy Data Converter displays the interface for converting method 
templates.

2. In the Source Version list, select a legacy version.

The legacy version defaults to TraceFinder 1.0.1.

3. In the Target Version list, select TraceFinder 1.1.

4. In the Target Drive list, select a fixed drive.

You cannot write the converted files to a mapped drive.

5. To add a single method template, do the following:

a. Click Add a Template and browse to the 
C:\Thermo\TraceFinder\1.0.1\Templates\Methods folder.

b. Select the method template (.pmtx) file and click Open.

The application adds the method template to the Method Templates to be Converted list:

6. To add all the method templates in the Methods folder, do the following:

a. Click Add a Folder and browse to the C:\Thermo\TraceFinder\1.0.1\Templates 
folder.

b. Select the Methods folder and click OK.

Note  The default folder for saved method templates is Templates\Methods. If you 
have templates in other folders, you can navigate to your folder.
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The application adds all the method templates in the folder to the Method Templates to 
be Converted list:

7. Repeat step 6 for each method template you want to convert.

8. (Optional) In the New Name column, type a new name for each method template that 
you want converted.

If you leave this column blank, the converted template keeps the old name with “_1” 
appended.

9. Select the check box for each method template you will convert, and click .

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the template that is currently 
converting.

When the Status column reports that the template is successfully converted, 
the application writes the converted template to the 
C:\Thermo\TraceFinder\1.1\Templates\Methods folder.

10. To view a log of the conversion, click View Log.

The application opens a log file for the session in a Notepad text editor window:
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 To convert a batch template

1. In the Data Type list, select Batch Template.

The TraceFinder Legacy Data Converter displays the interface for converting batch 
templates.

2. In the Source Version list, select a legacy version.

The legacy version defaults to TraceFinder 1.0.1.

3. In the Target Version list, select TraceFinder 1.1.

4. In the Target Drive list, select a fixed drive.

You cannot write the converted files to a mapped drive.

5. Click Add Template and browse to the C:\Thermo\TraceFinder\1.0.1\Templates\Batches 
folder.

6. Select the batch template folder and click OK.

The application adds the batch template to the Batch Templates to be Converted list:

7. Repeat step 6 for each batch template you want to convert.

8. (Optional) In the New Name column, type a new name for each batch template that you 
want converted.

If you leave this column blank, the converted template keeps the old name with “_1” 
appended.

9. Select the check box for each batch template you will convert, and click .

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the template that is currently 
converting.
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When the Status column reports that the template is successfully converted, 
the application writes the converted template folder to the 
C:\Thermo\TraceFinder\1.1\Templates\Batches folder.

10. To view a log of the conversion, click View Log.

The application opens a log file for the session in a Notepad text editor window:
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Choosing a Mode
When user security is enabled, the dashboard provides the current user with options 
applicable to the role assigned to that user. The following table shows the available modes for 
each user role.
 

Use the following procedures:

• To choose a mode

• To display a log of instrument errors

• To monitor the instrument status

• To  watch the real-time display from the dashboard

 To choose a mode

1. From the dashboard, click the mode in which you want to work.

Your dashboard shows only the modes that you have permission to use. See “TraceFinder 
Dashboard” on page 25. 

2. To change modes from within any of the TraceFinder application modes, click a mode 
button in the navigation pane.

Table 2. User roles and permissions 

User role Method 
Development Acquisition Data Review Configuration

LabDirector × × × ×

ITAdmin ×

Supervisor × × ×

Technician × ×

QAQC ×

Note  When user security is not enabled, all modes are available to all users.
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 To display a log of instrument errors 

1. Right-click the status light in the lower right corner of any mode.

2. Select Instrument Log.

The Instrument Log dialog box opens.

The Instrument Log displays all instrument errors that have occurred since the 
TraceFinder application started or since the last time you cleared the message log.

3. Do any of the following:

– Click Refresh to display errors that occur after you open the Instrument Log dialog 
box.

– Click Clear Messages to remove messages from the Instrument Log display.

The application clears messages only from the Instrument Log display. These 
messages remain in the following log file:

C:\Thermo\TraceFinder\1.1\Logs\TraceFinder.log 

– Click OK to dismiss the Instrument Log dialog box.

 To monitor the instrument status

To get immediate information about the instrument status, look at the LED in the lower 
right corner of the TraceFinder window. 

 Green: Indicates that the instrument is ready.

 Yellow: Indicates that the instrument is in standby mode.

 Red: Indicates that the instrument is turned off or no device is configured. 
Thermo Scientific TraceFinder User Guide 23



2 Getting Started
Choosing a Mode
 To watch the real-time display from the dashboard

Click Real Time Status.

The real-time status is displayed at the bottom of the dashboard.

For descriptions of all the features of the real-time display, see “Real-time Display” on 
page 246. 
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TraceFinder Dashboard

A dashboard for a user in the LabDirector role looks like this:

Table 3. TraceFinder dashboard screen parameters  (Sheet 1 of 2)

Parameter Description

Real Time Status Opens the real-time display for the current acquisition. The 
acquisition progress is displayed within the current mode window. 

Help Opens the TraceFinder Help.

Log Off Logs off the current user and displays the logon screen. This 
function is available only when user security is enabled. See 
“Specifying User Security” on page 66.

Acquisition Opens the Acquisition mode where you can create and review 
batches, batch data, reports, and local methods. See Chapter 5, 
“Using the Acquisition Mode.” 

Data Review Opens the Data Review mode where you can review batches, 
batch data, reports, and local methods. See Chapter 6, “Using the 
Data Review Mode.” 
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Method Development Opens the Method Development mode where you can create a 
master method, an instrument method, or a development batch. 
See Chapter 4, “Using the Method Development Mode.” 

Configuration Opens the Configuration mode where you can set permissions, 
assign users to roles, configure available reports and import new 
reports, and maintain the various databases, including the 
Compound Datastore. See Chapter 3, “Using the Configuration 
Mode.” 

Table 3. TraceFinder dashboard screen parameters  (Sheet 2 of 2)

Parameter Description
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Using the Configuration Mode

This chapter discusses the configuration tasks assigned to the ITAdmin and LabDirector roles.

Users in the role of ITAdmin or LabDirector are responsible for the following:

• Handling the databases

• Applying roles to users

• Understanding security, users, and groups

• Creating local users and network groups

• Creating projects and subprojects

• Maintaining compounds in the compounds datastore

 To access the Configuration mode

Click Configuration from the dashboard or the navigation pane.

The Configuration mode navigation pane opens.

Contents

• User Administration

• Project Administration

• Compound Datastore

• Application Configuration
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Figure 3. Configuration mode navigation pane

Table 4.  Configuration mode navigation pane functions  (Sheet 1 of 2)

Function Description

User Administration Opens the User Administration view where you can add, 
remove, or edit user accounts and permissions. See “User 
Administration” on page 30.

This task pane is available only when you have selected Enable 
User Security on the General page of the Application 
Configuration view. See “Application Configuration” on 
page 56.

Project Administration Opens the Project Administration view where you can create 
and manage projects and subprojects. See “Project 
Administration” on page 39.
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Compound Datastore Opens the Compound Datastore view where you can manage 
the definition of compounds in the current datastore. See 
“Compound Datastore” on page 44. 

This task pane is available only when you have selected Enable 
Compound Datastore on the General page of the Application 
Configuration view. See “Application Configuration” on 
page 56.

Application Configuration Opens the Application Configuration view where you can 
specify available reports, user security, compound datastore, 
reporting defaults, multiplexing, detection algorithms, and 
target screening. See “Application Configuration” on page 56. 

Table 4.  Configuration mode navigation pane functions  (Sheet 2 of 2)

Function Description
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User Administration
In the User Administration view of the Configuration mode, users in the role of LabDirector 
or ITAdmin can add, remove, or edit user accounts and permissions. 

For detailed descriptions of each user role and the permissions and responsibilities for each 
role, see “Choosing User Roles” on page 36.

Use the following procedures:

• To open the User Administration view

• To add a user

• To edit user information

• To change a user password

• To remove a user

 To open the User Administration view

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. 

2. Click the User Administration task pane.

The User Administration view opens. See “User Administration view” on page 34.

 To add a user

1. Click the Add User icon, .

The application enables the parameters in the User area at the bottom of the view. 

2. Type a unique name in the Username field.

Note  The User Administration view is available only when you enable user security. 
Follow the instructions “To turn on user security” on page 66.
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3. Select a role from the Role list.

All users must be assigned to one of these defined roles. For detailed information about 
the permissions allowed for each role, see “Choosing User Roles” on page 36.

4. Type the user’s password and type it again to the confirm it.

Make sure to communicate the password to the user.

5. (Optional) Type the user’s full name, account number, phone number, and e-mail 
address. 

6. To enable this user logon, select the Enabled check box.

You can disable a user logon without deleting the user’s information. Follow the 
instructions “To edit user information” on page 31. 

7. Do one of the following:

When all the user information is correct, click the Save Changes icon, .

The TraceFinder application adds the new user to the User Listing table, and the 
parameters in the User area are unavailable.

–Or–

To discard all information and not create a new user from 
the parameter values you entered, click the Cancel Changes icon, .

The application discards all information and the parameters in the User area are 
unavailable. 

 To edit user information

1. In the User Listing table, select a user.

The user information populates the parameter fields in the User area.

Note  Clicking anywhere in the row selects the user.
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2. Click the Edit User icon, .

The application enables the parameters in the User area.

3. Edit any of the parameter values.

If you are editing your own user name, the Enabled check box is unavailable because you 
cannot make your own account unavailable.

4. Do one of the following:

When all the user information is correct, click the Save Changes icon, .

The TraceFinder application adds the new parameter values to the User Listing, and the 
parameters in the User area are unavailable.

– Or–

To discard all changes and not save the edits, click the Cancel Changes icon, .

All changes are discarded, and the parameters in the User area are unavailable.

 To change a user password

1. In the User Listing table, select a user.

The user information populates the parameter fields in the User area.

2. Click the Edit User icon, .

The parameters in the User area are enabled.
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3. Click Reset Password.

The application makes the password and confirming password visible as a string of 
asterisks ******.

4. In the Password box, select the ****** and type a new password.

5. In the Confirm Password box, select the ****** and retype the new password.

6. Click the Save Changes icon, .

Make sure to communicate the new password to the user. 

 To remove a user

1. In the User Listing table, select a user.

The user information populates the parameter fields in the User area.

2. Click the Remove User icon, .

If you select your current user name, the Remove User icon is unavailable. You cannot 
remove yourself.

3. When prompted, confirm that you want to remove this user. 

If the user is currently logged on to the TraceFinder application, the user’s current session 
is not affected.

4. Click OK.

Note  Clicking anywhere in the row selects the user.

Note  Rather than completely removing the user, you can disable a user logon without 
removing all the user information from the system. Follow the instructions “To edit user 
information” on page 31. 
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Figure 4. User Administration view

Table 5. User Administration view parameters  (Sheet 1 of 2)

Parameter Description

Security Groups
All permission levels defined in the TraceFinder application. For detailed descriptions of 
user permissions, see “Choosing User Roles” on page 36.

User Listing

Username User logon names.

Role The security group that defines user permissions.

Account number User account numbers.

Phone number User telephone numbers.

Email address User e-mail addresses.

Enabled Available or unavailable status for the user account.

User

Username Logon name for the current user.

Role Security group that defines the current user’s permissions.

Password Logon password for the current user.

Full name The the current user’s actual name.

Account number Optional account number for the current user.

Phone number Optional telephone number for the current user.
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Email address E-mail address for the current user. Used to notify user of a randomly generated 
password.

Enabled Allows or disallows access for this user. When this user is currently logged on, disallowing 
takes effect after the user logs off.

Reset Password Makes the password visible as a string of asterisks so that you can select and change it.

Icon Function

 Add user Enables the fields in the User area where you can enter information for a new user.

 Remove user Deletes all information for the selected user.

 Edit user Enables the User area where you can edit any of the parameters for the selected user.

 Save changes Adds the new parameter values to the User Listing table and disables the parameters in 
the User area.

 Cancel changes Discards all new or edited information.

Table 5. User Administration view parameters  (Sheet 2 of 2)

Parameter Description
Thermo Scientific TraceFinder User Guide 35



3 Using the Configuration Mode
User Administration
Choosing User Roles 
This section describes the responsibilities for five different user roles when user security is 
enabled: LabDirector, ITAdmin, Supervisor, Technician, and QAQC.

User Permissions

A laboratory director or an IT administrator assigns you to a role that gives you permission to 
access specific modes of the TraceFinder application. When you log on, the dashboard 
displays links to only the modes that you can access.
 

LabDirector

In the LabDirector role, you review graphically applicable data and manipulate data, batches, 
methods, and instruments. 

A laboratory director is responsible for these tasks:

• Creating or editing methods for new levels of detection or adding new compounds to the 
existing database

• Reviewing data from the mass spectrometer

• Running samples and reviewing data collected by others

• Reporting the data

• Understanding the results and giving final approval of the released data before archiving

ITAdmin

In the ITAdmin role, you set security, manage users into roles, and manipulate the various 
databases. You are responsible for adding compounds into the various compound databases. 

An IT administrator is responsible for these tasks: 

• Handling the databases

• Applying roles to users

• Understanding security, users, and groups

• Creating local users and network groups

IMPORTANT  User roles are in effect only when user security is enabled. When user 
security is not enabled, all users have access to all modes.

Table 6. User roles and permissions 

User role Method 
Development Acquisition Data Review Configuration

LabDirector × × × ×
ITAdmin ×
Supervisor × × ×
Technician × ×
QAQC ×
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Supervisor

In the Supervisor role, you are responsible for setting up the instrument samples and using 
previously built sequences and methods for processing and acquiring data. You also develop 
and edit methods for processing and acquiring data, review the data, and distinguish between 
the need to rerun samples or pass reports up to the lab manager for final review. On a daily 
basis, you establish the priority for a list of samples to run and create the sequence of events.

A supervisor is responsible for these tasks: 

• Submitting samples 

• Creating and submitting batches

• Reporting the data to management

• Creating or editing methods for new levels of detection or adding new compounds to the 
existing database

• Reviewing data from the mass spectrometer

• Understanding the results, who ran the batch, and who passed along the results before 
giving intermediate approval and sending the data to management

• Modifying new compounds or adjusting methods for specific result sets

Technician

In the Technician role, you are responsible for setting up the instrument samples and using 
previously built sequences and methods for processing and acquiring data. You also edit 
existing methods for processing and acquiring data, review collected data, and distinguish 
between the need to rerun samples or pass reports up to the supervisor. On a daily basis, you 
are responsible for gathering the list of samples to run and creating the sequence of events. 

A technician is responsible for these tasks:

• Submitting samples 

• Creating and submitting batches

• Creating data to be reviewed by management

• Receiving instructions for new sets of samples for the TraceFinder application to analyze 
after finishing the current analysis

• Reviewing data from the mass spectrometer

• Understanding the resulting data, making integration changes, and passing those changes 
up for further approval
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QAQC

In the QAQC role, you review graphically applicable data and interpret the data, but you do 
not manipulate the data.

A QAQC technician is responsible for these tasks: 

• Reviewing data from the mass spectrometer

• Understanding the results and who ran and passed along the results before giving 
intermediate approval and sending the data to management

• Receiving instructions for new sets of samples for the TraceFinder application to analyze 
after finishing the current analysis

Note  In the QAQC role, you cannot submit batches for acquisition from the Acquisition 
mode.
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Project Administration 
In the LabDirector or ITAdmin role, you can create and manage projects and subprojects on 
fixed or network drives in the Project Administration view of the Configuration mode.

This section includes the following topics:

• Working with Drives

• Working with Projects

 To open the Project Administration view

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. 

2. In the Configuration navigation pane, click Project Administration.

The Project Administration view opens.

By default, all projects are created under a main Projects folder on the C: drive:

C:\Thermo\TraceFinder\1.1\Projects
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Working with Drives

Drives can be any of the following:

• Fixed: Directly connected to your computer.

• Network: Either a remote box or a mapped drive. A shared folder that is mapped to a 
drive letter might physically exist on your computer, but because it is mapped, it is 
considered to be a Network drive.

• Removable: Temporary drives such as a 3.5-inch disk or USB drive.

Use the following procedures:

• To choose a drive

• To change the default drive

• To hide a drive from display

• To refresh the drives display

 To choose a drive

1. In the Available Drives area, click any drive other than the default C: drive.

If you have not created a Projects directory on this drive, you see this message:

2. Click Create Projects Directory.

The TraceFinder application adds a new Projects directory to the selected drive. To create 
projects and subprojects on this drive, see “To create projects or subprojects” on page 42.

 To change the default drive

Select the check box in the Default column.

Only fixed drives can be set as the default drive. The default drive is the first drive listed in 
all drive lists and is the only drive that you can use to acquire data.
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 To hide a drive from display

Clear the check box in the Show column.

The application does not list the hidden drive in drive lists. You cannot hide the default 
drive.

 To refresh the drives display

Right-click and choose Refresh from the shortcut menu.

The Available Drives table refreshes to show any drives that have changed, for example, if 
you have inserted a USB drive. You can now configure any new drives.
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Working with Projects

When you create a batch, the application stores the data files, local method, and reports in a 
project and subproject that you create in the C:\Thermo\TraceFinder\1.1\Projects folder.

Use the following procedures:

• To create projects or subprojects

• To delete projects or subprojects

• To remove all empty folders

• To copy the folder hierarchy from another drive

 To create projects or subprojects

1. Select the top-level project.

You can select the main Projects folder and create a new project under it, or you can select 
one of the existing projects and create a subproject under it.

When you select a project folder, the application enables the plus sign icon, , 
indicating that you can create a folder within the selected folder.

2. Click the plus sign.

The TraceFinder application creates a new, unnamed project folder under the selected 
project.

3. While the new project is still highlighted, type a new name.

Project names are limited to 30 characters and can contain spaces and special characters, 
except for the following special characters: \ / : * ? " < > |

4. To save the new name, press ENTER or click anywhere in the view.

 To delete projects or subprojects

1. Select the project or subproject you want to delete.

Note  After you add a subproject to a project, you cannot rename the project.
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You can delete projects that do not have subprojects. You can delete subprojects that do 
not have batches. When the selected project or subproject is available for deletion, the 
application enables the minus sign icon, .

2. Click the minus sign, or right-click and choose Remove Project from the shortcut menu.

3. At the prompt, click Yes to remove the selected project or subproject.

 To remove all empty folders 

1. Select the project or subproject that contains empty folders.

2. Right-click and choose Remove All Empty Child Folders from the shortcut menu. 

A dialog box asks if you want to remove all empty folders.

3. Click OK.

The application removes all folders that have no folders or files. There is no undo for this 
command.

 To copy the folder hierarchy from another drive 

1. Select the top-level Projects directory in the Project Administration area.

2. Right-click and choose Copy Folder Hierarchy from Drive from the shortcut menu.

3. Choose a drive from the list of available drives.

At the prompt, you must confirm that you want to create a folder hierarchy that matches 
that of the specified drive. 

4. Click OK.

To replicate the hierarchy from the specified drive, the application will add new folders to 
the current hierarchy, but it will not remove folders. 

IMPORTANT  The Copy Folder Hierarchy from Drive command copies only the 
project and subproject folders; it does not copy batches within the folders.
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Compound Datastore 
In the LabDirector or ITAdmin role, you can manage compound definitions in the current 
datastore in the Compound Datastore view.

This section includes the following topics:

• Opening and Saving a Datastore

• Adding Compounds, Quan Peaks, and Confirming Ions to a Datastore

• Choosing Experiment Types

For a description of all the parameters in the Compound Datastore view, see “Compound 
Datastore View” on page 48.
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Opening and Saving a Datastore

You can use the default datastore or you can create your own datastore.

Use the following procedures:

• To open the Compound Datastore editor

• To open a compound datastore

• To create a new compound datastore

• To save a datastore

• To save a datastore to a new name

 To open the Compound Datastore editor

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. 

2. Click the Compound Datastore task pane.

The current datastore opens in the Compound Datastore view. For a detailed list of all 
parameters and functions on the compound Datastore view, see “Compound Datastore 
View” on page 48.
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 To open a compound datastore

1. Click Load Compound Datastore in the Compound Datastore task pane. 

The Open Compound Datastore dialog box opens.

2. Double-click the name of the datastore you want to open. 

The selected datastore opens in the Compound Datastore view. See “Compound 
Datastore View” on page 48.

 To create a new compound datastore

Click New Compound Datastore in the Compound Datastore task pane.

A new, empty datastore opens in the Compound Datastore view. 

You can import a file of compounds into the new datastore (following the instructions, To 
import compounds), or you can manually add compounds one at a time (following the 
instructions, To add a compound to the datastore).

 To save a datastore

1. Click Save Compound Datastore in the Compound Datastore task pane.

The application stores the database as

…\Thermo\TraceFinder\1.1\Databases\filename.xml

If the datastore contains any compounds that do not have associated quan peaks, the 
Invalid Compound Datastore Not Saved dialog box opens, listing the compounds.
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2. To add a quan peak row to the listed compounds, click Continue.

The application returns you to the Compound Datastore view.

3. Add quan peaks to the incomplete compounds before you save the datastore.

See “To add a quan peak to a compound” on page 53. 

 To save a datastore to a new name

1. Click Save As Compound Datastore in the Compound Datastore task pane.

The Save Compound Datastore dialog box opens.

2. Type a file name for the new compound datastore.

3. Click Save.

The application stores the database as

…\Thermo\TraceFinder\1.1\Databases\filename.xml

Figure 5. Save Compound Datastore dialog box

Table 7. Select Compound Datastore dialog box parameters

Parameter Description

Compound Datastore 
name

Lists the file name for the new datastore.

Overwrite Overwrites the selected datastore.

OK Writes the new datastore to the Databases folder.

Cancel Closes the dialog box and makes no changes to the datastore.
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Figure 6. Compound Datastore View
 

 

Table 8. Compound Datastore view parameters  (Sheet 1 of 3)

Parameter Description

Function icons

 Adds a new compound row. 

Removes the selected row and all quan peak and confirming ion rows within it.

Adds a new quan peak row to the compound. Each compound requires at least one quan 
peak.

 Removes the selected row and all confirming ion rows within it.

Adds a new confirming ion row to the quan peak.

Removes the selected confirming ion row.

Select experiment types 
to display 

Specifies one of these experiment types that each use a different structure for the mass 
filter. See “Choosing Experiment Types” on page 55.

• SRM: Selected Reaction Monitoring
• XIC: Extracted Ion Chromatogram
• SIM: Single Ion Monitoring

Compound parameters

Compound Name Alphanumeric name assigned to the compound.

Experiment Type Experiment type: SRM, XIC, or SIM. 

Category (Optional) Alphanumeric identifier. 

Ionization (Optional) Alphanumeric identifier. 
Valid values: None, ESI, APCI, EI, CI, APPI
Default: None

Chemical Formula (Optional) Alphanumeric chemical identifier.
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Quan peak parameters

Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the center of a target 
precursor-ion peak in mass-to-charge ratio (m/z) units. 
In confirming ion rows, the precursor mass is a noneditable copy of the quan peak 
precursor mass.
Available only for SRM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quan ion. The location of the center of a target quan-ion 
peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Mass The mass-to-charge ratio of the quan ion. The location of the center of a target quan-ion 
peak in mass-to-charge ratio (m/z) units. 
Available only for XIC and SIM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas.
Available only for SRM experiments.
Range: –250.00 to 250.00

RT (min) Retention time. The application uses RT and Window values to determine the start and 
stop time for the acquisition. 
Range: 0.00 to 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Window (sec) The application uses RT and Window values to determine the start and stop time for the 
acquisition. 
Range: 0.00 to 499.50
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Polarity + (positive) or – (negative)

Lens (Optional) Range: –400 to 400

Energy Ramp (Optional) 
Available only for SRM experiments.
Range: 0.00 to 200.00

Table 8. Compound Datastore view parameters  (Sheet 2 of 3)

Parameter Description
Thermo Scientific TraceFinder User Guide 49



3 Using the Configuration Mode
Compound Datastore
Confirming ion parameters

Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the center of a target 
precursor-ion peak in mass-to-charge ratio (m/z) units. 
Available as a noneditible field only for SRM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quan ion. The location of the center of a target quan-ion 
peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Mass The mass-to-charge ratio of the quan ion. The location of the center of a target quan-ion 
peak in mass-to-charge ratio (m/z) units. 
Available only for XIC and SIM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas. 
Available only for SRM experiments.
Range: –250.00 to 250.00

Table 8. Compound Datastore view parameters  (Sheet 3 of 3)

Parameter Description
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Adding Compounds, Quan Peaks, and Confirming Ions to a Datastore

In the Compound Datastore view, you can import compounds into the datastore, add or 
remove compounds from the datastore, add quan peaks and confirming ions to a compound, 
or remove quan peaks or confirming ions from a compound.

Use the following procedures:

• To import compounds

• To add a compound to the datastore

• To remove a compound

• To add a quan peak to a compound

• To remove a quan peak

• To add a confirming ion to a quan peak

• To remove a confirming ion

 To import compounds

1. Click Import Compounds in the Compound Datastore task pane.

2. Browse to a .csv or .xml compounds file and click Open.

The TraceFinder application imports the compounds from the imported file, adds them 
to any compounds already in the datastore, and alphabetically sorts them.

When the application imports a compound that contains multiple quan peaks and 
confirming ions, it lists all the peaks under a single compound name, as in this example 
for Monuron:
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 To add a compound to the datastore

1. Click the Add Compound button, , or right-click the compounds list and choose 
Add Compound from the shortcut menu.

The application adds a new, empty compound row to the compounds table. 

2. Click the first table cell, and enter the required Compound Name parameter.

3. (Optional) Change the value for the Experiment Type. 

The default is SRM. For descriptions of available experiment types, see “Choosing 
Experiment Types” on page 55.

After you add a quan peak to the compound, you cannot change the experiment type, 
even if you cancel the quan peak.

4. (Optional) Type a value or select a value from the Category list. 

You can use any alphanumeric string. After you type a new Category value, that value is 
available from the list.

5. (Optional) Change the values for Ionization.

The default is None.

6. (Optional) Type a value for the Chemical Formula. 

You can use any alphanumeric string. 

Each compound requires at least one quan peak.

 To remove a compound

1. Select the compound row you want to delete.

2. Click the Remove Compound button, , or right-click and choose Remove 
Compound from the shortcut menu.

3. If you are sure you want to delete the selected row, at the prompt, click OK.

The application removes the selected row and all quan peak and confirming ion rows 
within it.

Tip  If you add a row of compound information and do not complete all the column 
required values, you can right-click and choose Cancel to remove the entire row. You 
can cancel only an incomplete compound row. 
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 To add a quan peak to a compound

1. Select the compound.

2. Click the Add Quan Peak button, , or right-click and choose Add Quan Peak 
from the shortcut menu. 

The application adds a new quan peak row to the compound. A quan peak includes 
quantitative values for the compound. Each compound requires at least one quan peak.

3. Enter all required parameters. 

For a list of required and optional parameters, see the list of “Compound Datastore view 
parameters” on page 48.

4. Repeats steps 2 through 3 to add as many as six quan peaks to the compound. 

 To remove a quan peak 

1. Select the row of the quan peak you want to delete.

2. Click the Remove Quan Peak button, , or right-click and choose Remove Quan 
Peak from the shortcut menu.

3. If you are sure you want to delete the selected row, at the prompt, click OK.

The application removes the selected row and all confirming ion rows within it.

Tip  You cannot add another new compound or save the compound datastore until 
you enter all required quan peak parameters or remove incomplete quan peaks from 
the compound. 

Tip  If you add a row of quan peak information and do not complete all the required 
values, you can right-click and choose Cancel to remove the entire row. You can 
cancel only incomplete quan peak rows. 

Quan peak row
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 To add a confirming ion to a quan peak 

1. Click the Add Confirming Ion icon, , or right-click the quan peak row and choose 
Add Confirming Ion from the shortcut menu.

The application adds a new confirming ion row to the quan peak. A confirming ion 
includes a mass value. 

2. Type the required column values for the confirming ion.

The required confirming ion values differ for each experiment type. See “Choosing 
Experiment Types” on page 55.

3. Repeats steps 1 through 2 to add as many as 10 confirming ions to the quan peak.

 To remove a confirming ion

1. Select the confirming ion row you want to delete.

2. Click the Remove Confirming Ion icon, , or right-click and choose Remove 
Confirming Ion from the shortcut menu.

3. If you are sure you want to delete the selected row, at the prompt, click OK.

The application removes the selected confirming ion row.

 To filter a list

Click the funnel icon, , in the column header.

For each column, the application displays filterable criteria (compound names, 
experiment types, categories, or ionization methods) in a list. In all lists, you can choose 
to view all criteria or a specific type of criterion for that column.

Tip  If you add a row of confirming ion information and do not complete all the 
required values, you can right-click and choose Cancel to remove the entire row. You 
can cancel only incomplete confirming ion rows. 

Confirming ion row
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Choosing Experiment Types

The TraceFinder application uses three experiment types: SRM, XIC, and SIM. 

A compound datastore can include multiple experiment types for a single compound; 
however, each compound name and experiment type combination must be unique.

SRM – Selected Reaction Monitoring

The SRM experiment type supports triple quadrupole LC/MS. The mass filter includes 
precursor mass and narrow mass ranges to identify product masses. Imported compounds 
with no experiment type are treated as SRM data.

Confirming ions include values for product mass, collision energy, and a noneditable 
precursor mass.

XIC – Extracted Ion Chromatogram

The mass filter is a single, full scan which is post-processed to extract a peak for the ions of 
interest.

Confirming ions include a single mass value.

SIM – Single Ion Monitoring

The SIM experiment type supports single quadrupole LC/MS and Exactive™ systems. The 
mass filter includes narrow mass ranges to identify product masses.

Confirming ions include a single mass value.
Thermo Scientific TraceFinder User Guide 55



3 Using the Configuration Mode
Application Configuration
Application Configuration
In the LabDirector or ITAdmin role, you can enable features such as available reports, user 
security, compound datastore, reporting defaults, multiplexing, detection algorithms, and 
target screening. You can also choose the reports that are available to users, the application 
defaults, and the defaults used for peak detection.

This section includes the following tasks:

• Specifying the Reports Configuration

• Specifying User Security

• Enabling a Compound Datastore

• Specifying Configuration Defaults

• Specifying Multiplexing Parameters

• Specifying Detection Parameters

• Enabling Target Screening

 To open the Application Configuration view

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. 

2. Click Application Configuration.

The Application Configuration view opens. 

Table 9. Application Configuration pages  (Sheet 1 of 2)

Page

Reports See “Specifying the Reports Configuration” on page 58.

User Security See “Specifying User Security” on page 66.

Compound Datastore See “Enabling a Compound Datastore” on page 67.
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3. In the Application Configuration list, click the type of information you want to 
configure.

Defaults See “Specifying Configuration Defaults” on page 68.

Multiplex See “Specifying Multiplexing Parameters” on page 70.

Detection See “Specifying Detection Parameters” on page 71.

Table 9. Application Configuration pages  (Sheet 2 of 2)

Page
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Specifying the Reports Configuration 

In the LabDirector or ITAdmin role, you can configure a list of reports that are available to 
users when they generate reports from the Method Development, Data Review, and 
Acquisition modes. From the Reports page, you can configure the standard, custom, or target 
screening reports.

Example PDFs of report formats are located in the following folder:

C:\Thermo\TraceFinder\1.1\ExampleReports

Use the following procedures:

• To open the Reports page

• To specify which reports are available

• To import new reports

 To open the Reports page

In the Application Configuration view, click Reports.

The Reports page of the Application Configuration view opens. 

• For a list of General Quantitation reports, see “General Quantitation Reports” on 
page 60.

• For a list of Environmental and Food Safety reports, see “Environmental and Food 
Safety Reports” on page 63. 

 To specify which reports are available

1. Use the directional arrows to move reports from the Installed Reports pane to the 
Displayed Reports pane.

In the Method Development, Data Review, and Acquisition modes, users can access all 
reports in the Displayed Reports pane.

Tip  Use the CTRL or SHIFT keys to select multiple reports.
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2. To create a single composite report for an entire batch (rather than separate reports for 
each sample), select the Batch Level check box for the report.

Rather than creating separate reports for each sample, the application uses a composite of 
the data from all the samples to create a single report for the entire batch. Batch-level 
reports are prepended with a B to differentiate them.

3. Do one of the following:

To apply the current selections, do the following:

a. Click Apply.

A message reminds you that you must restart the TraceFinder application before a 
user can access the reports you selected for the Method Development, Data Review, 
and Acquisition modes.

b. To restart the TraceFinder application now, click Yes, or to remain on the Reports 
page, click No.

–Or–

To return the report selections to their original state (when you first opened this page), 
click Undo Changes.

 To import new reports

1. Click Import.

2. In the browser, locate a Crystal Reports .dll or Custom Reports .xltm file and open the 
file.

The application writes the imported report to the TraceFinder installation directory and 
displays the new report in the Installed Reports pane.

Note  Only reports with the ability to aggregate data at the batch level have the Batch 
Level check box enabled.
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General Quantitation Reports

The General Quantitation configuration uses the following standard, custom, and target 
screening reports. For descriptions of the parameters on the Reports page, see “General 
Quantitation Reports page parameters” on page 62.

Figure 7. General Quantitation Reports page showing standard reports
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Figure 8. General Quantitation Reports page showing custom reports

Figure 9. General Quantitation Reports page showing target screening reports

Note  Target Screening reports are available only when you enable target screening. See 
“Enabling Target Screening” on page 83.
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Table 10.  General Quantitation Reports page parameters 

Parameter Description

Installed reports All reports listed in the Installed Reports pane are potentially 
available but are not selected for use in the application.

Displayed reports All reports listed in the Displayed Reports pane are selected for 
use in the application.

>> Moves all reports from the Installed Reports list to the Displayed 
Reports list.

> Moves the selected reports from the Installed Reports list to the 
Displayed Reports list.

< Moves the selected reports from the Displayed Reports list to the 
Installed Reports list.

<< Moves all reports from the Displayed Reports list to the Installed 
Reports list.

Import Opens a browser where you can select a report file to add to the 
Installed Reports list.

Undo changes Returns the report selections to their original state (when you 
first opened this page).

Apply Applies the current selections, and reminds you that you must 
restart the TraceFinder application before a user can access the 
reports you selected for the Method Development, Data Review, 
and Acquisition modes.
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Environmental and Food Safety Reports

The Environmental and Food Safety configuration uses the following standard, custom, and 
target screening reports. For descriptions of the parameters on the Reports page, see 
“Environmental and Food Safety Reports page parameters” on page 65.

Figure 10. Environmental and Food Safety Reports page showing standard reports
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Figure 11. Environmental and Food Safety Reports page showing custom reports

Figure 12. Environmental and Food Safety Reports page showing target screening reports

Note  Target Screening reports are available only when you enable target screening. See 
“Enabling Target Screening” on page 83.
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Table 11.  Environmental and Food Safety Reports page parameters 

Parameter Description

Installed reports All reports listed in the Installed Reports pane are potentially 
available but are not selected for use in the application.

Displayed reports All reports listed in the Displayed Reports pane are selected for 
use in the application.

>> Moves all reports from the Installed Reports list to the Displayed 
Reports list.

> Moves the selected reports from the Installed Reports list to the 
Displayed Reports list.

< Moves the selected reports from the Displayed Reports list to the 
Installed Reports list.

<< Moves all reports from the Displayed Reports list to the Installed 
Reports list.

Import Opens a browser where you can select a report file to add to the 
Installed Reports list.

Undo changes Returns the report selections to their original state (when you 
first opened this page).

Apply Applies the current selections, and reminds you that you must 
restart the TraceFinder application before a user can access the 
reports you selected for the Method Development, Data Review, 
and Acquisition modes.
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Specifying User Security

In the LabDirector or ITAdmin role, you can enable user security.

When user security is enabled, all users must log on to the TraceFinder application for access 
to only those modes assigned to their user role. See “Choosing User Roles” on page 36.

 To open the User Security page

In the Application Configuration view, click User Security.

The User Security page of the Application Configuration view opens.

 To turn on user security

1. In the User Security area, select the Enable User Security check box.

When this check box is selected, all users must log on to the TraceFinder application for 
access to the modes assigned to their user role. See “Choosing User Roles” on page 36.

When this check box is cleared, users are not required to log on to the TraceFinder 
application. When they start the application, the dashboard is the first screen that users 
see and all modes are available to them. Only the User Administration view in 
Configuration mode is hidden and cannot be edited. 

2. In the Application Configuration view, click Apply.

A message reminds you that you must restart the TraceFinder application before the user 
security setting is enabled.

3. When you are prompted to restart the application, click Yes.

Note  By default, user security is not enabled. 

IMPORTANT  If you are the administrator logging on with user security enabled, you 
can use Administrator/Password as the username/password. 
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Enabling a Compound Datastore

In the LabDirector or ITAdmin role, you can enable the compound datastore.

 To open the Compound Datastore page

1. In the Application Configuration view, click Compound Datastore.

The Compound Datastore page of the Application Configuration view opens.

2. In the Compound Datastore Selection area, select the Enable Compound Datastore 
check box.

3. In the Application Configuration view, click Apply.

4. When prompted to restart the application, click Yes.

After restarting, the application implements the following changes:

• Displays the Acquisition List page on the Compounds page in the Master Method 
View. See “Editing the Compounds Page” on page 114.

• Displays the Compound Datastore task pane on the Configuration mode navigation 
pane. See “Compound Datastore” on page 44.

• Enables the Export SRM Data command in the Method Development mode. See 
“Exporting SRM Data” on page 199.

Note  By default, the Enable Compound Datastore option is not selected.
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Specifying Configuration Defaults

In the Application Configuration view of the Configuration mode, as a user in the 
LabDirector or ITAdmin role, you can specify the default laboratory and instrument names, 
the mass precision, and the intensity scale to use for reporting.

Use the following procedures:

• To open the Defaults page

• To specify a default laboratory name and instrument name

• To specify default mass precision and the intensity scale

 To open the Defaults page

In the Application Configuration view, click Defaults.

The Defaults page of the Application Configuration view opens.
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 To specify a default laboratory name and instrument name

1. Type the name of your laboratory in the Lab Name box.

When you create a method, the application uses this default laboratory name for the 
Laboratory Name value on the General page of the Master Method View. The application 
uses this laboratory name in the report headings.

The application does not apply this default laboratory name to previously created 
methods. By default, the laboratory name is Default Laboratory.

2. Type the name of your instrument in the Instrument Name box.

When you create a batch, the application uses this default instrument name for the 
Instrument Name value. The application uses this instrument name in the report 
headings.

3. In the Application Configuration view, click Apply.

The application does not apply this default instrument name to previously created 
batches. By default, the instrument name is Thermo Scientific Instrument.

4. When prompted to restart the application, click Yes.

 To specify default mass precision and the intensity scale

1. In the Display Mass Precision box, set the mass precision decimal places value to an 
integer from 0 to 5, inclusive.

The default mass precision is 2. The TraceFinder application uses this mass precision 
value in the following locations:

• Reports:
– Blank Report
– Confirmation Report (data spectra, library spectra, quan ion display, and qual 

ion display)
– All High Density reports (m/z values)
– Ion Ratio Failure Report (quan ion and qual ion)
– Manual Integration Report (m/z value)
– Qualitative Summary Report (all m/z values)
– Quantitation Report (QIon)

• All peaks on the Detection pages in the Method Development mode
• The spectrum display in the Data Review mode
• The spectrum display in the Method Forge dialog box

2. Select Relative or Absolute from the Chromatogram Intensity Scale list.

This sets the default display type for both quan and qual chromatograms displayed in 
data review and reports. 

3. In the Application Configuration view, click Apply.

4. When prompted to restart the application, click Yes.
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Specifying Multiplexing Parameters

In the LabDirector or ITAdmin role, you can enable multiplexing and specify the maximum 
number of channels to use.

A user in the LabDirector, Supervisor, or Technician role can choose which channels to use for 
acquisition before submitting a batch from the Acquisition mode.

 To enable multiplexing

1. In the Application Configuration view, click Multiplex.

The Multiplexing Support page opens. 

2. Select the Enable Multiplexing Support check box.

3. In the Select Number of Channels list, select 2 Channels or 4 Channels.

4. When you select 2 channels, select a 1- or 2-arm autosampler configuration.

The 1 arm configuration enables channels 1 and 3; the 2 arm configuration enables 
channels 1 and 2.

When you use a 4-arm configuration, autosampler 1 uses channels 1 and 3 and 
autosampler 2 uses channels 2 and 4.

5. To apply the multiplexing settings, do the following:

a. In the Application Configuration view, click Apply.

A message reminds you that you must restart the TraceFinder application before the 
multiplexing selections are reflected in the Acquisition mode.

b. To restart the TraceFinder application now, click Yes, or to remain on the 
Multiplexing Support page, click No.
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Specifying Detection Parameters

In the LabDirector or ITAdmin role, you can specify detection parameters for Genesis, ICIS, 
or Avalon detection algorithms. Use the Peak Detection Defaults page to specify a peak 
detection algorithm and its options and to determine the area under a curve.

This section includes procedures for specifying the following detection algorithms:

• Genesis Detection Method

• ICIS Detection Method

• Avalon Detection Method

 To specify common detection parameters

1. In the Application Configuration view, click Detection.

The Peak Detection Defaults page opens. See “Common peak detection areas” on 
page 72.

2. In the Detector Type list, select a detector type.

3. In the Mass Tolerance area, do the following:

a. Select the units of measure you want to use. 

b. In the Value box, specify the number of millimass units or parts per million to use as 
the upper limit.

The application applies this mass tolerance to the extracted chromatograms. The default 
is 500 MMU.

4. In the Retention Time area, do the following:

a. In the Window box, specify the width of the window (in seconds) to indicate how far 
around the expected retention time the system will look for a peak apex. 

b. In the View Width box, specify the viewable size (in minutes) of the ion 
chromatogram display. 

5. In the Ion Ratio Parameters area, do the following:

a. In the Window Type box, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

b. In the Window (+/-%) box, select the acceptable ion ratio range. 

c. In the Ion Coelution box, select the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak.

6. In the Peak Detection Parameters area, select one of the detection algorithms: Genesis, 
ICIS, or Avalon.
Thermo Scientific TraceFinder User Guide 71



3 Using the Configuration Mode
Application Configuration
Figure 13. Common peak detection areas 

Table 12. Common peak detection parameters 

Parameter Description

Detector Type

Mass Tolerance

Units • (Default) MMU (millimass units) 
MMU is a static calculation to the extracted mass.

• PPM (parts per million) 
PPM is a variable calculation dependent on the actual mass. 
The smaller the mass, the narrower the tolerance range. The 
larger the mass, the wider the tolerance range.

Value Upper limit of MMU or PPM.
Default: 500
Range: 0.1 through 50 000

Retention Time

Window (sec) Width of the window (in seconds) to indicate how far around the 
expected retention time the system will look for a peak apex. 

View width (min) Viewable size (in minutes) of the ion chromatogram display. 
Changing the view width does not affect the process of peak 
detection; the TraceFinder application uses it only for graphical 
display. 

Ion Ratio Parameters

Window type The absolute or relative calculation approach for determining the 
acceptable ion ratio range. 

Window (+/-%) The acceptable ion ratio range.

Ion coelution 
(min)

The maximum difference in retention time between a confirming 
ion peak and the quantification ion peak.
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Genesis Detection Method

The TraceFinder application provides the Genesis peak detection algorithm for backward 
compatibility with Xcalibur 1.0 studies. 

Figure 14. Genesis peak detection page

Table 13. Genesis peak detection page parameters  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the Genesis peak detection algorithm.

Detection method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Range: Any odd integer from 1 through 15 points
Default: 1 
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S/N threshold Current signal-to-noise threshold for peak integration. Peaks with 
signal-to-noise values less than this value are not integrated. Peaks 
with signal-to-noise values greater than this value are integrated. 

Range: 0.0 to 999.0

Enable valley detection Uses the valley detection approximation method to detect 
unresolved peaks. This method drops a vertical line from the apex 
of the valley between unresolved peaks to the baseline. The 
intersection of the vertical line and the baseline defines the end of 
the first peak and the beginning of the second peak. 

Expected width (sec) The expected peak width parameter (in seconds). This parameter 
controls the minimum width that a peak is expected to have if 
valley detection is enabled. 

With valley detection enabled, any valley points nearer than the 
expected width/2 to the top of the peak are ignored. If a valley 
point is found outside the expected peak width, the TraceFinder 
application terminates the peak at that point. The application 
always terminates a peak when the signal reaches the baseline, 
independent of the value set for the expected peak width. 

Range: 0.0 to 999.0

Constrain peak width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
Peak Width check box enables the Peak Height (%) and Tailing 
Factor options.

Peak height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when you select the Constrain Peak Width check 
box. 

Range: 0.0 to 100.0%

Tailing factor A factor that controls how the TraceFinder application integrates 
the tail of a peak. This factor is the maximum ratio of the trailing 
edge to the leading side of a constrained peak. This text box is 
active only when you select the Constrain the Peak Width check 
box. 

Range: 0.5 through 9.0

Table 13. Genesis peak detection page parameters  (Sheet 2 of 3)

Parameter Description
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Min peak height (S/N) For the valley detection approximation method to use the Nearest 
RT Peak Identification criteria, this peak signal-to-noise value 
must be equaled or exceeded. For component identification 
purposes, the TraceFinder application ignores all chromatogram 
peaks that have signal-to-noise values that are less than the S/N 
Threshold value. 

Range: 0.0 (all peaks) through 999.0

Peak S/N cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test assumes it has found an edge of a peak when the baseline 
adjusted height of the edge is less than the ratio of the baseline 
adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 
200, the TraceFinder application defines the right and left edges of 
the peak when the S/N reaches a value less than 200. 

Range: 50.0 to 10000.0

Valley rise (%) The peak trace can rise above the baseline by this percentage after 
passing through a minimum (before or after the peak). This 
criteria is useful for integrating peaks with long tails.

This method drops a vertical line from the apex of the valley 
between unresolved peaks to the baseline. The intersection of the 
vertical line and the baseline defines the end of the first peak and 
the beginning of the second peak. 

When the trace exceeds rise percentage, the TraceFinder 
application applies valley detection peak integration criteria. This 
test is applied to both the left and right edges of the peak. 

Range: 0.1 to 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this 
parameter ensures that the surrounding measurements are higher. 

Range: 1.0 to 100.0
Default: 2.0

# background scans Number of background scans performed by the TraceFinder 
application.

Report noise as Determines if the noise used in calculating S/N values is calculated 
using an RMS calculation or peak-to-peak resolution threshold. 
Options are RMS or Peak to Peak.

Table 13. Genesis peak detection page parameters  (Sheet 3 of 3)

Parameter Description
Thermo Scientific TraceFinder User Guide 75



3 Using the Configuration Mode
Application Configuration
ICIS Detection Method

The ICIS peak detection algorithm is designed for MS data and has superior peak detection 
efficiency at low MS signal levels. 

Figure 15. ICIS peak detection page

Table 14. ICIS peak detection page parameters  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the ICIS peak detection algorithm.

Detection method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Range: Any odd integer from 1 through 15 points
Default: 1 
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Area noise factor The noise level multiplier used to determine the peak edge after 
the location of the possible peak. The ICIS peak detection 
algorithm uses this value. 

Range: 1 through 500
Default: 5

Peak noise factor The noise level multiplier used to determine the potential peak 
signal threshold. The ICIS peak detection algorithm uses this 
value.

Range: 1 through 1000
Default: 10

Baseline window The TraceFinder application looks for a local minima over this 
number of scans. The ICIS peak detection algorithm uses this 
value.

Range: 1 through 500
Default: 40

Constrain peak width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
Peak Width check box enables the Peak Height (%) and Tailing 
Factor options.

Peak height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when you select the Constrain Peak Width check 
box. 

Range: 0.0 to 100.0%

Tailing factor A factor that controls how the TraceFinder application integrates 
the tail of a peak. This factor is the maximum ratio of the trailing 
edge to the leading side of a constrained peak. This text box is 
active only when you select the Constrain the Peak Width check 
box. 

Range: 0.5 through 9.0

Table 14. ICIS peak detection page parameters  (Sheet 2 of 3)

Parameter Description
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Min peak height (S/N) For the valley detection approximation method to use the Nearest 
RT Peak Identification criteria, this peak signal-to-noise value 
must be equaled or exceeded. For component identification 
purposes, the TraceFinder application ignores all chromatogram 
peaks that have signal-to-noise values that are less than the S/N 
Threshold value. 

Range: 0.0 (all peaks) through 999.0

Noise method The options are INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level. 
The ICIS peak detection algorithm uses this value. 

Repetitive: Uses a multiple pass algorithm to determine the noise 
level. The ICIS peak detection algorithm uses this value. In 
general, this algorithm is more accurate in analyzing the noise 
than the INCOS Noise algorithm, but the analysis takes longer. 

Min peak width The minimum number of scans required in a peak. The ICIS peak 
detection algorithm uses this value.

Range: 0 to 100 scans
Default: 3

Multiplet resolution The minimum separation in scans between the apexes of two 
potential peaks. This is a criteria to determine if two peaks are 
resolved. The ICIS peak detection algorithm uses this value.

Range: 1 to 500 scans
Default: 10 

Area tail extension The number of scans past the peak endpoint to use in averaging 
the intensity. The ICIS peak detection algorithm uses this value.

Range: 0 to 100 scans
Default: 5

Area scan window The number of allowable scans on each side of the peak apex. A 
zero value defines all scans (peak-start to peak-end) to be included 
in the area integration. 

Range: 0 to 100 scans
Default: 0 

RMS Specifies that the TraceFinder application calculate noise as RMS. 
By default, the application uses Peak To Peak for the noise 
calculation. RMS is automatically selected if you manually 
determine the noise region.

Table 14. ICIS peak detection page parameters  (Sheet 3 of 3)

Parameter Description
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Avalon Detection Method

The Avalon peak detection algorithm is designed for UV data. The Avalon peak detection 
algorithm also supports negative peaks.

Figure 16. Avalon peak detection page

Table 15. Avalon peak detection page parameters 

Parameter Description

Sensitivity Specifies the Avalon peak detection algorithm.

Detection method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Range: Any odd integer from 1 through 15 points
Default: 1 

Time/Event/Value Displays the events specified in the Avalon Event List dialog box. 
Initially displays only the default events that cannot be edited or 
deleted.

Edit Opens the Avalon Event List dialog box where you can edit the 
Time/Event/Value parameters. See “Avalon Event List” on 
page 80.
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Avalon Event List

The event list includes both user-defined and noneditable default events. The application 
displays the default events when you choose Avalon sensitivity. You cannot delete these events 
or change their time or values. For a detailed list of events and value ranges, see “Event types” 
on page 81.

Figure 17. Avalon Event List dialog box

Table 16. Avalon Event List dialog box parameters 

Parameter Description

Time (Min) Specifies the start time of the event.

Event Specifies the type of event. For a detailed list of events and value 
ranges, see “Event types” on page 81.

Value Specifies the value of the event.

Add Adds a new event to the list with the current Time/Event/Value 
parameters.

Delete Removes the selected Time/Event/Value parameter from the event 
list.

Change Applies the current parameter values.

Cancel Closes the dialog box without making any changes. Any additions, 
deletions, or changes revert to their original state.

Apply Closes the dialog box.
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Figure 18. Event types

Table 17. Event type definitions  (Sheet 1 of 2)

Parameter Description

Start Threshold Specifies the threshold at the start of a peak. The Start Threshold is 
directly related to the RMS noise in the chromatogram.
Range: 0 to 999 999 999

End Threshold Specifies the threshold at the end of a peak. The End Threshold is 
directly related to the RMS noise in the chromatogram.
Range: 0 to 999 999 999

Area Threshold Controls the area cutoff. Any peaks with a final area less than the area 
threshold will not be detected. This control is in units of area for the 
data. 
Range: 0 to 999 999 999

P-P Threshold The peak-to-peak resolution threshold controls how much peak 
overlap must be present before two or more adjacent peaks create a 
peak cluster. Peak clusters have a baseline drop instead of 
valley-to-valley baselines. Specified as a percent of peak height 
overlap.
Range: 0.1 to 99.99

Negative Peaks Permits detection of a negative going peak. Automatically resets after 
finding a negative peak.
Valid values: On or Off

Bunch Factor Specifies the number of points grouped together during peak 
detection. This event controls the bunching of chromatographic 
points during integration and does not affect the final area 
calculation of the peak.  A high bunch factor groups peaks into 
clusters.
Range: 0 to 999
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Tension Controls how closely the baseline should follow the overall shape of 
the chromatogram. A lower tension traces the baseline to more 
closely follow changes in the chromatogram.  A high baseline tension 
follows the baseline less closely, over longer time intervals. 
Range: 0 to 999.99 minutes

Tangent Skim Using this event, you can tangent skim any peak clusters.  By default, 
it chooses the tallest peak in a cluster as the parent. You can also 
identify which peak in the cluster is the parent. Tangent skim peaks 
are detected on either side (or both sides) of the parent peak. Tangent 
skim automatically resets at the end of the peak cluster.
Range: 0 to 1

Shoulders On Allows peak shoulders to be detected (peaks which are separated by 
an inflection rather than a valley) Sets a threshold for the derivative.

Shoulders Off Disables peak shoulder detection.
Range: 0 to 50

Force Cluster On Force the following peaks to be treated as a cluster (single peak).

Force Cluster Off End the forced clustering of peaks.

Disable Cluster On Prevent any peaks from being clustered.

Disable Cluster Off Permit clusters to occur again.

Table 17. Event type definitions  (Sheet 2 of 2)

Parameter Description
82 TraceFinder User Guide Thermo Scientific



 3 Using the Configuration Mode
Application Configuration
Enabling Target Screening

In the Application Configuration view of the Configuration mode, you can enable target 
screening features.

 To enable target screening

1. In the Application Configuration view, click Target Screening.

The Target Screening page of the Application Configuration view opens.

2. In the Target Screening area, select the Enable Target Screening check box.

3. In the Application Configuration view, click Apply.

A message reminds you that you must restart the TraceFinder application before the target 
screening feature is enabled.

4. When prompted to restart the application, click Yes.

Note  You must have the ToxID application installed on your computer before you can 
generate Target Screening reports.
Thermo Scientific TraceFinder User Guide 83





4

Using the Method Development Mode

This chapter includes method development tasks assigned to the Supervisor or LabDirector 
roles.

From the Method Development mode, you can create a master method, an instrument 
method, or a simple development batch to test your instrument method.

 To access the Method Development mode

Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens. For a detailed description of all the 
features on the Method Development navigation pane, see “Method Development 
navigation pane” on page 86.

Contents

• Working with Master Methods

• Working with Instrument Methods

• Working with Development Batches
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Figure 19. Method Development navigation pane

Table 18. Method Development navigation pane functions  (Sheet 1 of 2)

Function Description

Method View See “Working with Master Methods” on page 88.

Create method Opens the Create Master Method dialog box where you can 
choose the process you want to use to begin your master method. 

Open method Opens the Open Master Method dialog box where you can choose 
a master method to open.
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Import Published 
Method

Opens the Import Published Method dialog box where you can 
select a published method to import.

Export SRM data Writes the selected reaction monitoring (SRM) table to the 
following file:

…\Thermo\TraceFinder\1.1\Methods\methodname.xml

You can use the data in this file in the instrument method editor 
when you open the TSQ 2.1 application. This command is 
available only when you have selected the Enable Compound 
Datastore option on the Compound Datastore page of the 
Application Configuration view. See “Application Configuration” 
on page 56.

The compounds in the Acquisition List must contain at least one 
SRM experiment type.

Recent Files Displays recently saved master methods.

Instrument View See “Working with Instrument Methods” on page 200.

New instrument 
method

Opens the Instrument View where you can specify instrument 
settings for your configured instruments.

If the instrument you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then 
reopen the application. You cannot configure an instrument while 
the TraceFinder application is running.

Open instrument 
method

Opens a browser where you can choose an instrument method to 
open.

Development Batch See “Working with Development Batches” on page 207.

Select batch location Specifies a location to store temporary development batch raw data 
files.

New sample list Removes acquired samples from your development batch, so you 
can begin a new sample list.

Open Qual Browser Opens the Thermo Xcalibur Qual Browser where you can view the 
acquired raw data files.

Table 18. Method Development navigation pane functions  (Sheet 2 of 2)

Function Description
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Working with Master Methods
The TraceFinder application uses a master method to specify the nature and types of 
acquisition, processing, and reporting that occur with a batch of samples. When you are 
testing for compounds in an assay, you can create a method designed specifically for that type 
of application. 

A master method contains a list of compounds and an initial set of information for detecting, 
processing, and reporting those compounds. 

When you create a master method, the TraceFinder application uses the method to determine 
how the software works with a set of samples to provide a set of meaningful results. The 
application uses an instrument method to define how raw data is acquired. The rest of the 
master method defines how the raw data is processed, how the flags information evaluates the 
results, and how the reporting functionality defines the way your data and results are output 
into reports. 

The TraceFinder application applies your master method to a batch, which is a list of one or 
more samples to be processed and reported. Together, the master method and batch provide a 
workflow-oriented approach to the data processing and information reporting for batches of 
samples. 

To speed up the creation of master methods, you can create a method template. Using a 
method template helps you to develop methods faster because the TraceFinder application 
saves all of your commonly used method settings in a template, such as the number of 
confirming ions or the use of data-dependent data. 

This section includes instructions for the following tasks:

• Creating a New Master Method

• Editing a Master Method

• Creating a Method Template

• Importing Published Master Methods

• Exporting SRM Data
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Creating a New Master Method

To begin a master method, follow any of four different procedures:

• Creating a New Method with Method Forge

• Importing an Xcalibur Master Method

• Associating a Raw Data File

• Selecting Compounds from the Compound Datastore

With each procedure, you begin the method in a specific way and then use the common 
features of the Master Method View to complete and save your master method.

Figure 20. Create Master Method dialog box
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Creating a New Method with Method Forge

With Method Forge, you can create a new master method by manually selecting peaks, 
selecting multiple compounds, renaming peaks, or comparing mass spectra from the library 
searches. You can also choose to let the TraceFinder application automatically create a master 
method for you. For a detailed description of all the Method Forge parameters, see “Method 
Forge dialog box parameters” on page 96.

When the TraceFinder application automatically creates a master method for you, it performs 
the following functions:

• Reviews your raw data file and identifies compounds that are present in your sample. 

• Uses your mass spectral reference libraries to assign compound names and CAS numbers.

• Uses mass spectral information to select potential quantification and confirming ions and 
a reference mass spectrum for the compound. 

Use the following procedures:

• To automatically select compounds to create a new method

• To manually select compounds to create a new method

 To automatically select compounds to create a new method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens. 

2. Select the Use Method Forge option and click OK.

The Method Forge dialog box opens. For a detailed description of all the features on the 
Method Forge dialog box, see “Method Forge dialog box” on page 95.

Use the Method Forge to create a master method from an existing raw data file or to 
create a new raw data file to use for the master method. 
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3. In the Method Forge dialog box, do one of the following:

Select the Use the Default Template option. 

–Or–

Select the Select a Custom Template option and highlight your custom template in the 
Method template table.

For detailed instructions on creating a custom method template, see “Creating a Method 
Template” on page 188.

4. Select the Name the Master Method check box and type a name for your master method.

You can enter an existing method name and overwrite it when you create the method. If 
you do not specify a name, the application names the method for the raw data file used to 
create the method.

5. Select the Automatically Create the Master Method check box.

6. Do one of the following:

a. In the Raw File Selection area, choose Use an Existing Raw Data File.

b. Click the browse button and locate a raw data file to use for the method.

c. Go to step 8.

–Or–

a. In the Raw File Selection area, choose Acquire a New Raw Data File.

b. From the Instrument method list, select a method (.meth) file to use for acquiring the 
data.

c. In the Raw Filename box, type the name of the file where the TraceFinder application 
will write the raw data file.

d. In the Path box, type a path or click the browse button and locate a folder where the 
application will save the raw data file.

e. (Optional) Type a comment about the acquired sample or the data file.

7. If you chose to acquire a new raw data file, do one of the following:

Choose Manual Injection.

–Or–

Do the following:

a. Choose Use Autosampler.

b. In the Vial Position box, type a vial position.

c. In the Injection Volume box, type an injection volume.

The minimum injection volume allowed is 0.1 μL; the maximum injection volume 
allowed is 5000 μL.
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8. To automatically create the master method, click OK (or Overwrite).

As the Method Forge creates the method, it displays the following status:

The Method Forge process searches the NIST library and displays the identified 
compound names instead of peak times.

When the acquisition completes, Method Forge performs peak detection, datastore 
searching, and characteristic ion and reference spectrum identification. Method Forge 
then loads this information into a new master method. This process occurs immediately if 
you selected a previously acquired raw data file.

If the compounds in the raw data file you used to create the method are not in the current 
compound datastore, the TraceFinder application displays the compounds in the Edit 
Compound Dependent Parameters dialog box.

9. (Optional) Select the compounds that you want to add to the compound datastore and 
click Add to CDS.

The selected compounds are added to the current compound datastore.

10. To use these compounds in your method and close the dialog box, click Continue to 
Method.

The TraceFinder application uses all compounds found in the raw data file in your 
method and displays the General page of the Master Method View. For a detailed 
description of all the features on the General page, see “General page” on page 111.

Note  You must use the Add to CDS command before you continue to the method.
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11. From the Instrument Method list on the General page, select an instrument method.

12. From the Qualitative Peak Processing Template list, select a method template for 
performing peak detection on quantitative samples following target compound analysis.

13. From the Background Subtraction Range Option list, select how you want the 
background subtraction range determined from one of these options:

• Before Peak: Averages and subtracts a specified number of scans before the apex of 
the peak.

• After Peak: Subtracts a specified number of scans following the apex of the peak.

• Both Sides of Peak: Subtracts a specified number of scans from each side of the apex 
of the peak.

14. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 104.

 To manually select compounds to create a new method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens.

2. In the Create Master Method dialog box, select Use Method Forge and click OK.

The Method Forge dialog box opens. For a detailed description of all the features on the 
Method Forge dialog box, see “Importing an Xcalibur Master Method” on page 97.

3. In the Method Forge dialog box, do one of the following:

Select the Use the Default Template option. 

–Or–

Select Select a Custom Template and highlight your custom template in the Method 
Template table.

For detailed instructions about creating a custom method template, see “Creating a 
Method Template” on page 188.
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4. Select the Name the Master Method check box and type a name for your master method.

You can enter an existing method name and overwrite it when you create the method. If 
you do not specify a name, the method is named for the raw data file used to create the 
method.

5. Ensure that the Automatically Create the Master Method check box is not selected.

6. To select a raw data file, click the browse button and locate the file.

7. To manually create the master method, click OK (or Overwrite).

The Master Method View displays a list of possible matches in the Library Results pane. 
The TraceFinder application displays the best match in the Compound Name list and 
displays the peak spectrum for that compound.
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8. To use a compound other than the compound chosen by the TraceFinder application, 
scroll to the spectrum for that compound and select the compound name in the header of 
the spectrum pane. 

9. After you manually select your compound, click Create to create the master method. 

All compounds found in the raw data file are used in your method. The TraceFinder 
application displays the General page of the Master Method View. For a detailed 
description of all the features on the General page, see “General page” on page 111.

10. From the Instrument Method list on the General page, select an instrument method.

11. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 104. 

Figure 21. Method Forge dialog box

Select 
compound
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Table 19. Method Forge dialog box parameters 

Parameter Description

Method template selection

Use the default 
template

Creates a new method with the default template.

Select a custom 
template

Lists all the available method templates.

For detailed instructions about creating a custom method template, see “Creating a Method 
Template” on page 188.

Name the master 
method

The name for the new master method.

Automatically create 
the master method

When the acquisition completes, Method Forge performs peak detection, library searching, 
and characteristic ion and reference spectrum identification. This information is loaded into 
a new master method. This process occurs immediately when you specify an existing raw 
data file.

Raw file selection

Use an existing raw 
data file

Enables the Raw Filename box where you can select a raw data file to use to create the 
master method.

Acquire a new raw data 
file

Enables functions to acquire data to create a raw data file to use to create the master method.

Instrument 
method

The saved method (.meth) file to use for acquiring the data.

Raw filename The file name where the TraceFinder application writes the raw data.
Path The location where the TraceFinder application saves the raw data file.
Sample comment (Optional) Comment about the acquired sample or the data file.

Manual injection Performs a manual acquisition.
Use autosampler Performs an autosampled acquisition.
Vial position The tray vial number used for the autosampler acquisition.
Injection amount The volume (in milliliters) injected by the autosampler acquisition.
Function button

Overwrite Overwrites the specified master method name. This function is enabled only when the 
specified master method name already exists.

OK Creates a master method using the data and parameters you specified.
Cancel Closes the Method Forge and does not create a master method.
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Importing an Xcalibur Master Method

You can create a new master method from an existing Xcalibur processing method.

 To import an Xcalibur master method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens.

2. In the Create Master Method dialog box, select the Import Xcalibur Processing Method 
option and click OK.

The Import an Xcalibur Method dialog box opens.

3. Click the browse button for the Xcalibur Method to Import box, browse to the Xcalibur 
processing method file, and open the file.

The TraceFinder application imports the compound information from the Xcalibur 
method file.

4. (Optional) Click the browse button for the Raw Data File to Associate box, browse to the 
raw data file, and open the file.

5. (Optional) Change the number of decimal places in the Mass Precision box.

You can set the mass precision decimal places to any integer between 0 and 5, inclusive.

Note  When you associate a raw data file, the application read the mass precision from 
the file and this parameter is unavailable.
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6. Click OK.

If the compounds in the imported Xcalibur method file are not in the Compound 
Datastore, the TraceFinder application displays the compounds in the Edit Compound 
Dependent Parameters dialog box.

7. (Optional) Select the compounds you want to add to the Compound Datastore and click 
Add to CDS.

The selected compounds are added to the current compound datastore.

To add these compounds to the datastore, you must use the Add to CDS command 
before you continue to the method. When you click Continue to Method, the Edit 
Compound Dependent Parameters dialog box closes and you cannot return to add the 
compounds.

8. To add these compounds to your method and close the dialog box, click Continue to 
Method.

The TraceFinder application adds all compounds found in the imported Xcalibur method 
and displays the General page of the Master Method View. For a detailed description of 
all the features on the General page, see “General page” on page 111.

9. From the Instrument Method list on the General page, select an instrument method.

10. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 104. 
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Associating a Raw Data File

You can use the compounds in a previously acquired raw data file to create a new master 
method.

Use the following procedures:

• To associate a raw data file with the method

• To add compounds to the method

 To associate a raw data file with the method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens.

2. In the Create Master Method dialog box, select the Associate a Raw Data File option 
and click OK.

The Associate a Raw Data File dialog box opens.

3. Click the browse button and locate a raw data file to associate with the method.
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4. To set a reference spectrum, do one of the following:

Click Yes.

–Or–

Click Yes, with Background Subtraction.

This feature is available only when you have set background subtraction values on the 
General page of the Master Method View. See “Editing the General Page” on page 106.

The TraceFinder application adds all compounds found in the raw data file to your 
method and displays the General page of the Master Method View. For a detailed 
description of all the features on the General page, see “General page” on page 111.

5. From the Instrument Method list on the General page, select an instrument method.

6. To save the new method, choose File > Save from the main menu.

If the compounds in the associated raw data file are not found in the Compound 
Datastore, you cannot save the method. Follow the instructions “To add compounds to 
the method” on page 100.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 104. 

 To add compounds to the method

1. Click the Compounds tab.

The Detection page is selected by default.

The Detection page shows an empty Compound list and displays the chromatographic 
data for the compounds in the raw data file.

2. Select a filter from the Filter list.
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3. Click the peak in the chromatogram that represents the compound you want to add to 
the method. 

4. Right-click and choose Add This Peak as New Compound from the shortcut menu.

The TraceFinder application performs a library search for the selected compound. The 
application uses the first match it finds as the compound name, the base peak of the mass 
spectrum as the quan peak, and the second and third largest ions as the confirming ions. 

If the name of the first match is already in the library, the Add New Compound dialog 
box opens.
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5. (Optional) In the Add New Compound dialog box, do the following:

a. To use a compound other than the compound already in the library, scroll to the 
spectrum for that compound and select the compound name in the title bar of the 
spectrum pane.

b. In the Type of Compound to Add list, select a compound type.

c. Click OK.

6. Repeat this procedure for each compound you want to add to the method.

For a detailed description of all the features on the Detection page, see “Editing the 
Compounds Page” on page 114. 

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 104. 

Selecting Compounds from the Compound Datastore

You can select compounds from the compound datastore to create a new master method. This 
method for creating a master method is available only when the compound datastore is 
enabled. See “Enabling a Compound Datastore” on page 67.

 To select compounds from the datastore

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens.

Select 
compound
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2. In the Create Master Method dialog box, select the Select Compounds from CDS 
option and click OK.

The Select Compounds to Add dialog box opens, listing all the compounds defined in the 
compound datastore.

3. Select the check box for each of the compounds you want to add to the method.

4. To quickly select multiple compounds, right-click and use any of the commands on the 
shortcut menu.

5. Click Apply.

The TraceFinder application adds the selected compounds to the method. 

6. From the Instrument Method list on the General page, select an instrument method.

7. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 104. 

Table 20. Select Compounds to Add shortcut menu

Command Description

Select All Selects all compounds in the compound datastore.

Deselect All Clears all compounds in the compound datastore.

Copy Down Copies the state (checked or cleared) of the currently selected 
compound to all compounds below it in the compound list.

Note  After you add a compound to a method, the compound is no longer enabled in 
the Select Compounds to Add dialog box. You cannot remove the applied compounds 
from the method by returning to this dialog box. To remove a compound from a 
method, see “Acquisition List” on page 114.
Thermo Scientific TraceFinder User Guide 103



4 Using the Method Development Mode
Working with Master Methods
Editing a Master Method

You can open a master method to view or edit the compounds, method instructions, and 
reporting options in the method.

This section includes instructions for the following tasks:

• Opening a Master Method

• Editing the General Page

• Editing the Compounds Page

• Editing the Flags Page

• Editing the Groups Page

• Editing the Reports Page

Opening a Master Method

Use the TraceFinder application to open a master method that was created and saved in the 
current TraceFinder application or imported from TraceFinder version 1.0.1.

Use the following procedures:

• To open a saved master method

• To open a saved master method from the Recent Files list

 To open a saved master method

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. In the Method View task pane, click Open Method, or choose 
File > Open > Master Method from the main menu.

The Open Master Method dialog box opens.

The Open Master Method dialog box displays all available methods. The list of 
TraceFinder methods can include any method created with TraceFinder 1.0.1 or greater.
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3. Select a master method and click Open.

The General page for the selected method opens in the Method View. For a detailed 
description of all the features on the General page, see “General page” on page 111.

When you open a TraceFinder 1.0.1 method, the TraceFinder application copies all 
components of the selected method including its associated instrument method. 

• If the TraceFinder 1.0.1 master method does not have an associated instrument 
method, the Master Method View for the imported method indicates that you must 
select an instrument method.

• If you open a TraceFinder 1.0.1 master method that uses an instrument method 
name already used in your Xcalibur\methods folder, you are prompted to overwrite 
the instrument method or use the method with the same name already in your 
methods folder.

 To open a saved master method from the Recent Files list

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

When you save a method, the application adds it to the Recent Files list. The Recent Files 
list displays a list of your most recently saved master method files.

2. Click the method name in the Recent Files list. 

The General page for the selected method opens in the Method View. For a detailed 
description of all the features on the General page, see “General page” on page 111.
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Editing the General Page

The General page defines basic information about the master method. For a detailed 
description of all the features on the General page, see “General page” on page 111.

Use the following procedures:

• To specify general information for a master method

• To edit the instrument method parameters

• To set automated background subtraction options

• To specify a chromatogram reference sample

• To specify mass tolerance

 To specify general information for a master method

1. In the Lab Name box, type the name to be displayed on the top of each printed, saved, or 
exported report.

The default name is Default Laboratory.

2. In the Assay Type box, type the assay type to be targeted by the method.

3. From the Injection Volume box, select the injection volume (in μL) to be used for sample 
injection.

Use either the up/down arrows to change the volume in increments/decrements of 1 μL 
or the keyboard to enter non-integer injection volumes. 

4. From the Ion Range Calc Method list, select a method for calculating the ion ratio range 
windows.

When you select Level, the TraceFinder application displays a Use Level list where you 
can choose a calibration level. To define the calibration levels on the Compounds page, 
see “Editing the Compounds Page” on page 114.

5. From the Qualitative Peak Processing Template box, select a template for performing 
peak detection on quantitative samples following target compound analysis.

IMPORTANT  The TraceFinder application uses this injection volume in the master 
method, not the injection volume from the instrument method.
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 To edit the instrument method parameters

1. From the Instrument Method list on the General page, select an instrument method. 

For a detailed description of all the features on the General page, see “General page” on 
page 111.

2. To edit the instrument method for this master method, click Edit.

The Thermo Xcalibur Instrument Setup dialog box opens. This example instrument 
setup shows multiple configured instruments.

3. Edit the values on the instrument page for your instrument.

4. From the main menu on the Thermo Xcalibur Instrument Setup dialog box, 
choose File > Save and then choose File > Exit.

The TraceFinder application returns you to the General page.
Thermo Scientific TraceFinder User Guide 107



4 Using the Method Development Mode
Working with Master Methods
5. To update any changes that were made to the instrument method after you created this 
master method, click Update.

The Update Instrument Method? dialog box opens.

6. Choose one of the following options:

• Send to Xcalibur Method: Overwrites the Xcalibur method with the current 
instrument method.

• Get From Xcalibur Method: Overwrites the current instrument method with the 
Xcalibur method.

• Cancel: Make no changes to the instrument method in the current master method.

 To set automated background subtraction options

1. In the Background Subtraction Range Option list, select how you want the subtraction 
range determined from the following options:

• Before Peak: Averages and subtracts a specified number of scans before the apex of 
the peak.

• After Peak: Subtracts a specified number of scans following the apex of the peak.

• Both Sides of Peak: Subtracts a specified number of scans from each side of the apex 
of the peak.

2. In the Number of Scans to Subtract box, enter a number.

This is the number of scans that the TraceFinder application subtracts from the 
background after averaging. If you specified to subtract scans from both sides of the peak, 
the application subtracts this number of scans from each side of the peak.

3. In the Stepoff Value box, enter a number.

The TraceFinder application uses this offset value to average and subtract scans that are 
not adjacent to the apex of the peak. For example:

If you specified to subtract 3 scans before the peak and the stepoff value is 5, the 
TraceFinder application ignores the first 5 scans to the left of the peak and applies the 
averaging and subtraction to the 6th, 7th, and 8th scans to the left of the peak.
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 To specify a chromatogram reference sample

1. In the Set Chromatogram Reference Sample list, select External.

2. Click Select.

The Open Chromatograph Reference Sample dialog box opens.

3. Select a project from the list of projects.

4. Select a subproject from the list of subprojects.

5. Select a batch from the list of batches.

The TraceFinder application displays only batches that were created using the current 
master method. 

6. Select a sample from the list of processed samples.

The TraceFinder application displays all the processed samples in the selected batch. To 
use a sample as a reference sample, it must have been processed with the current master 
method.

7. Click Open.

The selected sample is displayed as the chromatogram reference sample in the Master 
Method View.

Note  If you are creating a new method, you will not see any reference samples here. 
You must first create and save a batch using this method to see the reference samples 
in this list.

Tip  To clear the reference sample from the master method, select None in the Set 
Chromatogram Reference Sample list.
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 To specify mass tolerance

1. Select the units of measure you want to use. 

2. Specify the number of millimass units or parts per million to use as the m/z ± tolerance 
value.

The application applies this mass tolerance to the extracted chromatograms.
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Figure 22. General page

Table 21. General page parameters  (Sheet 1 of 3)

Parameter Description

Lab name The laboratory name to be displayed on the top of each printed, saved, or exported report. 
Default: Default Laboratory
To specify this default laboratory name, see “Specifying Configuration Defaults” on 
page 68.

Assay type The name for the analysis type to be targeted by the method. The assay type associates the 
method with the analysis of a compound or specific class of compounds (for example, you 
might use an assay type of PAH for the analysis of Polynuclear Aromatic Hydrocarbons). 
The TraceFinder application uses this assay type in the method template. 
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Injection volume The system uses the injection volume (in μL) for sample injection. For a more detailed 
explanation, refer to the documentation for the autosampler.

The injection volume in the master method overrides the injection volume in the 
instrument method. 

The injection volume in the batch overrides the injection volume in the master method.

Range: 0.1 through 5000 μL

Ion range calc method The TraceFinder application uses the selected ion range calc method to calculate the ion 
ratio range windows: Manual (default), Average, Level, or Weighted average. When you 
select Level, an additional list is displayed where you can select a calibration level amount. 
To define these calibration levels on the Compounds page, see “Editing the Compounds 
Page” on page 114.

Instrument method Instrument method used for acquiring samples.

Edit Opens the Thermo Xcalibur Instrument Setup dialog box where you can edit the 
instrument method.

Update Choose one of the following:
• Send to Xcalibur Method: Overwrites the Xcalibur method with the current 

instrument method.
• Get From Xcalibur Method: Overwrites the current instrument method with the 

Xcalibur method.

Qualitative peak 
processing template

The TraceFinder application uses the qualitative peak processing template to perform peak 
detection on quantitative samples following compound analysis.

Background 
subtraction range 
option

Valid values: None, Before Peak, After Peak, Both Sides of Peak
Default: None

Number of scans to 
subtract

Valid values: Even numbered integers
Default: 0

Stepoff value Offset from the selected peak to the first subtracted peak.

Set chromatogram 
reference sample 

Valid values: None, External
Default: None

Set Reference sample This parameter is enabled only when Set Chromatogram Reference Sample is set to 
External. Click the Select button to choose a reference sample from the project folders.

Table 21. General page parameters  (Sheet 2 of 3)

Parameter Description
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Mass Tolerance Upper limit of MMU or PPM.
Default: 500
Range: 0.1 through 50 000

• (Default) MMU (millimass units): MMU is a static calculation to the extracted mass.

• PPM (parts per million): PPM is a variable calculation dependent on the actual mass. 
The smaller the mass, the narrower the tolerance range. The larger the mass, the wider 
the tolerance range.

Notes  Notes you add about the method.

Table 21. General page parameters  (Sheet 3 of 3)

Parameter Description
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Editing the Compounds Page

Use the Compounds page to set all parameters for the identification, detection, and 
quantification for the target compound list. 

From the Compounds page of the Master Method View, you can access the following pages:

• Acquisition List

• Identification

• Detection

• Calibration

• Calibration Levels

• QC Levels

• Real Time Viewer

• Using the Shortcut Menu Commands

Acquisition List

The Acquisition List page displays all compounds defined for the current method. From this 
page, you can add or delete compounds from the method. For a detailed description of all the 
features on the Acquisition List page, see “Acquisition List page” on page 116.

The Acquisition List page is displayed only when you select the Enable Compound Datastore 
option on the Compound Datastore page in the Application Configuration view. For a 
detailed description of all the features on the Application Configuration view., see 
“Application Configuration” on page 56.

Use the following procedures:

• To filter the compound list

• To delete a compound from the list

• To add a compound to the list

 To filter the compound list

1. To display a filtered list of compounds, click the funnel icon, , in the column header.

The application displays a list of filterable criteria. In all lists, you can choose to filter by 
All, Blanks, NonBlanks, or by custom filter criteria. Other filter criteria are specific to the 
individual columns.

2. To create a custom filter based on compound values in a specific column, choose Custom 
from the column list.

For detailed instructions about creating a custom filter, see Appendix C, “Using Filter 
Criteria.” 
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 To delete a compound from the list 

1. Select the compound to remove from the list.

2. Click the Remove Compound icon, , or right-click and choose Remove 
Compound from the shortcut menu.

A confirmation dialog box opens, listing the compound to be removed.

3. To confirm the deletion, click Yes.

The selected compound is removed from the acquisition list, which has no effect on the 
compound datastore.

 To add a compound to the list

1. Click the Add Compound icon, , or right-click and choose Add Compound from 
the shortcut menu.

The Select Compounds to Add dialog box opens, listing all the compounds defined in the 
compound datastore.

2. Select the check box for each of the compounds you want to add to the method.

3. To quickly select multiple compounds, right-click and use any of the commands on the 
shortcut menu.

4. Click Apply.

The TraceFinder application adds the compounds to the Acquisition List and 
Compounds pages of the Master Method View. 

Table 22. Select Compounds to Add shortcut menu

Command Description

Select All Selects all compounds in the compound datastore.

Deselect All Clears all compounds in the compound datastore.

Copy Down Copies the state (checked or cleared) of the currently selected 
compound to all compounds below it in the compound list.
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Figure 23. Acquisition List page

*

Table 23. Acquisition List page parameters  (Sheet 1 of 3)

Parameter Description

Function Icons

Opens the Select Compounds to Add dialog box that lists all the compounds defined in the 
compound datastore.

Deletes the selected compound. The icon is unavailable when no row is selected.

If you used the filters to display a subset of compounds, the selected compound might not be 
visible on the Acquisition List page. 

Compound parameter

Compound Name Alphanumeric name assigned to the compound.

Experiment Type Experiment type: SRM, XIC, or SIM.

Category (Optional) Alphanumeric identifier. 

Ionization (Optional) Alphanumeric identifier. 
Valid values: ESI, APCI, EI, CI, APPI

Chemical Formula (Optional) Alphanumeric chemical identifier.

Quan peak parameters

Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the center of a target 
precursor-ion peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quan ion. The location of the center of a target quan-ion 
peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.
Range: 10.000 to 2999.999
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Mass The mass-to-charge ratio of the quan ion. The location of the center of a target quan-ion 
peak in mass-to-charge ratio (m/z) units. 
Available only for XIC and SIM experiments.
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas. 
Range: –250 to 250

Lens (Optional) Range: –400 to 400

Polarity + (positive) or – (negative)

RT (min) Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

The TraceFinder application uses the RT and Window values to determine the start and stop 
time for the acquisition. 
Range: 0.00 to 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Window (sec) Acquisition window. The TraceFinder application uses the RT and Window values to 
determine the start and stop time for the acquisition. 
Range: 0.00 to 499.50
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Energy Ramp Available only for SRM experiments.
Range: 0.00 to 200.00

Confirming ion parameters

Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the center of a target 
precursor-ion peak in mass-to-charge ratio (m/z) units. 
Available as a read-only field for SRM experiments only.
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quan ion. The location of the center of a target quan-ion 
peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.
Range: 10.000 to 2999.999

Table 23. Acquisition List page parameters  (Sheet 2 of 3)

Parameter Description
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Mass The mass-to-charge ratio of the quan ion. The location of the center of a target quan-ion 
peak in mass-to-charge ratio (m/z) units. 
Available only for XIC and SIM experiments.
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas. 
Available only for SRM experiments.
Range: –250.00 to 250.00

Table 23. Acquisition List page parameters  (Sheet 3 of 3)

Parameter Description
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Identification

The Identification page lists the compounds that are targeted for analysis, reporting, and other 
compound-specific values.

 To filter the displayed compounds

From the Show list, select the type of compounds you want to display in the compounds 
list.

Figure 24. Identification page

 

Compound type Description

Quan compounds Displays only quan compounds, such as target 
compounds, internal standards, and surrogates. 

Target compounds Displays only target compounds.

Internal Standards Displays only internal standard compounds.

Surrogates Displays only surrogate compounds.

Table 24. Identification page parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

The TraceFinder application uses the RT and Window values to determine the start and 
stop time for the acquisition. 
Range: 0.00 to 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Compound A list of compounds that have been identified. To customize the compound names, click the 
cell and type a new name. To display a filtered list of compounds, use the Show list.
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Compound type Compound types are Quan Compound, Target Compound, Internal Standard, and 
Surrogate.

The TraceFinder application uses target compounds, internal standards, and surrogates in 
quantitative analysis.

Active Identifies each compound to be included in data review and reporting. By default, all added 
compounds are set to active. This active or inactive setting populates to the Batch View and 
Data Review view in the Data Review mode. 

CAS No The Chemical Abstract Service (CAS) number that the TraceFinder application matched 
with each compound. To change or add a number, click the CAS No cell and enter a new 
number.

Use as RT Reference When performing peak detection with retention time standards, the TraceFinder 
application first identifies those compounds identified as retention time standards and then 
uses their observed retention times to adjust any associated target compound.

Reference compound Reference compound to be used for retention time adjustment for a compound. This list 
includes all compounds that are selected in the Use as RT Reference column. 

Table 24. Identification page parameters  (Sheet 2 of 2)

Parameter Description
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Detection

Use the Detection page to customize peak detection and integration for any ions that define 
peaks and compounds.

From the Detection page, you can access the following pages:

• Times

• Signal

• Detect

• Spectrum

• Ratios

On the Detection page (see “Detection page” on page 129), you can configure how 
characteristic ions for targeted compounds are detected and integrated. You can also edit the 
list of characteristic ions for a specific compound. Refining these parameters in the master 
method for each compound and its ions can reduce the degree of manual integration that 
would otherwise be required. 

You can change the parameters used to identify a quantification peak, mass range, or 
confirming ion. The TraceFinder application automatically uses the first match it finds as the 
compound name, the base peak of the mass spectrum as the quan peak, and the second and 
third largest ions as the confirming ions. 

Use the following procedures:

• To filter the displayed compounds

• To add compounds to the method

• To change the compound reference spectrum

• To replace a quan mass

• To add a mass to the existing quan mass ranges

• To add a quan peak

• To add a mass as a new compound

• To replace a confirming ion

• To add a mass as a new confirming ion

• To save the new method
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 To filter the displayed compounds

From the Show list, select the type of compounds you want to display in the compounds 
list.

 To add compounds to the method

1. From the main menu, choose Master Method > Associate a Raw Data File.

The Associate a Raw Data File dialog box opens.

2. Browse to a raw data file to associate with the method and open the file.

3. To update the target ion ratio values when you associate this raw data file, select the Yes 
option.

4. To update the scan filters when you associate this raw data file, select the Yes option.

5. To set a reference spectrum, do one of the following:

Select the Yes option.

–Or–

Select the Yes, with Background Subtraction option.

This feature is available only when you have set background subtraction values on the 
General page of the Master Method View. See “Editing the General Page” on page 106.

Compound type Description

Quan compounds Displays all quan compounds, such as target compounds, 
internal standards, and surrogates. 

Target compounds Displays only target compounds.

Internal Standards Displays only internal standard compounds.

Surrogates Displays only surrogate compounds.
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6. Click OK.

The TraceFinder application displays the chromatographic and spectrum data for the 
compounds in the selected raw data file. 

7. Select a filter from the Filter list.

8. Click to select the peak in the chromatogram that represents the compound you want to 
add to the method. 

9. Right-click and choose Add This Peak as New Compound from the shortcut menu.

The TraceFinder application performs a library search for the selected compound. The 
application uses the first match it finds as the compound name, the base peak of the mass 
spectrum as the quan peak, and the second and third largest ions as the confirming ions. 

If the name of the first match is already in the library, the Add New Compound dialog 
box opens.
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Figure 25. Add New Compound dialog box

10. (Optional) To use a compound other than the compound already in the library, scroll to 
the spectrum for that compound and select the compound name in the title bar of the 
spectrum pane.

11. In the Type of Compound to Add list, select a compound type.

12. Click OK.

13. Repeat this procedure for each compound you want to add to the method.

Selected 
compound
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 To change the compound reference spectrum

1. In the raw data file chromatogram pane, click a peak.

The TraceFinder application displays the spectrum for the selected peak in the spectrum 
pane.

2. In the raw data file spectrum pane, right-click and choose Use This Spectrum for 
Compound Reference Spectrum from the shortcut menu.

The TraceFinder application replaces the spectrum on the Spectrum page of the quan 
peak pane with this spectrum. 

 To replace a quan mass

1. Click the pane for the quan mass that you want to replace. 

2. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

3. Right-click and choose Set This Mass as Quan Mass from the shortcut menu.

4. Choose either Don’t Update Ion Ratios or Update Ion Ratios Using This Spectrum.

You can see the updated ion ratios on the Ratios page for the confirming ions. See 
“Ratios” on page 149.

 To add a mass to the existing quan mass ranges

1. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Mass to Existing Quan Mass Ranges from the 
shortcut menu.

3. Choose either Don’t Update Ion Ratios or Update Ion Ratios Using This Spectrum.

The TraceFinder application adds the selected mass to the existing quan mass ranges to 
increase the signal. 

If you chose to update the ion ratios, you can see the updated ion ratios on the Ratios 
page for the confirming ions. See “Ratios” on page 149.
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 To add a quan peak

1. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Mass as New Quan Peak from the shortcut menu.

The application adds a new quan peak to the compound.

You can use the shortcut menu on the spectrum pane for this new quan peak to perform 
any of the tasks you could perform on the original quan peak.

 To add a mass as a new compound

1. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Mass as New Compound from the shortcut menu.

The TraceFinder application performs a library search for the selected compound. The 
application uses the first match it finds as the compound name, the base peak of the mass 
spectrum as the quan peak, and the second and third largest ions as the confirming ions. 

If the name of the first match is already in the library, the Add New Compound dialog 
box opens with the matching compound selected.
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Figure 26. Add New Compound dialog box

3. (Optional) In the Add New Compound dialog box, make any of the following changes:

a. Change the name for the compound in the Name of New Compound box.

b. Use a compound other than the compound chosen by the TraceFinder application by 
scrolling to the spectrum for that compound and selecting the compound name in 
the title bar of the spectrum pane.

c. In the Type of Compound to Add list, select a compound type.

4. Click OK.

Selected 
compound
Thermo Scientific TraceFinder User Guide 127



4 Using the Method Development Mode
Working with Master Methods
 To replace a confirming ion

1. Click the pane for the confirming ion that you want to replace. 

2. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

3. Right-click and choose Set this Mass as Confirming Ion from the shortcut menu.

The TraceFinder application replaces the confirming ion with the selected mass.

 To add a mass as a new confirming ion 

1. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add this Mass as New Confirming Ion from the shortcut menu.

The TraceFinder application adds the confirming ion to the quan peak.

You can use the shortcut menu on the spectrum pane for this new confirming ion to 
perform any of the tasks you could perform on the original confirming ions.

 To save the new method

1. Choose File > Save.

The Save Master Method dialog box opens.

2. Do one of the following:

Type a new name for the master method and click OK.

–Or–

Select a method name to overwrite and click Overwrite.

The TraceFinder application saves the new method data in the following folder:

…\Thermo\TraceFinder\1.1\Methods 
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Figure 27. Detection page
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Table 25.  Detection page parameters

Parameter Description

Compound list Lists all compounds in the master method.

Quan peak Displays a chromatogram for the quan peak and its confirming ions. The quan peak and 
confirming ion panes include additional pages for retention time, signal, detection, 
spectrum, and ratio parameters.

Filter Displays the filter used for the raw data file.

Reference 
chromatogram and 
spectra

Displays a reference chromatogram and spectra for the raw data file.

Additional pages

Times Defines the retention time and window for a quan peak. 
See “Times” on page 131.

Signal Defines the detector and its parameters used to display each chromatogram trace. See 
“Signal” on page 132.

Detect Defines the peak detection algorithm and its options. 
See “Detect” on page 135.

Spectrum Defines a reference mass spectrum for a quan peak or compound. See “Spectrum” on 
page 144.

Ratios Defines the criteria for evaluating, confirming, or qualifying ions. See “Ratios” on page 149.
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Times

Use the Times page to define the retention time and window for a quan peak. 

Figure 28. Times page

Table 26. Times page parameters

Parameter Description

Expected RT (min) Expected retention time. The time after injection when the 
compound elutes. The total time that the compound is retained 
on the column. 

Window (sec) Width of the window (in seconds) to indicate how far around the 
expected retention time the system looks for a peak apex. 

View width (min) Viewable size of the ion chromatogram display. Changing the view 
width does not affect the process of peak detection; the 
TraceFinder application uses it only for graphical display. 
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Signal

Use the Signal page to define the detector and its parameters as you display each 
chromatogram trace. For a detailed description of all the features on the Signal page, see 
“Signal page parameters” on page 133.

 To specify ranges of ions for detection and integration

1. In the Ranges area, click Edit.

The Edit Mass Ranges dialog box opens where you can enter rows using a center of mass 
or a range.

Figure 29. Edit Mass Ranges dialog box

2. Enter a value in the Center Mass box and click Add.

The application adds a row with this value to the ranges grid. Center mass values are listed 
in the Start m/z column. The application uses a range of one amu centered on this value.

3. Enter values in the Start m/z and End m/z columns and click Add.

The application adds a row with these start and end values.

4. Add as many ranges as you want.

When you process a batch with this method, the application sums the multiple ions 
specified by these ranges. 

5. Click Apply.

When you are editing a master method, the application applies the entries to the list of 
ranges.
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Figure 30. Signal page

Table 27. Signal page parameters  (Sheet 1 of 2)

Parameter Description

Detector MS: Mass spectrometers. 
Analog: Supplemental detectors (for example, FID, ECD). 
AD card: If you have a detector not under data system control, you can capture the analog signal and 
convert it to digital using an interface box (for example, SS420X) for storage in the raw data file. 

Filter Represents a particular data acquisition channel. For example, the filter option + c Full ms 
[35.00-500.00] represents a positive ion centroid signal acquired in single-stage, full-scan mode from 
m/z 35 to 500.

Trace Represents a specific range of the data. In conjunction with the filter, the TraceFinder application 
uses the trace to identify the characteristic ions for a compound. The options are: Mass Range, TIC, 
or Base Peak.
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Ranges

Edit Opens the Edit Mass Ranges dialog box where you can specify a range of ions for detection and 
integration. See “Edit Mass Ranges dialog box” on page 132.

Start m/z
End m/z

Specifies ranges of ions for detection and integration. The application sums the multiple ions 
specified by these ranges. 

Ranges specified by a center mass value are listed as a single value in the Start m/z column. The 
application uses a range of one amu centered on this value. 

Table 27. Signal page parameters  (Sheet 2 of 2)

Parameter Description
134 TraceFinder User Guide Thermo Scientific



 4 Using the Method Development Mode
Working with Master Methods
Detect

Use the Detect page to define the peak detection algorithm (sensitivity) and its options and to 
determine the area under a curve. There are three sensitivity modes: Genesis, ICIS, and 
Avalon. On this page, you can specify how you want each mode to run.

For a detailed description of all the features on the Detect page for Genesis sensitivity, 
see “Detect page parameters for Genesis” on page 137.

For a detailed description of all the features on the Detect page for ICIS sensitivity, 
see “Detect page parameters for ICIS” on page 140.

For a detailed description of all the features on the Detect page for Avalon sensitivity, 
see “Detect page parameters for Avalon” on page 142.

 To apply current peak detection settings to all peaks 

1. Edit the parameters for either the Quan peak or a Confirming peak.

2. Right-click the Detect page and choose Apply to All Peaks in Method from the shortcut 
menu.

The application updates all compounds in the method with the current settings on the 
Detect page. These updates apply to both quan and confirming ions.

 To apply current peak detection settings to all peaks that use the same detection 
mode

1. Edit the parameters for either the Quan peak or a Confirming peak.

2. Right-click the Detect page and choose Apply to All Peaks with Like Sensitivity Setting 
from the shortcut menu.

The application uses the current settings on the Detect page to update all compounds in 
the method that use the same sensitivity mode (Genesis, ICIS, or Avalon). These updates 
apply to both quan and confirming ions that use the same sensitivity mode.
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Figure 31. Detect page for Genesis
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Table 28. Detect page parameters for Genesis  (Sheet 1 of 2)

Parameter Description

Sensitivity Specifies the Genesis peak detection algorithm.

Detection method Highest peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration.

Range: Any odd integer from 1 through 15 points
Default: 1 

S/N threshold Current signal-to-noise threshold for peak integration. Peaks with signal-to-noise values less 
than this value are not integrated. Peaks with signal-to-noise values greater than this value 
are integrated. 

Range: 0.0 to 999.0

Enable valley detection Uses the valley detection approximation method to detect unresolved peaks. This method 
drops a vertical line from the apex of the valley between unresolved peaks to the baseline. 
The intersection of the vertical line and the baseline defines the end of the first peak and the 
beginning of the second peak. 

Expected width (sec) The expected peak width parameter (in seconds). This parameter controls the minimum 
width that a peak is expected to have if valley detection is enabled. 

With valley detection enabled, any valley points nearer than the expected width/2 to the top 
of the peak are ignored. If a valley point is found outside the expected peak width, the 
TraceFinder application terminates the peak at that point. The application always terminates 
a peak when the signal reaches the baseline, independent of the value set for the expected 
peak width. 

Range: 0.0 to 999.0

Constrain peak width Constrains the peak width of a component during peak integration of a chromatogram. You 
can then set values that control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain Peak Width check box 
enables the Peak Height (%) and Tailing Factor options.

Peak height (%) A signal must be above the baseline percentage of the total peak height (100%) before 
integration is turned on or off. This text box is active only when you select the Constrain 
Peak Width check box. 

Range: 0.0 to 100.0%
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Tailing factor A factor that controls how the TraceFinder application integrates the tail of a peak. This 
factor is the maximum ratio of the trailing edge to the leading side of a constrained peak. 
This text box is active only when you select the Constrain the Peak Width check box. 

Range: 0.5 through 9.0

Min peak height (S/N) For the valley detection approximation method to use the Nearest RT Peak Identification 
criteria, this peak signal-to-noise value must be equaled or exceeded. For component 
identification purposes, the TraceFinder application ignores all chromatogram peaks that 
have signal-to-noise values that are less than the S/N Threshold value. 

Range: 0.0 (all peaks) through 999.0

Peak S/N cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test identifies an edge of a peak when the baseline adjusted height of the edge is less 
than the ratio of the baseline adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 200, the TraceFinder 
application defines the right and left edges of the peak when the S/N reaches a value less 
than 200. 

Range: 50.0 to 10000.0

Valley rise (%) The peak trace can rise above the baseline by this percentage after passing through a 
minimum (before or after the peak). 

This method drops a vertical line from the apex of the valley between unresolved peaks to 
the baseline. The intersection of the vertical line and the baseline defines the end of the first 
peak and the beginning of the second peak. 

When the trace exceeds rise percentage, the TraceFinder application applies valley detection 
peak integration criteria. 

The TraceFinder application applies this test to both the left and right edges of the peak. 

The rise percentage criteria is useful for integrating peaks with long tails.

Range: 0.1 to 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this parameter ensures that the 
surrounding measurements are higher. 

Range: 1.0 to 100.0
Default: 2.0

# background scans Number of background scans performed by the TraceFinder application.

Report noise as Determines if the noise used in calculating S/N values is calculated using an RMS 
calculation or a peak-to-peak resolution threshold. Options are RMS or Peak to Peak.

Table 28. Detect page parameters for Genesis  (Sheet 2 of 2)

Parameter Description
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Figure 32. Detect page for ICIS
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Table 29. Detect page parameters for ICIS  (Sheet 1 of 2)

Parameter Description

Sensitivity Specifies the ICIS peak detection algorithm.

Detection method Highest peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration.

Range: Any odd integer from 1 through 15 points
Default: 1 

Area noise factor The noise level multiplier used to determine the peak edge after the location of the possible 
peak. 

Range: 1 through 500
Default: 5 

Peak noise factor The noise level multiplier used to determine the potential peak signal threshold.

Range: 1 through 1000
Default: 10

Baseline window The TraceFinder application looks for a local minima over this number of scans.

Range: 1 through 500
Default: 40

Constrain peak width Constrains the peak width of a component during peak integration of a chromatogram. You 
can then set values that control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain Peak Width check box 
enables the Peak Height (%) and Tailing Factor options.

Peak height (%) A signal must be above the baseline percentage of the total peak height (100%) before 
integration is turned on or off. This text box is active only when you select the Constrain 
Peak Width check box. 

Range: 0.0 to 100.0%

Tailing factor A factor that controls how the TraceFinder application integrates the tail of a peak. This 
factor is the maximum ratio of the trailing edge to the leading side of a constrained peak. 
This text box is active only when you select the Constrain the Peak Width check box. 

Range: 0.5 through 9.0
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Min peak height (S/N) For the valley detection approximation method to use the Nearest RT Peak Identification 
criteria, this peak signal-to-noise value must be equaled or exceeded. For component 
identification purposes, the TraceFinder application ignores all chromatogram peaks that 
have signal-to-noise values that are less than the S/N Threshold value. 

Range: 0.0 (all peaks) through 999.0

Noise method The options are INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level.

Repetitive: Uses a multiple pass algorithm to determine the noise level. In general, this 
algorithm is more accurate in analyzing the noise than the INCOS Noise algorithm, but the 
analysis takes longer. 

Min peak width The minimum number of scans required in a peak.

Range: 0 to 100 scans
Default: 3

Multiplet resolution The minimum separation in scans between the apexes of two potential peaks. This is a 
criterion to determine if two peaks are resolved.

Range: 1 to 500 scans
Default: 10 

Area tail extension The number of scans past the peak endpoint to use in averaging the intensity.

Range: 0 to 100 scans
Default: 5

Area scan window The number of allowable scans on each side of the peak apex. A zero value defines all scans 
(peak-start to peak-end) to be included in the area integration. 

Range: 0 to 100 scans
Default: 0 

RMS Specifies that the TraceFinder application calculate noise as RMS. By default, the 
application uses Peak To Peak for the noise calculation. RMS is automatically selected if you 
manually determine the noise region.

Table 29. Detect page parameters for ICIS  (Sheet 2 of 2)

Parameter Description
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Figure 33. Detect page for Avalon

Table 30. Detect page parameters for Avalon  (Sheet 1 of 2)

Parameter Description

Sensitivity Specifies the Avalon peak detection algorithm.

Detection method Highest Peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.
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Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration.

Range: Any odd integer from 1 through 15 points
Default: 1 

Autocalc Initial Events Automatically calculates the events in the Event list.

Edit Opens the Avalon Event List dialog box. See “Avalon Event List” on page 80.

Table 30. Detect page parameters for Avalon  (Sheet 2 of 2)

Parameter Description
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Spectrum

Use the Spectrum page to store a reference mass spectrum for a quan peak or compound.

For a detailed description of all the shortcut menu commands on the Spectrum page, see 
“Spectrum shortcut menu functions” on page 148.

Use the following procedures:

• To update confirming ion ratios

• To change the quantitation mass used for a quan peak

• To add ions together to get an accumulated signal

• To add a quan peak to an existing compound

• To add one or more confirming ions to an existing compound

• To zoom in on the chromatogram or spectrum displays

 To update confirming ion ratios

1. Click a peak in the quan peak chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. Right-click the Spectrum pane and choose Update Confirming Ion Ratios with This 
Spectrum from the shortcut menu.

 To change the quantitation mass used for a quan peak

1. Click a peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the spectrum pane. 

2. In the spectrum pane, hold the cursor over the m/z value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected.

3. Right-click and choose one of the following commands from the shortcut menu:

• Set This Mass as Quan Mass > Don’t Update Ion Ratios

• Set This Mass as Quan Mass > Update Ion Ratios Using This Reference Spectrum

The following examples show an original quan peak and a quan peak with an updated quan 
mass.
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Figure 34. Original quan peak mass example

The TraceFinder application replaces the original quan mass with the selected mass.

Figure 35. Updated quan peak example

Original quan peak mass

New quan peak mass
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 To add ions together to get an accumulated signal

1. Hold the cursor over the m/z value for an ion in the Spectrum pane. 

A red box around the ion’s m/z value indicates that the ion is selected.

2. Right-click and choose Add This Mass to Existing Quan Mass Range from the shortcut 
menu.

You can now update the ion ratios to adjust the confirming ion comparisons to the new 
summed quan peak signal.

 To add a quan peak to an existing compound

1. Click the peak in the Quan Peak chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. In the Spectrum pane, hold the cursor over the m/z value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected.

3. Right-click and choose Set This Mass as New Quan Peak from the shortcut menu. 

The TraceFinder application adds this ion as a new quan peak.

New quan peak mass
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 To add one or more confirming ions to an existing compound

1. Click the peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. In the Spectrum pane, hold the cursor over the m/z value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected. 

3. Right-click and choose to Add This Mass as New Confirming Ion from the shortcut 
menu.

The TraceFinder application adds the selected mass as a confirming peak for this quan 
peak.

 To zoom in on the chromatogram or spectrum displays

1. Drag the cursor to delineate a rectangle.

The display zooms in on the specified rectangle.

2. To return to the original display, right-click and choose Reset Scaling from the shortcut 
menu.
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Figure 36. Spectrum page

Table 31. Spectrum shortcut menu functions 

Functions Description

Update confirming ion 
ratios with this spectrum

Updates the confirming ion ratios using the selected peak.

Set this mass as quan 
mass

Adds the quan mass of the selected ion to the quantitation mass used for the quan peak. 
You can choose to update the ion ratios or not update the ion ratios using this reference 
spectrum.

Add this mass to 
existing quan mass range

Adds the selected mass to your existing quan mass range. You can choose to update the ion 
ratios to adjust the confirming ion comparisons to the new summed quan peak signal.

Set this mass as new 
quan peak

Adds a new quan peak to an existing compound.

Add this mass as new 
confirming ion

Adds one or more confirming ions to an existing compound.

Reset scaling Returns the chromatogram or spectrum display to its original size. 
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Ratios

Use the Ratios page to define the criteria for evaluating the confirming or qualifying ions. The 
TraceFinder application detects compounds that have confirming ion values outside their 
acceptable window and flags them in the Acquisition mode and on reports. 

For a detailed description of all the features on the Ratios page, see “Ratios page parameters” 
on page 150.

 To specify ion ratio criteria

1. Select the Enable check box to enable the confirming ion. 

2. In the Target Ratio box, select the theoretical ratio of the confirming ion’s response to the 
quantification ion’s response. 

3. In the Window Type list, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

4. In the Window (+/-%) box, select the acceptable ion ratio range. 

5. In the Ion Coelution box, select the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak.

In the following example:

• The target ratio is expected to be 61.02% and the window is Absolute 20%, so the 
acceptable window for this confirming ion is 41.02 to 81.02%. 

• If, instead, the window type is Relative, the plus or minus value is 20% of 61.02% (or 
12.20%), so the acceptable window for this confirming ion is 48.82 to 73.22%. 
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Figure 37. Ratios page

Table 32. Ratios page parameters

Parameter Description

Enable Makes the ion ratio criteria available.

Target ratio (%) The theoretical ratio of the confirming ion’s response to the quantification ion’s response. 

Window type The absolute or relative calculation approach for determining the acceptable ion ratio range. 

Window (+/-%) The acceptable ion ratio range.

Ion coelution (min) The maximum difference in retention time between a confirming ion peak and the 
quantification ion peak.
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Calibration

Use the Calibration page to set or edit the mathematical model used for preparing the initial 
calibration evaluation for one or more calibration standards. 

Each target compound can have its own initial calibration settings, independent of the other 
compounds. You can modify the calibration approach on this page or in Acquisition mode 
when you view the results of an actual calibration batch. 

Figure 38. Calibration page

Table 33. Calibration page parameters

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

Compound type Displays the compound type as an internal standard, an external standard, or a target 
compound.

Standard type Specifies Internal or External standards.

Response via The use of area or height.

Curve type Specifies Linear, Quadratic, or AverageRF curve types.

Origin The origin treatment as Ignore, Include, or Force. The Origin and Weighting columns are 
active only when you are using Linear or Quadratic curve types. 

Weighting Specifies the weighting as Equal, 1/X, 1/X^2, 1/Y, or 1/Y^2.

Units The units to be displayed with the calculated values.

ISTD The internal standard (ISTD) for a target compound or surrogate if the standard type is set 
to Internal. If you set the standard type to External, this field is inactive.

Amount The amount of the internal standard for ISTD compounds. 
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Calibration Levels

On the Calibration levels page for a master method, you can define the standards for 
calibration. You can edit calibration levels and concentrations for master methods only. The 
contents of this page are read-only when you are editing a local method. 

 To specify calibration levels and concentrations

1. Select the compound whose calibration levels and concentrations you want to define. 

2. In the Manage Calibration Levels area, type a value for the first calibration level.

The TraceFinder application adds a new, empty calibration level row beneath the edited 
row.

3. Continue adding calibration levels.

When you finish adding calibration levels, you can specify the concentrations for each 
level for each compound.

4. To enter the concentrations to the table, do the following:

a. Select the first calibration level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.

5. Repeat Step 4 for all calibration levels associated with the first compound.

6. To specify the same concentration values for all compounds, select the value you want to 
copy, right-click, and choose Copy Down from the shortcut menu. 
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Figure 39. Calibration Levels page

 

Table 34. Calibration levels page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

cal1-caln User-defined calibration levels for the compound.

Manage Calibration 
levels

Defines values for each of the calibration level values for the selected compound.
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QC Levels 

Use the QC levels page for a master method to define the standards for QC levels. You can 
edit QC levels for master methods only. The contents of this page are read-only when you are 
editing a local method. For a detailed description of all the features on the QC Levels page, see 
“QC levels page parameters” on page 155.

 To specify QC levels and concentrations

1. Select the compound whose QC levels, percentage test values, and concentrations you 
want to define. 

2. In the QC Levels area, type a name for the first QC level.

The TraceFinder application adds a new, empty QC level row beneath the edited row.

3. Type a value for the % Test.

The % Test is the acceptable difference (as a percentage) between the known amount and 
the calculated (measured) amount of each QC level.

4. Continue adding QC levels and values for the percentage test.

When you finish adding QC levels, you can specify the concentrations for each level for 
each compound.

5. To enter the concentration values to the table, do the following:

a. Select the first QC level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.
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6. Repeat Step 5 for all QC levels associated with the first compound.

7. To specify the same concentration values for all compounds, select the value you want to 
copy, right-click, and choose Copy Down from the shortcut menu. 

Figure 40. QC Levels page

Table 35. QC levels page parameters

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

QC1-QCn User-defined quality control levels for the compound.

QC levels

Level User-defined quality control level names.

% Test A value for the acceptable difference (as a percentage) between the known amount and 
calculated (measured) amount of each QC level.
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Real Time Viewer 

Use the Real Time Viewer page to specify which traces display in the real-time status pane 
when you perform acquisition in the Acquisition mode or when you acquire a development 
batch in the Method Development mode. See “Real-time Display” on page 246.

Figure 41. Real Time Viewer page

 

Table 36. Real Time Viewer page parameters  (Sheet 1 of 2)

Parameter Description

Show Quan Peaks 
Only

Displays only quan peaks in the compounds list. Quan peaks are indicated with a check in 
the Quan Peak column.

Displayable Traces

Quan Peak Checks indicate quan peak traces. Unchecked traces indicate confirming ions.

Compound Name Names of all compounds in the method.

Trace Lists the simple mass or precursor mass for all traces—both quan peak and confirming 
ion—for each compound.

Moves the selected trace to the Traces to Display in Real Time Viewer pane.

Moves the selected trace to the Displayable Traces pane.
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Using the Shortcut Menu Commands

Each page on the Compounds page (except the Acquisition List page) uses right-click shortcut 
menu commands to display or hide the retention column, remove compounds from the 
method, copy and paste data, or save the compound list to a .csv file.

Moves all traces to the Displayable Traces pane. 
To move multiple traces to the Traces to Display... pane, hold down the SHIFT key, select 
multiple traces, and then click .

Traces to Display in 
Real Time Viewer (0/25)

List the traces to be displayed and the display order in the real-time viewer in the 
Acquisition mode. Maximum number of traces is 25. 

Move to Top Moves the selected trace to the top of the Traces to Display... list and the second position in 
the real-time display. The TIC is always the first position in the real-time display.

Move Up Moves the selected trace up one position in the list.

Move Down Moves the selected trace down one position in the list.

Move to Bottom Moves the selected trace to the bottom of the list.

Table 36. Real Time Viewer page parameters  (Sheet 2 of 2)

Parameter Description

Table 37.  Compounds page shortcut menu  (Sheet 1 of 2)

Command Description

Copy down Copies the value in the selected row to all rows below it. This 
command is available only when you have selected a value that 
can be copied down. See Appendix B, “Using Copy Down and 
Fill Down.” 

Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master 
method.
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Copy Copies the data in the selected rows or columns to the Clipboard. 
Use this command to copy compound information to another 
application, such as an Excel spreadsheet. You cannot paste this 
data back into the method development compound list, but you 
can paste this copied data into other areas of the TraceFinder 
application.

Copy With Headers Copies the data in the selected rows or columns and the 
associated column headers to the Clipboard. Use this command 
to copy sample information to another application, such as an 
Excel spreadsheet. 

For example:

You cannot paste this data back into the method development 
compound list.

Paste Pastes a single column of copied data from another application, 
such as an Excel spreadsheet, into the selected column. The 
pasted data must be valid data for the selected column.

Undo Last Paste Removes the last pasted item in the method development 
compound list. 

Export to CSV file Opens the Save As dialog box where you can save the current 
compound list to a .csv file.

Table 37.  Compounds page shortcut menu  (Sheet 2 of 2)

Command Description

Copy With Headers 
from TraceFinder

Paste into Excel spreadsheet
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Editing the Flags Page

Use the Flags page to set limits and ranges so the TraceFinder application can review the data 
and results as an aid to final approval.

From the Flags page of the Master Method View, you can access these additional pages:

• Limits

• Calibration

• Chk Std

• Matrix Blank

• Solvent Blank

• ISTD

• Surrogate

• Lab Control (Environmental and Food Safety)

• Method Val (Environmental and Food Safety)

• Matrix Spike (Environmental and Food Safety)
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Limits 

Use the Limits page to define levels of review for quantified results. Quantified results appear 
on printed and electronic reports. You can also define when a quantified value is reported 
instead of reporting less than a particular limit. 

Figure 42. Limits page

Table 38. Limits page parameters 

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

LOD (Detection limit) Limit of detection. The lowest amount that can be detected. 
Usually derived from a method detection limit (mdl) study.

LOQ (Quantitation 
limit)

Limit of quantitation. The lowest amount that can be confidently 
and accurately quantitated. This is usually the lowest calibration 
amount.

LOR (Reporting limit) Limit of reporting. Also called cutoff in some industries. This is 
the lowest amount that can be reported, as determined by each 
laboratory’s standard operating practices.

ULOL (Linearity limit) Upper limit of linearity. This is usually the highest calibrator 
amount.

Carryover limit The highest amount of a substance that does not leave a residual 
amount in the instrument. If a substance has a carryover limit of 5, 
amounts higher than 5 usually dirty the instrument and leave 
residue behind, tainting the following sample. A carryover limit of 
less than 5 does not leave any residual amounts of the substance.
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Calibration 

Use the Calibration page to define acceptable criteria for initial calibration. The TraceFinder 
application makes the evaluation by comparing the initial calibration results for each 
compound found in the sample to the values defined on this page. 

On the Calibration report, the application flags the calculated values for internal standard 
compounds that exceed these limits.

Figure 43. Calibration page

Table 39. Calibration page parameters

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

R^2 threshold The minimum correlation coefficient (r2) for an acceptable 
calibration (when in linear or quadratic mode). 

Max RSD (%) The maximum relative standard deviation (RSD) for an acceptable 
calibration (when in average RF mode). 

Min RF The minimum average response factor (RF) for an acceptable 
calibration (when in average RF mode). 

Max Amt Diff (%) The maximum deviation between the calculated and theoretical 
concentrations of the calibration curve data points (when in linear 
or quadratic mode). 
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Chk Std

Use the Chk Std page to review the calibration on an ongoing basis. The TraceFinder 
application makes the evaluation by comparing the quality check standard results for each 
compound in the sample to the initial calibration using values defined on this page. 

On the Check Standard report, the TraceFinder application flags the calculated values for 
internal standard compounds that exceed these limits.

For linear and quadratic modes, the maximum difference for the calculated concentration in 
the Chk Std sample versus the theoretical value is set on the QC levels page of the 
Compounds page.

Figure 44. Chk Std page

Table 40.  Chk Std page parameters

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Max RF Diff (%) The maximum deviation between the response factor (RF) of the 
Chk Std sample and the average response factor from the 
calibration (when in average RF mode). 

Min RF The minimum response factor for the Chk Std sample (when in 
average RF mode). 
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Matrix Blank 

Use the Matrix Blank page to define acceptable levels of target compounds in blank samples. 
The TraceFinder application makes the evaluation by comparing the calculated concentration 
for each compound in the sample to the maximum concentration defined on this page. You 
can enter the maximum concentration as a percentage of a flag value or as a specified value. 

On the Matrix Blank report, the application flags the calculated values for target compounds 
that exceed these limits. 

 To specify the maximum concentration as a percentage

1. From the Method column list, select one of the following methods:
• None
• Concentration
• % of LOD
• % of LOQ
• % of LOR

2. In the Percentage column, type a percentage value.

 To specify the maximum concentration as an absolute value

1. From the Method column list, select Concentration.

2. In the Max Conc column, type an absolute value.

 To specify no maximum concentration

From the Method column list, select None. 

Figure 45. Matrix Blank page

Table 41.  Matrix Blank page parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.
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Method The evaluation process used for comparing the calculated 
concentration. You can specify no maximum, a specific 
concentration, or a percentage of the LOR, LOD, or LOQ. 

Percentage The percentage of the LOR, LOD, or LOQ if you are using the 
percentage approach. 

Max Conc The maximum concentration if you are using an absolute value. 

Table 41.  Matrix Blank page parameters  (Sheet 2 of 2)

Parameter Description
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Solvent Blank 

Use the Solvent Blank page to view or edit QC values for solvent reporting. The evaluation is 
made by comparing the calculated response for each compound in the sample to the 
maximum response defined on this page. 

On the Solvent Blank report, the TraceFinder application flags the calculated values for target 
compounds that exceed these limits. 

Figure 46. Solvent Blank page

Table 42. Solvent Blank page parameters

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Method The evaluation process to use as a response for the quan ion only 
(Quan Ion RT) or a summed response for the quan ion and any 
confirming ions (All Ion RT). To deactivate the solvent blank test 
for a specific compound, select None. 

Upper Limit Specifies an upper limit for each compound in the sample when 
you select an evaluation process. These values are not 
concentrations; they are raw response values.
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ISTD 

Use the ISTD page to review the response and retention time of internal standards (if 
available). The TraceFinder application makes the evaluation by comparing the area and 
retention time results for each internal standard compound in the sample to a specified range.

If all of your target compounds are set to external calibration mode or you have not identified 
any compounds as internal standards, this page does not show any values. 

Figure 47. ISTD page

Table 43. ISTD page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. 
The total time that the compound is retained on the column. 

Compound The compound name.

Min recovery (%) The minimum and maximum percent recoveries for the internal 
standards to define an acceptable range. For check standards, the 
TraceFinder application compares the response of each internal 
standard in each sample to a range around the average of the 
responses of that compound in all of the calibration standards. For all 
other samples, the application calculates the comparison range 
around the check standard responses if a check standard is available in 
the batch. If no check standard is available, the application tests 
against the initial calibration.

Max recovery (%)

Min RT (–min) The minimum and maximum drift (in minutes) for the internal 
standards to define an acceptable range. For check standards, the 
TraceFinder application compares the retention time of each internal 
standard in each sample to a range around the average of the retention 
times of that compound in all of the calibration standards. For all 
other samples, the application calculates the comparison range 
around the check standard retention times if a check standard is 
available in the batch. If no check standard is available, the 
application tests against the initial calibration.

Max RT (+min)

CV Test (%) Coefficient of Variance test.
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Surrogate 

Use the Surrogate page to view or edit values for surrogate recovery reporting. The application 
makes the evaluation by comparing the calculated concentration for each compound in the 
sample to the theoretical concentration and range defined on this page. 

You can use these parameters to evaluate the performance of your method. For this evaluation, 
prepare, analyze, and evaluate a number of samples (typically 4 to 10) to document method 
accuracy and precision as a comprehensive whole. 

On the Surrogate Recovery report, the application flags the calculated values for method 
validation compounds that exceed these limits. 

Figure 48. Surrogate page

Table 44. Surrogate page parameters 

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Theo Conc Values for the compounds that represent the expected theoretical 
concentration of that compound in the sample. 

Min recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that the application can determine 
by comparing the observed calculated concentration in the analysis 
to the expected concentration. Each method validation compound 
can have its own values for these fields, independent of other 
method validation compounds. 

Max recovery (%)

Max RSD (%) The maximum relative standard deviation of the set of observed 
concentrations for a component across the set of method 
validation samples. 
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Lab Control (Environmental and Food Safety)

Use the Lab Control page to view and edit QC values for lab control sample (LCS) and lab 
control sample duplicate (LCSD) analyses. The application makes the evaluation by 
comparing the calculated concentration for each compound in the sample to the theoretical 
concentration and range defined on this page. 

You can prepare samples (typically known as clean matrices) as LCS or LCSD. These 
represent samples where you have added known concentrations of target analytes. To define 
an LCS and its duplicate in a batch, select the appropriate sample type and a common sample 
ID. 

On the Lab Control report, the application flags the calculated values for spiked compounds 
that exceed these limits.

Figure 49. Lab Control page

Table 45. Lab Control page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. 
The total time that the compound is retained on the column. 

Compound The compound name.

Theo Conc Values for the lab control compounds that represent the expected 
theoretical concentration of that compound in the sample. 

Min recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that the application can determine by 
comparing the observed calculated concentration in the analysis to the 
expected concentration. Each LCS or LCSD compound can have its 
own values for these fields, independent of other LCS or LCSD 
compounds. 

Max recovery (%)

Max RPD Specifies a maximum value for relative percent difference (RPD) 
between two spiked samples. 
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Method Val (Environmental and Food Safety)

Use the Method Val page to view or edit QC values for method validation reporting. The 
application makes the evaluation by comparing the calculated concentration for each 
compound in the sample to the theoretical concentration and range defined on this page. 

You can use these parameters to evaluate the performance of your method. For this evaluation, 
prepare, analyze, and evaluate a number of samples (typically 4 to 10) to document method 
accuracy and precision as a comprehensive whole. To define a method validation sample in 
the batch, select the appropriate sample type. 

On the Method Validation report, the application flags the calculated values for method 
validation compounds that exceed these limits. 

Figure 50. Method Val page

Table 46. Method Val page parameters

Parameter Description

RT Retention time for the compound.
Compound The compound name.
Theo Conc Values for the compounds that represent the expected theoretical 

concentration of that compound in the sample. 
Min recovery (%) A range of the allowable minimum recovery percentage and the 

maximum recovery percentage that the application can determine 
by comparing the observed calculated concentration in the analysis 
to the expected concentration. Each method validation compound 
can have its own values for these fields, independent of other 
method validation compounds. 

Max recovery (%)

Max RSD (%) The maximum relative standard deviation of the set of observed 
concentrations for a component across the set of method 
validation samples. 
Thermo Scientific TraceFinder User Guide 169



4 Using the Method Development Mode
Working with Master Methods
Matrix Spike (Environmental and Food Safety)

Use the Matrix Spike page to view or edit QC values for matrix spike and matrix spike 
duplicate analyses. The application makes the evaluation by comparing the calculated 
concentration for each compound in the sample (after subtracting the original sample value) 
to the theoretical concentration and range defined on this page. 

To evaluate matrix spike or matrix spike duplicate compounds, prepare samples as MS or 
MSD. These represent samples where you have added known concentrations of target 
analytes. To define a sample, its MS, and its MSD in the batch, select the appropriate Sample 
Type and a Sample ID. 

Sample IDs must be unique. Duplicating Sample IDs can cause incorrect samples to be 
included in reports.

On the MS/MSD report, the application flags the calculated values for spiked compounds 
that exceed these limits. 

Figure 51. Matrix Spike page

Table 47. Matrix Spike page parameters 

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Theo Conc Values for the matrix spike compounds that represent the expected 
theoretical concentration of that compound in the sample. You 
can apply or not apply the dilution factor for a sample to the 
calculated matrix spike concentrations.

Min recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that can be determined by 
comparing the observed calculated concentration in the analysis to 
the expected concentration. Each matrix spike sample can have its 
own values for these fields, independent of other matrix spike 
samples. 

Max recovery (%)

Max RPD Specify a maximum value for relative percent difference (RPD) 
between two spiked samples. 
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Editing the Groups Page 

Use the Groups page of the Master Method View to organize compounds into functional or 
logical groups. You can use these groups for creating a subset of target compounds. For a 
detailed description of all the features on the Groups page, see “Groups page parameters” on 
page 172.

For quantitative processing, the TraceFinder application processes all compounds in the 
method and stores the complete result set, but only those in the selected group are visible in 
the Acquisition mode. Limiting the displayed compounds to those in the selected group can 
be useful when working with a master method containing a large list of compounds, only 
some of which are required for analysis in certain samples. In that case, the application 
requires only a single method and can reduce the results. To display only those compounds to 
be used in quantitative processing, select Quan Compounds from the Show list. 

You can create multiple groups and include the same compound in more than one group. 

 To create a group

1. From the Show list, select the type of compounds you want to view.

2. At the bottom of the Groups area, click Add Group.

The Add a New Group dialog box opens.

3. Type a name for the new group and click OK.

The new group appears in the Groups area.

4. Drag a compound from the Compounds area onto a group name (as if you were moving 
files into a folder).

5. To remove all the compounds from a group, rename the group, or delete it, right-click the 
group name and choose from the shortcut menu.

6. To remove a single compound, right-click the compound name in the group and choose 
Remove from Group from the shortcut menu.
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Figure 52. Groups page

Table 48. Groups page parameters 

Parameter Description

Compounds Lists all available compounds.

Groups Lists all available groups.

Add Group Opens the Add a New Group dialog box where you can create a 
new group.

Shortcut menu

Empty group Removes all compounds from the selected group.

Rename group Changes the name of the selected group.

Delete group Removes the selected group and all the compounds in it.

Remove from group Removes the selected compound from its group.
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Editing the Reports Page

Use the Reports page to specify how you want to save or print your reports. For a detailed 
description of the features on the Reports page, see “Reports page parameters” on page 176.

For the Quantitation Report type, you can modify quan report, user interface, quan flag, and 
surrogate correction options in the Report Options pane. 

This section includes instructions for the following tasks:

• Specifying Report Formats

• Specifying Quan Report Settings

• Specifying Target Screening Settings

Specifying Report Formats

• For each standard report, you can create a hardcopy printout, a PDF file, or an XML file. 

• For each custom report, you can create a hardcopy printout or an Excel Macro-Enabled 
Workbook (.xlsm) file. 

• For each target screening report, you can create a hardcopy printout or a PDF file. 

In addition to the report type, you can specify a report description for each of your reports. 
The default report description is the report name.

 To specify standard report types and output formats

1. Click the Reports tab.

The Reports page displays the following columns for all configured reports:

• The Example icon that opens an example PDF of the report type

• Report Name, Report Description, and Report Type

• Options to create a hardcopy, PDF file, or XML file for standard report types

• Options to create a hardcopy or Excel Macro-Enabled Workbook file for custom 
report types

• Options to create a hardcopy or PDF file for target screening report types

• The Batch Level option that indicates which reports are batch-level reports

For information about configuring which reports are available when you create a master 
method or which reports create a batch-level report, see “Specifying the Reports 
Configuration” on page 58.
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2. To edit the Report Description, double-click the name and type your new name.

The TraceFinder application uses this name for all reports that use this master method. 
You cannot edit the Report Description from other report views.

3. To specify the type of report output to create for each report type, select the check box in 
the appropriate column.

4. To duplicate the output type for all reports, click the cell to select it, then right-click and 
choose Copy Down from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell. This action applies only to reports where this output format is 
available.

By default, all report types are cleared.
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Figure 53. Reports page 
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Figure 54. Reports page, continued

Table 49.  Reports page parameters 

Parameter Description

Example Opens a PDF that displays an example of the report type.

Report Name The name of a report. 

Report Description The user-defined description to be used on a report. 

Print Sends reports to the printer. 

Create PDF Saves reports as PDF files. 
Available only for standard reports.

Create XML Exports reports in XML format. 
Available only for standard reports.

Create XLSM Exports reports in Excel Macro-Enabled Workbook (.xlsm) format.
Available only for custom reports.

Batch Level Rather than creating separate reports for each sample, the application uses a composite of 
the data from all the samples to create a single report for the entire batch. Batch-level reports 
are prepended with a B to differentiate them.
You cannot select this option from the Reports page. You must select the Batch Level option 
for the report in the report configuration. See “Specifying the Reports Configuration” on 
page 58. 
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Specifying Quan Report Settings 

Use the options on the Quan Report Settings page to choose parameters for flagging values 
and displaying information in standard report types.

Use the following procedures:

• To specify quantitation limits

• To specify user interface options

• To specify quantitation flag options

• To correct surrogates

• To track the use of the tune file

 To specify quantitation limits

1. To report the calculated concentration at all times or only when the quantified value 
exceeds LOD, LOQ, or LOR, choose the appropriate value from the Report 
Concentration list.

For a description of concentration limits, see “Limits” on page 160. 

2. To select the number of decimal places to report for calculated concentrations, set the 
value in the Decimal Places to be Reported box.

3. To include a chromatogram of the sample in the Quantitation Report, select the Show 
Chromatogram on Quantitation Report check box.

4. To display only valid compounds, select the Display Compounds Above Set Limit check 
box.
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 To specify user interface options

1. To shade a compound row on any of the reports if a value fails one of the criteria used for 
evaluation, select the Shade Row when Sample is Outside of Evaluation Criteria check 
box.

2. To separate the ion overlay pane from the confirming ion plots, select the Separate Ion 
Overlay Display check box.

3. To use an alternate format for the Calibration Report designed to print more concisely 
and limit the report to a maximum of 7 calibration standards, select the Use Alternate 
Calibration Report Format check box.

4. To display flags and a legend on high density reports, select the Display Quan Flags and 
Legend check box.

 To specify quantitation flag options

Select the values you want to display in the report.

Values are above or below the limits defined on the Quan page. 

These flags appear on a variety of reports and are defined in the “Quan Report Settings 
page parameters” on page 180.
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 To correct surrogates

Select the Correct Surrogates check box.

The TraceFinder application applies the conversion factor (specified in the sample row in 
the batch) to the sample’s calculated concentrations for surrogates as the conversion factor 
is applied to target compounds.

 To track the use of the tune file

1. Select the Enable Tune Time Tracking check box.

This option tracks the number of hours between the last instrument tune and each 
sample acquisition.

2. In the Tune File Lifetime box, enter the number of hours you want to allow between the 
last instrument tune and a sample acquisition. 

Any sample acquired outside this maximum allowable time is flagged on the Batch report. 
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Figure 55. Quan Report Settings page
 

 

Table 50. Quan Report Settings page parameters  (Sheet 1 of 2)

Parameter Description

Quan Limits Flags

Report concentration Reports the concentration at all times or only when the quantified value exceeds either the 
limit of detection (LOD), the limit of quantitation (LOQ), or the limit of reporting (LOR). 
Report concentration: Always, >LOD, >LOQ, or >LOR.

Decimal places to be 
reported

Number of decimal places to be included in the report. Maximum value is 6.

Show chromatogram 
on Quantitation 
Report

Displays a chromatogram (TIC trace) of the sample on the quantitation report. 

Display compounds 
above set limit

Prints only the positive compounds in a sample. If a compound is above the specified Quan 
Flag Options limits, the TraceFinder application reports the compound.

User Interface Options

Shade row when 
sample is outside of 
evaluation criteria

Shades a compound row on any of the reports if a value fails one of the criteria used for 
evaluation. 

Separate ion overlay 
display

Separates the ion overlay pane from the confirming ion plots in data review. 

Use alternate 
calibration report 
format

Uses an alternate format for the Calibration Report that is designed to print more concisely 
(this report is limited to a maximum of 7 calibration standards). 

Display Quan flags and 
legend

Displays manual flags, confirming manual flags, quan flags, and a legend on high density 
reports.
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Quan Flag Options
Values that are above or below limits defined on the Limits page. These flags appear on a 
variety of reports. 

Flag values below LOD Flags values below the limit of detection (LOD).

Flag values below LOQ Flags values below the limit of quantitation (LOQ).

Flag values above LOR Flags values above the limit of reporting (LOR).

Flag values above 
ULOL

Flags values above the upper limit of linearity (ULOL).

Flag values above 
Carryover

Flags values above the carryover limit.

Flag values between 
LOD and LOQ

Flags values between the limit of detection and the limit of quantitation known as the J flag.

Surrogate Correction Option

Correct surrogates Applies the conversion factor (specified in the sample row in the batch) to the sample’s 
calculated concentrations for surrogates as the conversion factor is applied to target 
compounds. For example, if you added surrogates to the sample as part of sample 
preparation and you require a dilution for analysis, the TraceFinder application dilutes the 
surrogates and target compounds and applies a dilution correction to correct for this 
dilution. However, if you added surrogates after a dilution has occurred, then you can leave 
the option cleared so that, while the target compounds are corrected for the dilution, the 
surrogates are reported “as is.”

Tune Time Tracking Options

Enable tune time 
tracking

Tracks the number of hours between the last instrument tune and each sample acquisition.

Tune file lifetime Specifies the maximum number of hours between the last instrument tune and a sample 
acquisition. Any sample acquired outside this maximum allowable time is flagged on the 
Batch report.

Table 50. Quan Report Settings page parameters  (Sheet 2 of 2)

Parameter Description
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Specifying Target Screening Settings 

Use the options on the Target Screening Settings page to set the parameters required to 
produce Target Screening reports. For a detailed description of the features on the Target 
Screening Settings page, see “Target Screening Settings page parameters” on page 185.

The TraceFinder application use these parameters to process a raw data file and create a report 
similar to a ToxID report. See “Example Target Screening Summary Report” on page 187.

Use the following procedures:

• To specify the default parameters

• To calculate and report semi-quantitative results

• To specify the ion ratio calculation method

• To specify the exact mass window

• To specify the Exactive parameters

 To specify the default parameters

1. Click the Processing Configuration File browse button and select a configuration file 
(.csv).

2. From the Screening Method list, select one of these compound screening methods.
•(Default) Auto Detect
•Based on Full MS2 scans
•Based on SRM and MS2 scans
•Based on MS2 and MS3 scans
•Based on MS3 scans
•Based on accurate mass scans
•Based on SRM scans
•Based on Exactive screening method
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3. Type the name of the company to print on the report.

4. Type the name of the laboratory to print on the report.

5. Click the Company Logo browse button and select a graphic file (.jpg, .gif, or .bmp) to 
print on the report.

6. In the m/z Window box, enter a value for the window above and below the m/z value for 
the compounds.

7. In the RT Window box, enter a value for the window above and below the retention time 
value for the compounds.

8. In the MS2 Search Library boxes, type the names of as many as three search libraries for 
searching MS/MS spectra.

9. In the MS3 Search Library boxes, type the names of as many as three search libraries for 
searching MS3 spectra.

10. Select the Use Full MS Scan to Confirm check box if you want to confirm library search 
results with parent ion peak detection in the full scan. 

When the application does not detect a peak in the full scan, the compound is not 
reported as a hit.

 To calculate and report semi-quantitative results

1. In the Semi Quantitative area, do the following:

a. Select the Report Semi-Quantitative Result check box.

b. Type the measurement units. 

The measurement units are used only for labeling purposes.

2. Select either the Scan Intensity or Peak Area option. 

• Scan Intensity: The application measures the intensity of the MS/MS peak without 
performing background subtraction. 

• Peak Area: The application measures the peak area of the reconstructed full scan 
chromatogram peak of the parent ion. When you select Peak Area, the Use Full MS 
Scan to Confirm check box is automatically selected.
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 To specify the ion ratio calculation method

1. Select the Use Scan at Peak Apex or Use Average Scan option.

• Use Scan at Peak Apex: The application calculates the ion ratio based on the peak 
apex scan spectrum.

• Use Average Scan: The application calculates the ion ratio based on the average scan 
spectrum over the range of the peak’s half height. The relative intensity in the 
configuration file must use the selected scan method.

2. In the Ion Ratio Window (%) box, type the acceptable percentage of the intensity of the 
qualifier ion to the quan ion.

For example, when the Ion Ratio Window is 20% and the quan ion has an 
intensity/height of 100, the specified confirming ion/mass must have a height of at least 
80 to be considered found.

 To specify the exact mass window

Type a total window width value in parts per million for the Exact Mass Window.

For example, when you expect a mass of 50 with a window of 2, the algorithm creates an 
XIC based on the responses of all masses from 49 to 51.

 To specify the Exactive parameters

1. Type values for Adduct 1, Adduct 2, and Adduct 3. 

These values identify the adducts listed in and applied throughout the configuration file. 
Adducts are polarity sensitive. For negative ionization, enter negative adduct values.

These values default to H+, NH4+, and Na+, respectively.

2. To search the entire raw data file for the specified peak, do the following:

a. Select the No Specified Retention Time check box.

b. Select either the First Peak or Highest Peak option. 

When the search finds more than one m/z match in the raw data file, the application 
uses the specified peak for processing.
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3. Select the Report All Compounds Listed in Configuration File check box to report all 
compounds in the configuration file whether or not matches are found for them. 

The default reports on only those compounds where matches are found in the raw data 
file. This option applies to the Exactive experiment only.

Figure 56. Target Screening Settings page 

 

Table 51. Target Screening Settings page parameters  (Sheet 1 of 2)

Parameter Description

Processing 
Configuration File

Specifies a configuration file (.csv).

Screening Method Specifies one of the following screening methods:
• (Default) Auto Detect
• Based on Full MS2 scans
• Based on SRM and MS2 scans
• Based on MS2 and MS3 scans
• Based on MS3 scans
• Based on accurate mass scans
• Based on SRM scans
• Based on Exactive screening method

Note  Using the Auto Detect method, the ToxID application can identify the screening 
experiment implemented in the acquired data file.

Company Name Specifies the name of the company to print on the report.

Laboratory Name Specifies the name of the laboratory to print on the report.

Company Logo Specifies a graphic file (.jpg, .gif, or .bmp) to print on the report.

m/z Window (mu) Specifies a value for the window above and below the m/z value for the compounds.

RT window (min) Specifies a value for the window above and below the retention time value for the 
compounds.
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MS2 Search Library Specifies the names of as many as three search libraries for searching MS/MS spectra.

MS3 Search Library Specifies the names of as many as three search libraries for searching MS3 spectra.

Use Full MS Scan to 
Confirm

Specifies that the application confirms library search results with parent ion peak detection 
in the full scan. When the application does not detect a peak in the full scan, the compound 
is not reported as a hit.

Semi Quantitative

Report 
Semi-Quantitative 
Result

Measurement Unit

Calculation based on Specifies one of the following calculation methods:
• Scan Intensity: Specifies that the application measures the intensity of the MS/MS peak 

without performing background subtraction. 
• Peak Area: Specifies that the application measures the peak area of the reconstructed full 

scan chromatogram peak of the parent ion. When you select Peak Area, the Use Full MS 
Scan to Confirm check box is automatically selected.

Ion Ratio Calculation Method (In SRM Experiment)

Use Scan at Peak Apex Specifies that the application calculates the ion ratio based on the peak apex scan spectrum.

Use Average Scan Specifies that the application calculates the ion ratio based on the average scan spectrum 
over the range of the peak’s half height. The relative intensity in the configuration file must 
use the selected scan method.

Ion Ratio Window(%)

Accurate Mass Experiment

Exact Mass Window Specifies a value in parts per million for the accurate mass experiment.

Exactive

Adduct 1–n Specifies the adducts listed in and applied throughout the configuration file. Adducts are 
polarity sensitive. For negative ionization, enter negative adduct values.
Defaults: Adduct 1: H+, Adduct 2: NH4+, and Adduct 3: Na+

No Specified Retention 
Time 

Specifies either First Peak or Highest Peak to use for processing when the search finds more 
than one m/z match in the raw data file.

Report All Compounds 
Listed in Configuration 
File

Specifies that in an Exactive experiment, the application reports all compounds in the 
configuration file whether or not matches are found for them. 
Default: Reports only those compounds where matches are found in the raw data file.

Table 51. Target Screening Settings page parameters  (Sheet 2 of 2)

Parameter Description
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Figure 57. Example Target Screening Summary Report

Your Company Name
Summary Report

Raw File Name: C:\Xcalibur\examples\ToxID\Exact_Mass\Exact_Mass_Test.RAW
Config File Name: C:\Xcalibur\examples\ToxID\Exact_Mass\ConfigFile_Exact_mass.csv
Sample Name: Laboratory: Your Lab Name
Acquistion Start Time: 3/24/2008 4:46:43 PM
Screening Conditions: Based on accurate mass scans. Exact mass window (ppm): 30, RT window(min): 0.50.

Peak 1

Peak 2

Peak 3

Peak 4

Peak 5

Peak 6

2 4 6 8 10 12
Time (min)

0

50

100
0

50

100
0

50

100
0

50

100
0

50

100
0

50

100 2.58
2.52

2.391.99
2.84 4.16

4.66
4.69

4.824.06 7.68 9.47
5.19

5.364.12 10.151.53
3.57

3.49
3.130.87 3.80 12.50

4.18

4.33 11.50
3.98

3.72 4.12

NL: 2.03E5
m/z= 240.15580-240.16300
F: FTMS + c ESI Full ms
[120.00-1000.00]

NL: 1.26E7
m/z= 250.17665-250.18415
F: FTMS + c ESI Full ms
[120.00-1000.00]

NL: 1.18E7
m/z= 278.18643-278.19477
F: FTMS + c ESI Full ms
[120.00-1000.00]

NL: 2.12E6
m/z= 328.14938-328.15922
F: FTMS + c ESI Full ms
[120.00-1000.00]

NL: 4.59E6
m/z= 342.16507-342.17533
F: FTMS + c ESI Full ms
[120.00-1000.00]

NL: 9.08E6
m/z= 337.20734-337.21746
F: FTMS + c ESI Full ms
[120.00-1000.00]

Peak
Number

Compound Name Expected
m/z

Detected
m/z

Delta
(mDa)

Delta
(ppm)

Expected
RT

Actual RT Intensity

1 Albuterol 240.15940 240.15939 -0.0 -0.0 2.58 2.58 199505
2 Alprenolol 250.18040 250.18039 -0.0 -0.0 4.50 4.66 12604499
3 Amitriptyline 278.19060 278.19061 0.0 0.0 5.00 5.19 11769755
4 6-Acetylmorphine 328.15430 328.15433 0.0 0.1 3.30 3.57 2112090
5 6-Acetylcodeine 342.17020 342.17035 0.1 0.4 4.10 4.18 4593306
6 Acebutolol 337.21240 337.21246 0.1 0.2 3.80 3.98 9077282
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Creating a Method Template

In the TraceFinder application, you can create a processing method using a method template 
that contains the basic settings. 

Use the following procedures:

• To create a method template

• To specify peak criteria

• To identify the peaks

• To specify confirming ions

• To calibrate the compounds

• To enter a note for the method

• To save the method template

 To create a method template

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. Click Method View in the navigation pane.

3. From the main menu, choose File > New > Method Template.

The Method Template Editor opens. For a complete description of the Method Template 
Editor, see “Method Template Editor dialog box” on page 195.
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 To specify peak criteria

1. In the Find the Peaks area, select a sensitivity level.

In selecting the degree of sensitivity, you define how extensively the peak detector 
algorithm searches for low-level peaks. 

• The Genesis peak detection algorithm is provided for backward compatibility with 
Xcalibur 1.0 studies. 

• The ICIS peak detection algorithm is designed for MS data and has superior peak 
detection efficiency at low MS signal levels. 

• The Avalon peak detection algorithm is designed for integrating UV/Vis and analog 
chromatograms. 

2. To look for peaks only in a certain range of the entire chromatogram, select the Limit the 
Retention Time Range check box and specify a retention time (RT) range. 

3. To indicate whether to select peaks by relative height or area and the percentage of the 
highest peak that results in compound selection, select the Enable Peak Threshold check 
box.

To consider a peak for a processing method, the TraceFinder application uses the Enable 
Peak Threshold filter to determine which peaks meet the specified percentage of the 
largest peak.

4. To display a specific number of the largest peaks by height or area, select the Only Select 
Top Peaks check box and enter the number of peaks to display.
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 To identify the peaks

1. In the Use these Libraries box, select the libraries you want to search.

All libraries loaded on your instrument are displayed in the Use these Libraries box. 

2. To limit the number of hits returned when the system searches a spectrum against the 
selected libraries, set a value in the Limit Library Hits box.

3. To specify how to sort the library searches, select a value from the Best Match Method 
list.

 To specify confirming ions

1. To set the number of confirming ions, select the Include Confirming Ions check box 
and enter a value in the Number of Confirming Ions box.

This value is the number of other ions in the spectrum whose ratio is compared to the 
quantitation ion. Using this ratio, you can then determine if it is the target compound or 
something else. This value defaults to 2 because you typically perform a 3-ion experiment 
with one quan mass and two confirming ions. 

The system selects the most intense ion to use as the quantitation mass and uses this mass 
for the mathematical operations. 
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2. To define the criteria for evaluating confirming or qualifying ions, select the Specify 
Default Ion Ratio Ranges check box and set the following values:

a. To specify the maximum difference in retention time between a confirming ion peak 
and the quantification ion peak, set a value in the Ion Coelution (min) box. 

b. To specify an absolute or relative calculation approach for determining the acceptable 
ion ratio range, select Absolute or Relative from the Window Type list.

c. To specify the acceptable ion ratio range, set a value in the Window (+/– %) box.

3. To include the peak spectrum in the processing method, select the Include Compound 
Peak Spectrum as Reference Spectrum check box.

 To calibrate the compounds

1. From the Calibration Method list, select Internal or External.

2. From the Curve Type list, select one of the following:

• Linear: All other settings are available with this exception: When you select Include in 
the Origin list, all weighting values are unavailable except for Equal.

• Quadratic: All other settings are available with this exception: When you select 
Include in the Origin list, all weighting values are unavailable except for Equal.

• Average RF: No selections in the Weighting or Origin lists are available. The 
Weighting list is set to Equal, and the Origin list is set to Ignore. 

3. From the Origin list, select one of the following:

• Ignore: Specifies that the origin is not included as a valid point in the calibration 
curve when the curve is generated. When you select Ignore, the calibration curve 
might or might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the origin of the data point 
plot when the calibration curve is generated.

• Include: Specifies that the origin is included as a single data point in the calculation 
of the calibration curve. When you select Include, the calibration curve might or 
might not pass through the origin.
Thermo Scientific TraceFinder User Guide 191



4 Using the Method Development Mode
Working with Master Methods
4. From the Weighting list, select one of the following:

• Equal: Specifies that the origin is included as a single data point in the calculation of 
the calibration curve. When you select Equal, the calibration curve might or might 
not pass through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their response (or response ratio). 

5. From the Response Via list, select Area or Height.

• Area: Specifies that the TraceFinder application use this area value in response 
calculations.

• Height: Specifies that the application use this height value in response calculations. 
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 To specify qualitative peak processing

1. Select the Use Genesis Algorithm for Qual Processing check box and specify a value for 
internal standard matching. 

The application uses the Genesis algorithm to match internal standards in a range 
plus/minus the value you specify. For additional information about the Genesis 
algorithm, see “Genesis Detection Method” on page 73.

2. Select or clear the Exclude Matching Quan Peaks check box and specify a value for the 
exclusion window.

The application excludes quan peaks in a range plus/minus the value you specify.

3. To process samples that include data-dependent scans, select the Use Data Dependent 
Scans check box.

When you process a sample using this feature, the application uses the TIC trace to find 
all data-dependent full scans, lists them, and performs a library search against the 
data-dependent MS/MS or MSn scan.

In addition to the peak information, the TIC Report and TIC Summary Report display 
information about the data-dependent filtered data. See Appendix A, “Reports.” 
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 To enter a note for the method

Type in the Notes box, or paste text from another application using CTRL+V.

You can add a note to your method template to explain what makes this template unique. 

 To save the method template

1. Choose File > Save from the Method Template Editor menu.

The Save Method Template dialog box opens.

2. Do one of the following:

Type a new name for the master method and click OK.

–Or–

Select a method name to overwrite and click Overwrite.

The TraceFinder application saves the new method template in the following folder:

…\Thermo\TraceFinder\1.1\Templates\Methods 
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Figure 58. Method Template Editor dialog box 
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Table 52. Method Template Editor dialog box parameters  (Sheet 1 of 3)

Parameter Description

Find the peaks

Sensitivity Defines how extensively the peak detector algorithm searches for low-level peaks. 

Limit the retention time 
range

Min RT specifies the beginning of the range. Max RT specifies the end of the range. 

Enable peak threshold Specifies whether to select peaks by relative height or area and the percentage of the highest 
peak that results in compound selection.

Only select top peaks Displays a specific number of the largest peaks by height or area.

Identify the peaks

Use these libraries Lists the libraries you can search.

Limit library hits Specifies the number of hits returned when the system searches a spectrum against the 
selected libraries.

Best match method Specifies how to sort the library searches. 
Valid values: Search Index, Reverse Search Index, Match Probability

Handle confirming ions

Include confirming ions/
Number of confirming 
ions

Specifies the number of confirming ions, which are other ions in the spectrum whose ratio 
is compared to the quantitation ion to identify the compound.

This value defaults to 2 because you typically perform a 3-ion experiment with one quan 
mass and two confirming ions.

Specify default ion ratio 
ranges

Enables the ion ratio range features.

Ion Coelution specifies the maximum difference in retention time between a confirming 
ion peak and the quantification ion peak. 

Window Type specifies an Absolute or Relative calculation approach for determining the 
acceptable ion ratio range.

Window (+/-%) specifies the acceptable ion ratio range.

Include compound peak 
spectrum as reference 
spectrum

Includes the peak spectrum in the processing method. Use this setting to perform a spectra 
comparison in Data Review. 

Calibrate the compounds

Calibration method Specifies an internal or external calibration method.

Curve type Specifies a linear, quadratic, or average RF curve type.
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Origin Specifies that the origin is ignored, forced, or included in the generated calibration curve.
• Ignore: Specifies that the origin is not included as a valid point in the calibration curve 

when the curve is generated. When you select Ignore, the calibration curve might or 
might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the origin of the data point 
plot when the calibration curve is generated.

• Include: Specifies that the origin is included as a single data point in the calculation of 
the calibration curve. When you select Include, the calibration curve might or might 
not pass through the origin.

Weighting Specifies the weighting for the calibration data points.
• Equal: Specifies that the origin is included as a single data point in the calculation of 

the calibration curve. When you select Equal, the calibration curve might or might not 
pass through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data points during the least-squares 
regression calculation of the calibration curve. Calibrants are weighted by the inverse 
of their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted by 
the inverse of the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data points during the least-squares 
regression calculation of the calibration curve. Calibrants are weighted by the inverse 
of their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted by 
the inverse of the square of their response (or response ratio). 

Response via Specifies if the TraceFinder application uses area or height in response calculations.
• Area: Specifies that the application use this peak area value in response calculations.
• Height: Specifies that the application use this peak height value in response 

calculations. 

Qualitative Peak Processing

Use Genesis algorithm 
for qual processing

The application uses the Genesis algorithm to match internal standards. 

ISTD matching Excludes all the target compounds found in the method and does not list these compounds 
in the TIC Report or in the Qual Mode view in the Data Review.

Table 52. Method Template Editor dialog box parameters  (Sheet 2 of 3)

Parameter Description
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Importing Published Master Methods 

In the TraceFinder application, you can import published methods to use for detecting, 
processing, and reporting. The Tracefinder installation provides the following folder of 
published methods:

…\Thermo\TraceFinder\1.1\Published Master Methods

 To import a published master method

1. From the Method View task pane, click Import Published Method. 

The Import Published Method dialog box opens.

2. Select a method to import.

3. Click Import.

The application reports that the method successfully imported and saves the method in 
the following folder:

…\Thermo\TraceFinder\1.1\Methods

You can use any of the Open Method commands to open this method just as you would a 
method you created.

Exclude matching quan 
peaks

Exclusion window

Compares the retention time of the internal standard in the method to the found retention 
time of the internal standard in the library search and excludes peaks outside the Exclusion 
Window range. 

Defines a range plus/minus the Exclusion Window value you specify.

Use data dependent 
scans

Constrains the Qual Mode view in the Data Review to only data-dependent scan spectra. 
See “Qual Mode” on page 313. In addition to the peak information, the TIC Report and 
TIC Summary report display information about the data-dependent filtered data.

Table 52. Method Template Editor dialog box parameters  (Sheet 3 of 3)

Parameter Description
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Exporting SRM Data

In the TraceFinder application, you can export your selected reaction monitoring (SRM) data 
to an XML file. The Export SRM Data command is available only when you select the Enable 
Compound Datastore option on the General page in the Application Configuration view. See 
“Application Configuration” on page 56.

 To export SRM data to an XML file

1. Open the master method whose SRM data you want to export.

2. From the Method View task pane, click Export SRM Data. 

The TraceFinder application writes the data in the SRM table to the following file:

…\Thermo\TraceFinder\1.1\Methods\methodname.xml

The data in this file matches the TSQ .xml data, which you can use in the instrument 
method editor of the TSQ application.

Figure 59. SRM TSQ Quantum™ example
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Working with Instrument Methods
An instrument method is a set of experiment parameters that define the operating settings for 
an autosampler, mass spectrometer, and so on. Instrument methods are saved as file 
type .meth.

Use the following procedures:

• To open the Instrument View

• To create a new instrument method

• To create a new multiplexing instrument method

• To open an instrument method

• To import an instrument method

 To open the Instrument View

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. Click the Instrument View task pane.

IMPORTANT  Do not open the Thermo Foundation Instrument Configuration window 
while the TraceFinder application is running.
200 TraceFinder User Guide Thermo Scientific



 4 Using the Method Development Mode
Working with Instrument Methods
 To create a new instrument method

1. Click New Instrument Method in the Instrument View task pane.

The Thermo Xcalibur Instrument Setup window opens.

This example instrument setup shows multiple configured instruments.

2. Click the icon for the instrument you want to use for the method.

3. Edit the values on the instrument page.

4. From the main menu in the Thermo Xcalibur Instrument Setup window, choose File > 
Save As.

The Save As dialog box opens.
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5. Select an instrument method name to overwrite or type a new name for the instrument 
method, and click Save.

The File Summary Information dialog box opens.

6. (Optional) Type a comment about the new instrument method.

7. Click OK.

The TraceFinder application saves the new instrument method in the following folder:

…\Xcalibur\methods
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 To create a new multiplexing instrument method

1. Click New Instrument Method in the Instrument View task pane.

The Thermo Xcalibur Instrument Setup window opens.

Figure 60. Example instrument setup showing a configured multiplexed instrument

2. Click the icon for the instrument you want to use for the method.

3. Edit the values for the instrument method.

For information about specifying multiplexing values, refer to the documentation for 
your multiplexed instrument.

4. Specify the channels you want to use for acquisition. For example:

5. From the main menu in Thermo Xcalibur Instrument Setup window, choose File > Save 
As.

The Save As dialog box opens.
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6. Select an instrument method name to overwrite or type a new name for the instrument 
method, and click Save.

The File Summary Information dialog box opens.

7. (Optional) Type a comment about the new instrument method.

8. Click OK.

The TraceFinder application saves the new instrument method in the following folder:

…\Xcalibur\methods
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 To open an instrument method

1. Click Open Instrument Method on the Instrument View task pane.

An instrument method browser opens.

2. In the browser, select an instrument method from the list and open the file.

The selected method opens in the Thermo Xcalibur Instrument Setup window. You can 
edit this method and save the changes, or you can save this method to another name.

Figure 61. Example instrument setup showing multiple configured instruments

Note  To open Help for any of your configured instruments, click Help on the 
instrument page.
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 To import an instrument method

1. From the Instrument View task pane, click Import Published Method. 

The Import Published Method dialog box opens. This dialog box lists the master 
methods in the Published Master Methods folder. You can import instrument methods 
that are associated with these published master methods. 

2. Select a method that includes the instrument method you want to import.

For instructions for importing the master methods, see “Importing Published Master 
Methods” on page 198.

3. Click Import.

The Save Instrument Method dialog box opens.

4. Do one of the following:

Type a new name for the instrument method and click OK.

–Or–

Select an instrument method name to overwrite and click Overwrite.

The application reports that the method successfully imported.

You can use any of the Open Instrument Method commands to open this method just as you 
would an instrument method that you created.
206 TraceFinder User Guide Thermo Scientific



 4 Using the Method Development Mode
Working with Development Batches
Working with Development Batches 
In the Development Batch view, you can test your instrument method in real time by creating 
and acquiring test samples. Development batches let you test different instrument methods 
and optimize parameters, such as MS source parameters and autosampler variables, to find the 
best conditions for a master method. Development batches are not designed for high 
throughput in everyday analysis.

This section includes instructions for the following tasks:

• Creating a Development Batch

• Editing Samples in a Development Batch

• Acquiring Samples in a Development Batch

Creating a Development Batch
You create a development batch to test your instrument method and use it to acquire samples 
only once. You cannot save a development batch; you can save only the raw data files created 
when you acquire the samples in the batch.

Use the following procedures:

• To open the Development Batch view

• To specify a location for development batch data

• To add samples to the development batch

• To insert samples into the development batch

• To copy a sample

 To open the Development Batch view

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. In the Method Development navigation pane, click Development Batch.

The Development Batch view opens a new, empty batch.

Note  The Channel column is available only when your configuration supports 
multiplexing.
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 To specify a location for development batch data

1. To specify a location for the files, click Select Batch Location in the Development Batch 
task pane.

By default, the TraceFinder application writes the temporary files, raw data files, and .sld 
method file to the following folder:

…\Thermo\TraceFinder\1.1\Temp

2. In the browser, do one of the following:

Locate the folder you want to use for the development batch files and click OK.

–Or–

Do the following:

a. Locate and select the folder where you want to create a new folder for the batch 
files.

b. Click Make New Folder.

The TraceFinder application creates a new folder in the selected folder.

c. Right-click the New Folder filename and choose Rename from the shortcut 
menu.

d. Type the name for the folder.

e. Click OK.

The TraceFinder application creates all development batch files in the specified folder.

 To add samples to the development batch

Do one of the following:

Right-click and choose Add Sample from the shortcut menu.

–Or–

To add multiple sample rows, enter the number of rows and click the Add Sample icon.

The application adds the specified number of new, empty samples to the end of the 
sample list.
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 To insert samples into the development batch

1. Select the sample above which you want to insert empty samples.

2. Do one of the following:

Right-click and choose Insert Sample from the shortcut menu.

–Or–

To insert multiple sample rows, enter the number of rows and click the Insert Sample 
icon.

The TraceFinder application inserts new, empty samples above the selected sample.

 To copy a sample

1. Select the sample you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The TraceFinder application adds a copy of the sample above the selected sample. 

Note  You cannot insert samples into an empty batch. You must have at least one 
sample to select before you can use this icon.
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Editing Samples in a Development Batch

A development batch requires fewer parameters than a real batch, but the mechanism for 
managing the information is the same.

For detailed instructions about using the Copy Down or Fill Down commands to enter 
column values, see Appendix B, “Using Copy Down and Fill Down.” 

Use the following procedures:

• To enter column values

• To resize or reorganize the columns

• To remove selected samples from the list

• To remove all samples from the list

 To enter column values

1. Double-click the Filename column and type a file name for the raw data file.

2. (Optional) Enter values for the Sample Name or Sample ID columns.

3. Enter a vial position for each sample.

4. Enter an injection volume for each sample.

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

5. To enter an instrument method for each sample, click the down arrow in the Instrument 
Method column and select a method from the list.

This list contains all the available instrument methods.

6. To enter a channel for each sample, click the down arrow in the Channel column and 
select a channel from the list.

You cannot specify the auto channel selection in a development batch.

Note  The Channel column is available only when your configuration supports 
multiplexing.
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Figure 62. Completed Development Batch

 To resize or reorganize the columns

1. To resize a column, drag the header separator on the right side of the column.

2. To move a column, drag the column header.

You cannot move the Filename column.

 To remove selected samples from the list

1. Select the samples you want to remove.

Use the first column to ensure that the samples are selected.

2. Right-click and choose Remove Selected Samples from the shortcut menu.

 To remove all samples from the list

1. Click New Sample List in the Development Batch task pane.

One of the following happens:

• If the samples in the current batch have all been acquired, the list is cleared.

• If the samples in the current list have not been acquired, a message confirms that you 
want to clear them and start a new list. 

2. To create a new empty list, click Yes. 

Note  You cannot save a development batch when you create a new one; you can only 
create, acquire, and discard each batch after you use it. The TraceFinder application 
saves only the generated raw data files in the specified batch location.

Selected samples
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Acquiring Samples in a Development Batch

In a development batch, you can submit the entire batch for acquisition or submit only 
selected samples.

Use the following procedures:

• To acquire selected samples

• To acquire the batch

 To acquire selected samples

1. Select the samples you want to acquire.

2. Right-click and choose Submit Selected Samples from the shortcut menu, or click the

Submit Selected Samples icon, .

The TraceFinder application creates a raw data file for each selected sample. It writes the 
raw data files and all temporary working files to the following folder:

…\Thermo\TraceFinder\1.1\Temp

When the acquisition is complete, the application deletes all the temporary working files. 
Only the raw data files and a MethodDevelopment.sld file remain in the folder.

If a sample is acquired more than once, the subsequent raw data files are time-stamped 
with the acquisition time.

 To acquire the batch

Right-click and choose Submit Batch from the shortcut menu, or click the Submit 
Batch icon, .

The TraceFinder application creates a raw data file for each sample in the batch and 
an .sld method file. The TraceFinder application writes the raw data files, the .sld method 
file, and all temporary working files to the specified folder.

When the acquisition is complete, the application deletes all the temporary working files. 
Only the raw data files and a MethodDevelopment.sld file remain in the folder.

If a sample is acquired more than once, the subsequent raw data files are time-stamped 
with the acquisition time.
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Viewing Raw Data Files in the Qual Browser

You can view the chromatogram and spectra for completed samples in a development batch.

Use the following procedures:

• To open the Qual Browser

• To display the last completed raw data file in the Qual Browser

 To open the Qual Browser

In the Development Batch task pane, click Open Qual Browser.

The Thermo Xcalibur Qual Browser window opens.

For detailed instructions about using the Qual Browser, refer to the Qual Browser Help. 
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 To display the last completed raw data file in the Qual Browser

In Acquisition page of the real-time viewer, right-click and choose View Last File in Qual 
Browser from the shortcut menu.

The last completed file opens in the Qual Browser. 

When all samples are completed, you can view the last raw data file for the batch.
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Using the Acquisition Mode 

This chapter describes the tasks associated with the Acquisition mode.

When you plan to work with multiple samples or use similarly designed batches, use the 
Acquisition mode to reduce the amount of data you must enter. 

Because the nature and types of batches are often similar (in some cases specified by laboratory 
standard practices), a user in the LabDirector or Supervisor role can define a batch template 
that supplies the basic structure of a batch. 

If you have a master method, you can create a batch and run the samples. Batches represent 
one or more samples that are to be acquired, processed, reviewed, and reported as a set. After 
you create a batch of samples, you can submit the batch and review the results in the Data 
Review mode or you can go directly to viewing and printing reports. 

You can also set up a calibration batch with known concentrations of the target compounds to 
compare the sample against the calibration in future batches. 

Contents 

• Working with Batches

• Real-time Display

• Sample Types
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Working with Batches 
This section includes instructions for the following tasks:

• Opening and Navigating the Acquisition Mode

• Creating Batches

Opening and Navigating the Acquisition Mode

To open the Acquisition mode, click Acquisition in the navigation pane or from the 
dashboard.

The TraceFinder application does not use the navigation pane in the Acquisition mode in the 
same way it uses the navigation pane in other modes. In the Acquisition mode, this pane 
keeps track of your progress as you move through the views to create and submit a batch or a 
batch template. 

Figure 63. Task pane when you enter the Acquisition mode 

The status of each view in the Acquisition mode shows you which tasks are completed and 
which tasks are not.

As you complete each view, the task panes display the parameters you specified for your batch. 

Completed view

Incomplete required view

Current view

Unvisited view
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Figure 64. Example task pane when you have completed the Acquisition mode 
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Creating Batches

These are the major steps you use in Acquisition mode to create a batch:

1. Selecting a Batch

2. Defining the Sample List

3. Selecting and Reviewing Reports

4. Submitting the Batch

Workflows

Depending on how you create your batch, you use different views in the Acquisition mode. 
The following workflows show the Acquisition views required for each batch creation 
approach. Depending on your approach to creating a batch, use one of these specific 
workflows. 

 Creating an original batch

To create an original batch, start with the instructions “To start a new batch” on 
page 220.

 Acquiring a previously saved (.tbr) batch

To acquire a previously saved batch, start with the instructions “To select a 
ready-to-acquire batch” on page 221.

Batch and
Method

Finish

Reports

Samples

Batch

Finish Samples
218 TraceFinder User Guide Thermo Scientific



 5 Using the Acquisition Mode
Working with Batches
 Editing and processing a previously acquired batch

To process a previously acquired batch, start with the instructions “To select a previously 
acquired batch” on page 222.

 Creating a batch template

To create a batch template, start with the instructions “To create a batch template” on 
page 223 and then click Save on the Finish page.

Batch

Finish

Samples

Finish

Samples

When user security is enabled, this 
workflow is available only to users in the 
LabDirector or Supervisor role. 

Template and
Method
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Selecting a Batch

In a Template Selection view of the Acquisition mode, you can choose to create a new batch in 
any of your current projects/subprojects. 

Use the following procedures:

• To start a new batch

• To select a template for the new batch

• To select a ready-to-acquire batch

• To select a previously acquired batch

• To create a batch template

 To start a new batch

1. Click the New Batch tab.

2. Select the project and subproject where you want to create the new batch.

3. Type a name for the new batch in the Batch Name box.

4. Select a method from the Method Selection list.

The Method Compound Data pane displays the compounds in the method. You cannot 
edit the compounds list from the Acquisition mode.

5. To continue to the next view, click Next.

The Sample Definition view opens. See “Defining the Sample List” on page 224.
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 To select a template for the new batch

1. Click the New Batch tab. 

2. In the Available Templates pane, select the template and method combination you want 
to use.

The system creates a Batch name with the selected template name and the date/time 
stamp. You can change the default project, subproject, and method associated with this 
template. 

3. (Optional) Select a different project and subproject where you want to create the new 
batch.

4. (Optional) Select a different method to use for the new batch.

5. To continue to the next view, click Next.

The Sample Definition view of the Acquisition mode opens. See “Defining the Sample 
List” on page 224.

 To select a ready-to-acquire batch

1. Click the Ready to Acquire tab.

All your unacquired, saved batches are displayed with the file extension .tbr (to be run). 
All .tbr batches are located in the following folder:

…\Thermo\Tracefinder\1.1\Projects\projectname\subprojectname

2. Select the batch you want to acquire.
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3. To continue to the next view, click Next.

The Finish view of the Acquisition mode opens. From the Finish view, you can save the 
batch, submit the batch for acquisition, or go to the Sample Definition view to edit the 
samples list for this batch.

4. Do one of the following:

• To prepare the batch for acquisition, click Submit.

For detailed instructions, see “Submitting the Batch” on page 237. 

–Or–

• To edit the samples list, click Previous.

For detailed instructions on editing a samples list, see “Defining the Sample List” on 
page 224.

–Or–

• To save the batch to the Ready to Acquire list, click Save.

The TraceFinder application saves your batch as a to-be-run (.tbr) file, closes the 
Acquisition mode, and returns you to the application dashboard.

The application saves the .tbr batches in the following folder:

…\Thermo\TraceFinder\1.1\Projects\projectname\subprojectname

 To select a previously acquired batch

1. Click the Acquired Batches tab.

From this page, you can resubmit a previously acquired batch, edit the batch, or save it to 
be acquired later.

2. In the Project pane, select a project name.

All subprojects included in the selected project are displayed in the Subproject pane.

3. In the Subproject pane, select a subproject name.

All previously acquired batches included in the selected subproject are displayed in the 
Batch pane.

4. In the Batch pane, select the batch you want to reacquire.
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5. To continue to the next view, click Next.

The Sample Definition view of the Acquisition mode opens. See “Defining the Sample 
List” on page 224.

 To create a batch template

1. Click the Template tab.

2. Select the project and subproject where you want to create the new batch template.

3. Type a name for the new batch template in the Template Name box.

4. Select a method from the Method Selection list.

The Method Compound Data pane displays the compounds in the method. You cannot 
edit the compounds list from the Acquisition mode.

5. To continue to the next view, click Next.

The Sample Definition view of the Acquisition mode opens. See “Defining the Sample 
List” on page 224.

Note  When user security is enabled, this page is available only to users in the 
LabDirector or Supervisor role. 
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Defining the Sample List

In the Sample Definition view of the Acquisition mode, you can create a list of samples for the 
batch. You can add samples, insert samples, import a sample list, or remove samples from the 
list. See “Sample Definition view” on page 230.

As you enter sample values, you can use the Copy Down and Fill Down commands to enter 
column values. For detailed instructions on using Copy Down and Fill Down to enter column 
values, see Appendix B, “Using Copy Down and Fill Down.” 

Use the following procedures:

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To remove samples from the list

• To reinject a sample from a previously acquired batch

• To select channels for the batch

• To assign a specific channel to a sample

When you have finished defining the list of samples, click Next.

• When you are creating a batch from scratch, creating a batch from a template, or editing 
a batch template, the Report Selection view opens. See “Selecting and Reviewing Reports” 
on page 233.

• When you are editing a previously acquired batch or a .tbr batch, the Finish Selection 
view opens. See “Submitting the Batch” on page 237.

 To add samples to the list

1. Select the number of sample rows to add and click the Add button, .

2. Type a file name in the Filename column for each sample. 

Each file name must be unique. 

3. Select a sample type from the Sample Type list for each sample. 

Tip  To quickly add a single row, right-click and choose Add Sample from the shortcut menu.

Available Environmental and Food Safety sample types

Matrix Blank Solvent Unknown/TIC
Cal Std Chk Std Unknown
LCS MDL MS
LCSD Method Val MSD
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For a detailed description of sample types, see “Sample Types” on page 259.

4. For each Cal Std or Chk Std sample, select a level from the Sample Level list.

The sample levels are defined in the master method. If there are no levels to select from 
the Sample Level list, ask a user with Supervisor or LabDirector permissions to edit the 
method and specify the levels. 

For detailed instructions about defining sample levels, see Chapter 4, “Using the Method 
Development Mode.” 

5. Type a vial position in the Vial Position column for each sample. 

6. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

7. (Optional) Type or edit the values for the remaining columns.

 To insert samples into the list

1. Select the sample above which you want to insert new, unknown samples.

You cannot use the Insert command to create the first sample row.

2. Select the number of samples to insert and click Insert, .

The application inserts the unknown samples above the selected sample.

3. Type a file name in the Filename column for each sample. 

Each file name must be unique. 

Available General Quantitation sample types

Matrix Blank Unknown/TIC Unknown
Cal Std Chk Std Solvent

Tip  Use the Fill Down command to make entering vial positions easier.

Note  When you use the horizontal scroll bar at the bottom of the samples list, the 
Status and Filename columns stay fixed while the other columns scroll right and left. 

Inserted 
samples
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4. Select a sample type from the Sample Type list for each sample. 

For a detailed description of each sample type, see “Sample Types” on page 259.
 

5. For each Cal Std or Chk Std sample, click the Sample Level cell and select a level from the 
list.

The sample levels are defined in the master method. If there are no levels to select from 
the Sample Level list, ask a user with Supervisor or LabDirector permissions to edit the 
method and specify the levels. 

For detailed instructions about defining sample levels, see Chapter 4, “Using the Method 
Development Mode.” 

6. Type a vial position in the Vial Position column for each sample. 

7. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

8. (Optional) Type or edit the values for the remaining columns.

Available Environmental and Food Safety sample types

Matrix Blank Solvent Unknown/TIC

Cal Std Chk Std Unknown

LCS MDL MS

LCSD Method Val MSD

Available General Quantitation sample types

Matrix Blank Unknown/TIC Unknown

Cal Std Chk Std Solvent

Tip  Use the Fill Down command to make entering vial positions easier.

Note  When you use the horizontal scroll bar at the bottom of the samples list, the 
Status, Filename, Sample Type, and Sample Level columns stay fixed while the other 
columns scroll right and left. 
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 To import samples into the list 

1. Click Import, .

The Sample Import Tool dialog box opens.

From this dialog box, you can import a sample list from a .csv, .xml, or .sld file.

2. Click Browse and select a .csv, .xml, or .sld file that contains the sample definitions you 
want to import.

3. From the Imported Samples Will Be list, select either Appended to the End of the List 
or Inserted at the Selected Row.

4. Click Import.

The Sample Import Tool dialog box closes, and the specified samples are added to the 
Samples list. 

When you import samples from an Xcalibur sequence file (.sld), the TraceFinder 
application makes the following column name substitutions:

When you import samples from an Xcalibur sequence file (.sld), the TraceFinder 
application makes the following sample type substitutions:

Note  The .csv, .xml, or .sld file format must match the TraceFinder file format. 

Xcalibur column TraceFinder column

Level Sample Level
Position Vial Position
Inj Vol Injection Volume
Dil Factor Conv Factor

Xcalibur sample type TraceFinder sample type

Blank Matrix Blank
QC Chk Std
Std Bracket Cal Std
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5. For each Cal Std or Chk Std sample, click the Sample Level cell and select a level from the 
list.

The sample levels are defined in the master method. If there are no levels to select from 
the Sample Level list, ask a user with Supervisor or LabDirector permissions to edit the 
method and specify the levels. 

For detailed instructions about defining sample levels, see Chapter 4, “Using the Method 
Development Mode.” 

6. Type a vial position in the Vial Position column for each sample. 

7. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

8. (Optional) Type or edit the values for the remaining columns.

9. (Optional) When using multiplexing, select a channel for each imported sample.

Imported samples default to Auto.

 To remove samples from the list

1. Select the samples you want to remove.

2. Right-click and choose Remove Selected Samples from the shortcut menu. 

 To reinject a sample from a previously acquired batch 

1. In the sample list, select the sample you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The TraceFinder application creates a copy of the selected sample and appends INJ001 to 
the file name. Additional reinjections of the same sample are numbered INJ002, INJ003, 
and so forth.

The TraceFinder application copies all parameter values from the original sample.

Tip  Use the Fill Down command to make entering vial positions easier.

Note  When you use the horizontal scroll bar at the bottom of the samples list, the 
Status, Filename, Sample Type, and Sample Level columns stay fixed while the other 
columns scroll right and left. 

Tip  Use the CTRL or SHIFT keys to select multiple samples.
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A green status icon indicates previously acquired samples (acquired and processed), and 
the sample name is grayed out. A blue status icon indicates samples created for reinjection 
(not acquired).

When you submit this batch, the application acquires only the reinjection samples. 

 To select channels for the batch

To disable a configured channel, clear the check box for the channel in the Multiplexing 
Channels area at the bottom of the page.

By default, all configured channels are selected. The configured channels are determined 
by the multiplexing settings in the Configuration mode. See “Specifying Multiplexing 
Parameters” on page 70. 

Disabling a channel in the Multiplexing Channels area does not remove this channel 
selection from the Channels list for each sample. When you assign a channel to a sample, 
be careful not to assign a channel that you disabled.

 To assign a specific channel to a sample 

1. Scroll to the Channel column (the rightmost column in the sample list).

All samples default to Auto. 

2. Select a channel from the Channel list. 

When you submit the batch, samples that are set to Auto run on any of the available 
channels and samples that are set to a specific channel run only on that channel.
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If you select a channel that is not available for this batch, the application flags the sample 
sequence on the Finish page of the Acquisition mode. See the previous procedure, To 
select channels for the batch.

3. If you see this error, do the following:

a. Click Previous to return to the Sample Definition page.

The incorrect sample is marked with an error flag.

b. Correct the channel selection.

Figure 65. Sample Definition view

 

Table 53. Sample Definition parameters  (Sheet 1 of 3)

Parameter Definition 

Sample Controls

Add Adds the specified number of empty rows to the sample grid.

Insert Inserts the specified number of empty rows above the selected row.

Import Opens the Sample Import Tool where you can import samples defined in a .csv file or 
an .xml file.

Multiplexing Channels 

All Channels Uses all configured channels to acquire this batch.

Channel 1-n Uses only the selected channels to acquire this batch.

Previous Returns you to the previous Acquisition mode view.

Cancel Confirms that you want to exit the Acquisition mode. When you cancel out of the 
Acquisition mode, your edits are not saved.

Save Saves this batch as a to-be-run (.tbr) batch.
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Next Takes you to the next Acquisition mode view.

Shortcut menu

Add Sample Adds a single empty row to the sample grid.

Insert Sample Inserts a single empty row to the sample grid above the selected row.

Insert Copy Sample Copies the currently selected row and inserts a copy above the row.

Reinject selected samples Creates a copy of the selected sample and appends INJ001 to the file name. Additional 
reinjections of the same sample are numbered INJ002, INJ003, and so forth.

Remove selected samples Removes selected samples from the sample grid.

Import samples Opens the Sample Import Tool. See “To import samples into the list” on page 227.

Copy Down Copies the value in the selected row to all rows below it. For detailed instructions about 
using the Copy Down command, see Appendix B, “Using Copy Down and Fill Down.” 

Fill Down Enters sequential values in the column starting with the value in the selected row and 
ending with the last row in the column. For detailed instructions about using the Fill 
Down command, see Appendix B, “Using Copy Down and Fill Down.” 

Modify columns Opens the Modify Columns dialog box. See “Column Display” on page 286.

Copy Copies the data in the selected rows or columns to the Clipboard. Use this command to 
copy sample information to another application, such as an Excel spreadsheet. You cannot 
paste this data back into the Acquisition mode sample list.

Copy With Headers Copies the data in the selected rows or columns and the associated column headers to the 
Clipboard. Use this command to copy sample information to another application, such as 
an Excel spreadsheet. You cannot paste this data back into the Acquisition mode sample 
list. For example:

Paste Pastes a single column of copied data from another application, such as an Excel 
spreadsheet, into the selected column.

Undo Last Paste Removes the last pasted item in the Acquisition mode sample list. 

Table 53. Sample Definition parameters  (Sheet 2 of 3)

Parameter Definition 

Copy With Headers 
from TraceFinder

Paste into Excel spreadsheet
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Export to CSV file Opens the Save As dialog box where you can save the current sample list to a .csv file.

Status color codes  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed.

Table 53. Sample Definition parameters  (Sheet 3 of 3)

Parameter Definition 
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Selecting and Reviewing Reports 

On the Report Selection view, you can specify the types of reports you want to create. See 
“Report Selection view” on page 235. For a complete list of report types and examples of 
output files, see Appendix A, “Reports.”  In addition to the report type, you can specify a 
report description for each of your reports. 

For each standard report you generate, you can create a hardcopy printout, a PDF file, or an 
XML file.

For each custom report you generate, you can create a hardcopy printout or an XLSM file. 

When you have finished specifying your report options, click Next to go to the Finish view. 
See “Submitting the Batch” on page 237.

The resulting output files for your reports are written to the following folder:

…\Projects\projectname\subprojectname\batchname\Reports

Use the following procedures:

• To edit a report description

• To preview a standard report

• To specify a standard report in print format or as a PDF, XML, or XLSM file

• To export reports to a specific folder

 To edit a report description

Select the Report Description column and edit the default description.

The default report description is the same as the report name. 

 To preview a standard report

1. Click the magnifying icon, , to view an example of the report type as a PDF file.

The right pane of the view displays an example PDF report with typical PDF viewer 
buttons.

2. To minimize the PDF viewer, click the minimize icon, .

Note  Only Standard report types have preview documents. 
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 To specify a standard report in print format or as a PDF, XML, or XLSM file

1. For each type of report you want to create, select the check box in the Print, Create PDF, 
Create XML, or Create XLSM columns.

2. To duplicate the output type for all reports, right-click the cell and choose Copy Down 
from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell. You can duplicate the output type only for reports that have this 
output format available.

 To export reports to a specific folder

1. Select the Export Results check box at the bottom of the view.

The Browse For Folder dialog box opens.

2. Locate and select the folder where you want to save the reports.

3. To create a new reports folder within the selected folder, click Make New Folder and type 
the new folder name.

4. Click OK.

The application writes all reports to the specified folder in addition to the batch Reports 
folder. 
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Figure 66. Report Selection view

Table 54. Report Selection parameters  (Sheet 1 of 2)

Parameter Description

Displays an example PDF for the report type. This example provides a model of the report 
type only; it does not reflect your specific data. This is available for standard reports only.

Report Name The name of a report. 

Report Description User-editable title to be used on a report. 

Report Type The type of report: Standard, Custom, or Target Screening. 

Print Reports to be sent to the printer. 

Create PDF Reports to be saved as PDF files. 
Available only for standard reports.

Create XML Reports to be exported in XML format. 
Available only for standard reports.
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Create XLSM Reports to be exported in Excel Macro-Enabled Workbook (.xlsm) format.
Available only for custom reports.

Batch Level Rather than creating separate reports for each sample, the application uses a composite of 
the data from all the samples to create a single report for the entire batch. Batch-level reports 
are prepended with a B to differentiate them.
You cannot select this option from the Report Selection page. You must select the Batch 
Level option for the report in the report configuration. See “Specifying the Reports 
Configuration” on page 58. 

Shortcut menu:
Copy Down

Copies the selected or cleared state to all subsequent reports in the column. 

Table 54. Report Selection parameters  (Sheet 2 of 2)

Parameter Description
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Submitting the Batch

In the Finish view of the Acquisition mode, you can specify a startup method, a shutdown 
method, or a calibration batch. You can save the batch to be acquired later, or you can acquire 
and process data and optionally create reports. See “Finish view” on page 244.

Use the following procedures:

• To specify startup or shutdown methods

• To specify a calibration batch

• To specify device states

• To save a batch for later acquisition

• To start an acquisition

• To view the output files

 To specify startup or shutdown methods

1. (Optional) Select a method from the System Startup Method list.

The TraceFinder application runs this method before running the batch. No autosampler 
injection takes place. This feature is not available for all instruments.

2. (Optional) Select a method from the System Shutdown Method list.

The TraceFinder application runs this method after running the batch. This feature is not 
available for all instruments.

Note  If you are working with a batch template, the only available function is Save.
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 To specify a calibration batch

1. In the Calibration area, select a calibration (.calx) file from the list.

2. Do one of the following:

To use the selected calibration file to process the current data, select the Use Calibration 
option.

The method must be the same for the calibration batch and the current batch. 

–Or–

To add calibration data from the current batch to the selected calibration file, select the 
Extend Calibration option. 

Note  You must acquire at least one batch with the current method to create a .calx 
calibration file.
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 To specify device states

In the System Status area, select the name of the device, right-click, and then choose a 
device state from the shortcut menu.

 

Table 55. Instrument states

Instrument state Description

Turn Device On Keeps the system in the On state when the current run finishes, 
so you can begin another run without waiting. All power and 
flows are maintained at operational levels. 
Default: On

Turn Device Standby Keeps the system in the Standby state when the current run 
finishes, so you can begin another run with only a short delay 
between runs. 

Some devices do not have a Standby feature. For devices with 
this feature, the device enters a power-saving or 
consumable-saving mode, and you can switch the device back 
on in approximately 15 minutes. Depending on the 
instrument, this state turns liquid flows off but maintains 
heaters and other subsystems in an On state so that there is no 
warm-up time required when you change from Standby to On. 

Turn Device Off Keeps the system in the Off state when the current run 
finishes. The Off state indicates that all power to the 
instrument, which the TraceFinder application can control, is 
turned off. This includes power to all heaters and 
subassemblies, but in some cases not all subassemblies. 

Some devices do not have an Off feature. For devices that do 
have this feature, the device enters a power-saving or 
consumable-saving mode, and you can switch the device back 
on. When several runs are queued, the application uses the 
system power scheme of the last submitted run. 

Instrument status indicators

Green indicates that the device is turned on or is running.

Yellow indicates that the device is in standby mode or is 
waiting for contact closure.

Red indicates that the device is turned off or that there is an 
error with the device.
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 To save a batch for later acquisition

From the Finish view, click Save.

The TraceFinder application saves your batch as a to-be-run (.tbr) file, closes the 
Acquisition mode, and returns you to the application dashboard.

 To start an acquisition

1. Click Submit.

The Submit Options dialog box opens. For a detailed description of the parameters, see 
“Submit Options dialog box” on page 241.

2. (Optional) Select the Create Reports check box.

3. Select the Use check box for the device that you want to use for this acquisition.

4. (Optional) Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

5. (Optional) Select the Start When Ready check box, which starts all instruments together 
when they are all ready. 

When this is cleared, individual instruments can start at different times and then have to 
wait for the last instrument to be ready.

6. (Optional with multiplexing enabled) Select the Priority Sequence check box. 

The application acquires the priority batch on the next available channel or the assigned 
channel.

7. (Optional without multiplexing enabled) Select the Priority Sequence check box and 
then select one of the following priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the currently acquiring 
batch. 

• Next Available Sample places the batch immediately after the currently acquiring 
sample.

8. (Optional) Click Cancel to exit the Acquisition mode without performing any tasks.

9. To start the selected processes, click OK.

The selected processes begin, and the TraceFinder application returns you to the 
dashboard and shows the real-time display at the bottom of the dashboard.

Note  By default, the application acquires and processes data when you submit the 
batch.
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The real-time display is visible from the dashboard and all modes. You can begin another 
batch in the Acquisition mode while you watch the real-time display of the currently 
acquiring batch. 

Figure 67. Submit Options dialog box

Table 56. Submit Options dialog box parameters  (Sheet 1 of 2)

Parameter Description 

User Name Name of the current user.

Acquire Data (Default) Submits the current batch to acquisition.

Process Data (Default) Processes the data for the current batch.

Create Reports Creates reports for the current batch.
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Acquisition pane

Device Name Lists all configured instruments. 

If the instrument you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then 
reopen the TraceFinder application. You cannot configure an 
instrument while the TraceFinder application is running.

Use Specifies the instruments used for this acquisition.

Start Device Specifies the instrument that initiates the communication 
with the other instruments. This is usually the autosampler.

Start When Ready Starts the specified device when all the instruments are ready 
to acquire data. When this is cleared, individual instruments 
can start at different times and then must wait for the last 
instrument to be ready.

Priority Sequence With multiplexing enabled, places the batch immediately after 
the currently acquiring batch. 

Without multiplexing enabled, specifies one of the following 
priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after 
the currently acquiring batch. 

• Next Available Sample places the batch immediately after 
the currently acquiring sample.

Post-run system 
state

Specifies the system state after it acquires the last batch.
On (default), Standby, or Off.

Hide/Show Details Collapses or expands the acquisition details of the Submit 
Options dialog box.

OK Begins the selected processes.

Cancel Closes the Submit Options dialog box without submitting any 
tasks.

Table 56. Submit Options dialog box parameters  (Sheet 2 of 2)

Parameter Description 
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 To view the output files

• The TraceFinder application writes saved batches to the subproject folder with the file 
extension .tbr (to be run):

…\TraceFinder\1.1\Projects\projectname\subprojectname

• For each acquired sample, the application writes an RSX file to the batch Data folder:

…\projectname\subprojectname\batchname\Data

• The application saves method information to the batch Methods folder:

…\projectname\subprojectname\batchname\Methods\methodname

• The application writes the reports to the batch Reports folder:

…\projectname\subprojectname\batchname\Reports
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Figure 68. Finish view

Table 57. Finish view parameters  (Sheet 1 of 2)

Parameter Description 

System Status The System Status pane displays the following: 
• Devices used for the acquisition
• Project, subproject, and name of the batch
• Number of samples in the batch
• Number of standard and custom reports to be printed and saved as PDF, XML, or 

XLSM files
• Local method and instrument method used for the batch
• Number of compounds in the method

System Startup 
Method

The instrument method that runs before the batch. No autosampler injection takes place. 
This feature is not available for all instruments.

System Shutdown 
Method

The instrument method that runs after the batch. No autosampler injection takes place. 
This feature is not available for all instruments.
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Calibration • Use calibration: Uses the selected calibration file to process the current data.
• Extend calibration: Adds calibration data from the current batch to the selected 

calibration file.

Save Saves the current batch as a to-be-run (.tbr) file.

Submit Opens the Submit Options dialog box where you can optionally choose to generate reports.

Table 57. Finish view parameters  (Sheet 2 of 2)

Parameter Description 
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Real-time Display
You can access the real-time display from the dashboard and from any mode in the 
TraceFinder application.

 To access the real-time display from the dashboard

Click Real Time Status.

The real-time status displays at the bottom of the dashboard.

 To access the real-time display from all modes

Click Real Time Status.

The real-time status displays at the bottom of the current view.

Figure 69. Real Time Status display

The real-time status display has four pages of information and a real-time trace pane:

• Acquisition Page

• Instrument Page

• Devices Page

• Queues Page

• Real-time Trace Display
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Acquisition Page

Use the Acquisition page to monitor the progress as the application acquires the samples. 

 To pause or stop the batches in the queue

Use the Start, , Stop, , or Pause, , buttons to control batches in the 
Acquisition queue.
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Instrument Page

Use the Instrument page to monitor the currently acquiring sample. 
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Devices Page

Use the Devices page to monitor the status of the instrument. The feedback you see on the 
Devices page depends on the instrument you are using. The following examples show an 
Accela autosampler and an Aria multiplexing device.

Accela Autosampler Feedback

Aria Multiplexing Feedback
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Use the following procedures:

• To pause the autosampler

• To access the Aria multiplexing controls

• To control the channels

• To view the pressure trace

 To pause the autosampler

1. Click Hold Autosampler.

The autosampler finishes the current autosampler step and then pauses. The LC pumps 
and autosampler continue.

2. To restart the autosampler, click Hold Autosampler again.

 To access the Aria multiplexing controls

Click Direct Control.

The AriaMuxVi Direct Ctl dialog box opens.

For a detailed description of the features in this dialog box, refer to the Transcend Systems 
with Xcalibur Software User Guide.
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 To control the channels

Right-click the channel name and choose a command from the shortcut menu.

Parameter Description 

On Turns on a stopped pump and continues acquiring the sample 
list assigned to that channel.

Off After the current sample completes, the application stops 
acquiring and the pump shuts down.

Standby After the current sample completes, the application stops 
acquiring. The pump continues to run.

Disable / Enable • Disable prevents the channel from receiving samples. 
When you choose Disable during a run, the application 
finishes the current sample on the channel and then stops. 

• Enable allows the channel to receive samples.

When you disable a channel that is set to On, the channel is 
highlighted in green and the status is READY. You can turn 
the channel to Off or Standby. 
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 To view the pressure trace

1. Click the Pres tab.

The Pressure page displays a pump pressure graph for each sample in the batch. A 
fluctuation or change in the pump pressure could indicate a change in the 
chromatography conditions.

2. To view the pressure for a specific pump, select the Pres 1 or Pres 2 option.

By default, the pressure for all pumps are displayed.

3. To view the pressure for a specific channel, select the corresponding channel number.

By default, the pressure for all channels is displayed.
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Queues Page

Use the Queues page to monitor and control the Acquisition, Processing, and Reporting 
queues:

• Use the Queue-level Commands to pause or remove batches in any of the queues. 

• Use the Batch-level Commands to pause or remove entire batches or samples within 
batches from any of the queues.

Queue-level Commands

Use the queue-level commands to pause or remove batches in any of the queues on the 
Queues page.

Use the following procedures:

• To pause all batches in a queue

• To remove a single batch from a queue

• To remove all batches in a queue

• To remove all pending batches

 To pause all batches in a queue

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Pause Queue from the shortcut menu.

After the current sample completes, the application pauses all batches and samples in the 
specified queue. Only the selected queue is affected.

3. To restart a paused queue, select the queue, right-click, and choose Resume Queue from 
the shortcut menu.

Note  When multiplexing is enabled, as many as four samples can be acquiring at 
once. Pausing the Acquisition queue does not affect any acquiring samples.
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 To remove a single batch from a queue

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Stop Active Batch from the shortcut menu.

The application confirms that you want to remove the active batch from the selected 
queue. After the current sample completes, the application removes the batch and all 
pending samples from the queue. Only the selected queue is affected.

 To remove all batches in a queue

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Stop All Batches from the shortcut menu.

The application removes all batches with pending samples from the selected queue. The 
current sample continues to acquire. Only the selected queue is affected.

 To remove all pending batches

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Remove Pending Batches from the shortcut menu.

The application removes all batches that contain only pending samples. Only the selected 
queue is affected.

Figure 70. Queue-level shortcut menu

 

Note  This command is available only when there are active batches in the queue. 
Paused batches and batches that contain only pending samples are not “active”.

Note  A pending batch is a batch in which all samples are pending. If any sample in 
the batch is active, the batch is not affected by this command.

Table 58. Queue-level shortcut menu commands (Sheet 1 of 2)

Parameter Description 

Pause Queue After the current sample completes, the application pauses the 
specified queue. Only the selected queue is affected.

Stop Active Batch Removes all pending samples from the specified queue. The active 
sample is not affected.
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Batch-level Commands

Use the batch-level commands to pause or remove entire batches or samples within batches 
from any of the queues on the Queues page.

Use the following procedures:

• To stop a batch

• To remove a pending batch

• To remove pending samples from a batch

• To remove a single pending sample from a batch

 To stop a batch

1. Select an active batch in any of the queues (Acquisition, Processing, or Reporting).

2. Right-click and choose Stop Batch from the shortcut menu.

The application confirms that you want to remove the selected batch from the queue. 
After the current sample completes, the application removes the batch and all pending 
samples from the queue.

 To remove a pending batch

1. Select a pending batch in any of the queues (Acquisition, Processing, or Reporting).

2. Right-click and choose Remove Pending Batch from the shortcut menu.

The application confirms that you want to remove the selected batch from the queue and 
then removes the batch from the queue.

Stop All Batches Removes all pending samples and batches from the specified 
queue. The active sample is not affected.

Remove Pending 
Batches

Removes all pending batches from the specified queue. The active 
batch is not affected.

Table 58. Queue-level shortcut menu commands (Sheet 2 of 2)

Parameter Description 

Note  The batch must have at least one active sample and one pending sample.

Note  A pending batch is a batch in which all samples are pending. If any sample in 
the batch is active, this command is not available.
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 To remove pending samples from a batch

1. Select a batch in any of the queues (Acquisition, Processing, or Reporting).

The batch must have at least one pending sample. 

2. Right-click and choose Remove Pending Samples from the shortcut menu.

The application confirms that you want to remove all pending samples from the batch 
and then removes the samples. If the batch includes only pending samples, the 
application removes the batch from the queue.

 To remove a single pending sample from a batch

1. Select a pending sample.

2. Right-click and choose Remove Sample from the shortcut menu.

The application confirms that you want to remove the selected sample from the batch and 
then removes the sample.

Figure 71. Batch-level shortcut menu

Table 59. Batch-level shortcut menu commands

Parameter Description 

Stop Batch After the current sample completes, the application removes all 
samples in the selected batch.

Remove Pending Batch Removes all samples from the selected pending batch.

Remove Pending 
Samples

Removes all pending samples from the selected batch.
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Real-time Trace Display

As each sample acquires, the real-time chromatogram pane shows the retention time and 
intensity of the TIC trace.

By default, the real-time display shows only the TIC trace as each sample acquires. To observe 
specific traces, such as the internal standard, use the RTV Display Traces function to display 
multiple traces.

When you create your method, you can specify additional traces to display in the real-time 
viewer and in which order the traces are displayed. The application always displays the TIC 
trace in the top pane. See “Real Time Viewer” on page 156.

 To display multiple traces

Right-click the chromatogram pane and choose the number of traces you want to display.

The chromatogram pane displays real-time chromatograms for the selected number of 
traces. 

The TIC is always displayed at the top. When there are more traces than can fit in the 
pane, you can scroll through the traces.

For each trace, the application displays the mass or precursor mass.
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Figure 72. Real-time display with multiple traces
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Sample Types 
The TraceFinder application uses the following sample types in all sample definitions and 
reports. To view example standard reports specific to a sample type, see Appendix A, 
“Reports.” 

Table 60.  Sample type definitions

Sample type Definition

Matrix Blank Contains no target compounds but might contain an ISTD when you 
use the internal standard quantitative analysis technique. By analyzing a 
blank sample, you can confirm that there are no residual compounds in 
the solvent system that can cause erroneous results.

Cal Std (Calibration standard) Contains known amounts of all target 
compounds. The purpose of a standard is to measure the response of the 
instrument to the target compounds so that the processing software can 
generate a calibration curve for each compound.

Chk Std (Check standard) Contains a known amount of one or more specific 
target compounds. The application places check standard samples in the 
sequence so that it can test quantitative analysis results for quality 
assurance purposes. After the application analyzes the Chk Std sample, 
it compares the measured quantity with the expected value and an 
acceptability range. The quantitative analysis of a Chk Std sample is 
classified as passed if the difference between the observed and expected 
quantities is within the user-defined tolerance. A Chk Std sample is 
classified as failed if the difference between the observed and expected 
quantities is outside the user-defined tolerance.

Solvent Contains only solvent.

Unknown Used for quantitative analysis of samples.

Unknown/TIC Used for quantitative and qualitative analysis of samples.

LCS Lab control sample.
(Environmental and Food Safety only)

LCSD Lab control sample duplicate.
(Environmental and Food Safety only)

MDL Method detection limits sample.
(Environmental and Food Safety only)

Method Val Method validation sample.
(Environmental and Food Safety only)

MS Matrix spike sample.
(Environmental and Food Safety only)

MSD Matrix spike duplicate sample.
(Environmental and Food Safety only)
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Using the Data Review Mode 

This chapter includes instructions for using the features of the Data Review mode.

In the Data Review mode, you can review batches, batch data, reports, and local methods.

 To access the Data Review mode

Click Data Review from the dashboard or the navigation pane.

The Data Review navigation pane opens.

Contents

• Working in the Batch View

• Working in Data Review View

• Working in Report View

• Working in the Local Method View
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Working in the Batch View
In the Batch View, you can manually create and edit a new batch or open and edit a previously 
saved batch. When you submit a batch, you can acquire and process data and optionally create 
reports for the submitted samples.

This section contains information about the following topics:

• Batch View Panes

• Creating a New Batch

• Editing a Batch

• Editing Report Output Formats

• Submitting a Batch
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Batch View Panes

The Batch View is divided into three panes: 

• Use the sample list to create a batch. See “Creating a New Batch” on page 264.

• Use the Automated Batch Reports pane to select the type of output formats you want to 
generate for the reports. See “Editing Report Output Formats” on page 274.

• Use the Compound Active Status pane to make specific compounds active or inactive. See 
“Setting Compound Active Status” on page 276.

Sample list

Automated Batch Reports pane Compound Active Status pane

Tip  To resize the panes, drag the separators that divide the panes.
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Creating a New Batch

In the Batch View, you can create a new batch.

Use the following procedures:

• To create a new batch

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To remove samples from the list

• To copy a sample

• To reinject a sample

• To edit sample values

• To customize the column display

• To temporarily customize the column display

 To create a new batch

1. Click New Batch in the Batch View task pane or choose File > New > Batch.

The Create a New Batch dialog box opens.
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2. Select a master method from the Method list. 

3. Select a drive from the Storage Location list. 

The project list displays all projects, subprojects, and batches on the selected drive.

You cannot use network drives to acquire data. For more information about network 
drives, see “Working with Drives” on page 40.

4. Select a project and a subproject and enter a name for your new batch.

5. Click Save.

A new, unnamed batch opens with one Unknown sample. 

 To add samples to the list

1. To add a single sample row, right-click the sample list and choose Add Sample from the 
shortcut menu.

2. To add multiple sample rows, select the number of rows and then click the Add Sample 
button, .

The application adds the specified number of new, empty samples to the end of the 
sample list.

Tip  The application does not display drives that do not have a project and subproject.

Tip  To enable the Save button, you must select a subproject and enter a unique batch 
name. If the Save button is not enabled, either you have entered a name that is already 
used or you have not selected a subproject.
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 To insert samples into the list

Select the sample above which you want to insert unknown samples, and do one of the 
following:

• To insert a single sample row, right-click and choose Insert Sample from the shortcut 
menu. 

• To insert multiple sample rows, select the number of rows and then click the Insert 
Sample button .

The TraceFinder application inserts a new, empty sample or samples above the selected 
sample.

 To import samples into the list

1. Choose Batch > Import Samples from the main menu, or click the Import Samples

button, .

The Sample Import Tool dialog box opens.

From this dialog box, you can import samples from a .csv, .xml, or .sld file.

2. Click Browse and select a .csv, .xml, or .sld file that contains the samples you want to 
import.

3. From the Imported Samples Will Be list, select Appended to the End of the List or 
Inserted at the Selected Row.

4. Click Import.

The Sample Import Tool dialog box closes, and the application adds the specified samples 
to the samples list. 

Inserted 
samples
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When you import samples from an Xcalibur sequence file (.sld), the TraceFinder 
application makes the following column name substitutions:

When you import samples from an Xcalibur sequence file (.sld), the TraceFinder 
application makes the following sample type substitutions:

5. (Optional) When using multiplexing, select a channel for each imported sample.

Imported samples default to Auto.

 To remove samples from the list

1. Select the samples you want to remove.

Make sure the first column indicates that the samples are selected.

2. Right-click and choose Remove Selected Samples from the shortcut menu.

 To copy a sample

1. Select the sample you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The TraceFinder application inserts the copy above the selected sample.

Xcalibur column TraceFinder column

Level Sample Level

Position Vial Position

Inj Vol Injection Volume

Dil Factor Conv Factor

Xcalibur sample type TraceFinder sample type

Blank Matrix Blank

QC Chk Std

Std Bracket Cal Std

Selected samples
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 To reinject a sample

1. In the sample list, select the sample you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The TraceFinder application creates a copy of the selected sample and appends INJ001 to 
the file name. Additional reinjections of the same sample are numbered INJ002, INJ003, 
and so forth.

The TraceFinder application copies all parameter values from the original sample.

 To edit sample values 

1. For each sample, do one of the following:

Double-click the Filename column and type a file name.

–Or–

Right-click and choose Browse in Raw File from the shortcut menu and locate a raw data 
file to use for the sample. 

2. For each sample, click the Sample Type column and select a sample type from the list.

3. For each Cal Std or Chk Std sample, click the Sample Level cell and select a level from the 
list.

The sample levels are defined in the master method. If there is nothing to select in the 
Sample Level list, do the following:

a. Return to the Method Development mode.

b. Open the method.

c. Click the Calibration Levels tab.

d. Add the levels.

e. Save the method.

f. Return to the Data Review mode, and click Update.

For detailed instructions, see Chapter 4, “Using the Method Development Mode.” 

Available Environmental and Food Safety sample types

Matrix Blank Solvent Unknown/TIC

Cal Std Chk Std Unknown

LCS MDL MS

LCSD Method Val MSD

Available General Quantitation sample types

Matrix Blank Unknown/TIC Unknown

Cal Std Chk Std Solvent
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4. Enter or edit the values for the remaining columns.

When you use the scroll bar at the bottom of the samples list, the Status, Flags, Filename, 
and Sample Type columns remain fixed and only the other columns scroll right and left. 

For instructions to automatically copy or fill values in these columns, see Appendix B, 
“Using Copy Down and Fill Down.” 

 To customize the column display

1. Right-click the Batch View sample list and choose Modify Columns from the shortcut 
menu.

The Modify Columns dialog box opens.

Parameter Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

Moves the selected column to the Available Columns pane. You cannot 
move the Status, Sample Level, Sample Type, or Filename columns.

Moves all columns except Status, Sample Level, Sample Type, and 
Filename to the Available Columns pane.

Moves the selected column name in the Displayed Columns pane one 
row up in the column order. You cannot move the Status, Sample Level, 
Sample Type, or Filename columns.

Moves the selected column name in the Displayed Columns pane one 
row down in the column order. You cannot move the Status, Sample 
Level, Sample Type, or Filename columns.
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2. Use the arrow buttons to move all the columns you want to display to the Displayed 
Columns pane.

All the columns you select are displayed after the Status, Sample Level, Sample Type, and 
Filename columns.

3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use the Up and Down buttons to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Batch View sample 
list; the last column in the list represents the rightmost column in the Batch View 
sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. When you have completed your changes, click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Batch View.

You can use the drag-and-drop method to temporarily reorder the columns in your 
sample list, but you cannot save this order. When you restart the TraceFinder application, 
the Batch View displays your columns in the order specified in the Modify Columns 
dialog box.

 To temporarily customize the column display

1. To resize a column, drag the header separator on the right side of the column.

2. To move a column, drag the column header.

You can swap the Status, Sample Level, Sample Type, and Filename columns with each 
other, but they must always be the first four columns in the sample list.

You cannot save these changes. When you restart the TraceFinder application, the Batch 
View displays your columns in the order specified in the Modify Columns dialog box.

Note  You cannot move the Status, Sample Level, Sample Type, or Filename 
columns.
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Editing a Batch

In the Batch View, you can open a saved batch and edit the samples list. You can add samples, 
edit samples, or remove samples. If the batch has already been acquired, you can select specific 
samples for reinjection. If the batch has unacquired samples when you complete your edits, 
you can save it as a to-be-run (.tbr) batch. 

Use the following procedures:

• To open a saved batch

• To open a recent batch

• To edit samples in a batch

• To reinject a sample from a previously acquired batch

• To submit all samples in the batch

• To submit selected samples

 To open a saved batch

1. From the Batch View task pane, click Open Batch.

The Open Batch dialog box opens.

2. Select a drive from the Storage Location list. 

The project list displays all projects, subprojects, and batches on the selected drive.

3. Select a project, subproject, and batch.

4. Click Open.

The selected batch opens in the Batch View.
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 To open a recent batch 

Click a batch name in the Recent Files list.

The selected batch opens in the Batch View.

 To edit samples in a batch

Use the commands described in “Working in the Batch View” on page 262.

You can edit samples, add new samples, reinject acquired samples, or delete samples.

 To reinject a sample from a previously acquired batch

1. In the sample list, select the sample you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The TraceFinder application creates a copy of the selected sample and appends INJ001 to 
the file name. Additional reinjections of the same sample are numbered INJ002, INJ003, 
and so forth.

The TraceFinder application copies all parameter values from the original sample.

A green status icon indicates previously acquired samples (acquired and processed), and 
the sample name is grayed out. A blue status icon indicates samples created for reinjection 
(not acquired).

When you submit all samples in this batch, all samples (including previously acquired 
samples) are acquired.

Tip  To view the drive, project, and subproject for a recent batch, hold your cursor 
over the batch name.
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3. To save this batch with the new samples for reinjection, choose File > Save > Batch from 
the main menu.

The batch is saved as a .tbr batch. You can open this batch from the Ready to Acquire 
page in the Acquisition mode and submit the batch. All submitted samples—both the 
reinjection samples and the previously acquired samples—are acquired. The application 
appends a timestamp to the acquired raw data files to differentiate each acquisition.
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Editing Report Output Formats 

In the Automated Batch Reports pane, you can view the reports that are selected for this batch 
and modify which output formats are generated for each report.

 To edit the sample-level output formats

1. Click the Sample Level tab.

The application displays reports and the output formats as they were specified in the 
method.

For detailed instructions for specifying which reports and output formats are generated, 
see “Specifying the Reports Configuration” on page 58.

2. Select or clear any of the check boxes for your reports.

3. To duplicate an output format for all reports for this sample, right-click the cell and 
choose Copy Down from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell. You can duplicate the output type only for reports that have this 
output format available.

4. To duplicate the output format for all samples in the batch, right-click the cell and choose 
Apply Selection to All Samples from the shortcut menu.

You can duplicate the output type only for reports that have this output format available.
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 To edit the batch-level output formats

1. Click the Batch Level tab.

The application displays the reports and the output formats as they were specified in the 
method.

For detailed instructions for specifying which reports and output formats are generated 
and which reports are batch-level, see “Specifying the Reports Configuration” on page 58.

2. Select or clear any of the check boxes for your reports.

3. To duplicate the output format for all reports, right-click the cell and choose Copy Down 
from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell. You can duplicate the output type only for reports that have this 
output format available.
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Setting Compound Active Status

In the Compound Active Status pane, you can choose specific compounds to be active or 
inactive.

 To set a compound as active or inactive

1. In the samples list, select a sample.

All compounds in the selected sample are listed in the Compound Active Status pane. 
The default active/inactive status is determined by the settings in the local method. See 
“Identification” on page 119.

2. Select or clear the Active check box for the compound.

When you specify a compound as inactive in this pane, it becomes inactive in the 
Compounds pane in the Data Review view. Inactive compounds are grayed out:

For instructions for changing the active/inactive status in the Data Review view, see 
“Inactive and Excluded Compounds” on page 290.
276 TraceFinder User Guide Thermo Scientific



 6 Using the Data Review Mode
Working in the Batch View
Compound Active/Inactive Status

You can specify which compounds are active or inactive in the Local Method View, the Batch 
View, or the Data Review view. 

For details about the setting the status on the Identification page, see “Identification” on 
page 119.

For details about setting the status in the Batch View, see “Setting Compound Active Status” 
on page 276.

For details about setting the status in the Data Review view, see “Inactive and Excluded 
Compounds” on page 290.
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Submitting a Batch

In the Batch View, you can submit an entire batch or only selected samples in the batch. 
When you submit a batch for acquisition and processing, you can choose to create reports for 
the submitted samples. See “Submit Options dialog box” on page 280.

Use the following procedures:

• To submit all samples in the batch

• To submit selected samples

For a description of commands on the shortcut menu, see “Batch View shortcut menu 
commands” on page 282.

 To submit all samples in the batch

1. Click the Submit Batch button, .

The Submit Options dialog box opens. See “Submit Options dialog box” on page 280.

2. Select the tasks you want to perform: acquire data, process data, or create reports.

3. (Optional) Click Show Details to display additional Acquisition parameters.

4. Select the Use check box for the device that you want to use for this acquisition.

5. (Optional) Select the Start Device check box to indicate the device that will initiate the 
communication with the other instruments. 

This is usually the autosampler.

6. (Optional) Select the Start When Ready check box to have all instruments start together 
when they are all ready. 

When this is cleared, individual instruments can start at different times and then must 
wait for the last instrument to be ready.

7. (Optional with multiplexing enabled) Select the Priority Sequence check box. 

The application acquires the priority batch on the next available channel or the assigned 
channel.

8. (Optional without multiplexing enabled) Select the Priority Sequence check box and 
then select one of the following priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the currently acquiring 
batch. 

• Next Available Sample places the batch immediately after the currently acquiring 
sample.

9. To start the selected processes, click OK.
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 To submit selected samples

1. Select the samples you want to submit.

2. Click the Submit Selected Samples button, .

The Submit Options dialog box opens. See “Submit Options dialog box” on page 280.

3. Select the tasks you want to perform: acquire data, process data, or create reports.

4. Select the Use check box for the device that you want to use for this acquisition.

5. (Optional) Click Show Details to display additional Acquisition parameters.

6. (Optional) Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

7. (Optional) Select the Start When Ready check box to have all instruments start together 
when they are all ready. 

When this is cleared, individual instruments can start at different times and then must 
wait for the last instrument to be ready.

8. (Optional with multiplexing enabled) Select the Priority Sequence check box. 

The application acquires the priority batch on the next available channel or the assigned 
channel.

9. (Optional without multiplexing enabled) Select the Priority Sequence check box and 
then select one of the following priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the currently acquiring 
batch. 

• Next Available Sample places the batch immediately after the currently acquiring 
sample.

10. To start the selected processes, click OK.
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Figure 73. Submit Options dialog box

Table 61. Submit Options dialog box parameters  (Sheet 1 of 2)

Parameter Description 

User Name Name of the current user.

Samples Reports the batch number and number of samples.

Acquire Data (Default) Submits the current batch to acquisition.

Process Data (Default) Processes the data for the current batch.

Create Reports Creates reports for the current batch.
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Acquisition pane

Device Name Lists all configured instruments. 

If the instrument you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then 
reopen the application. You cannot configure an instrument while 
the TraceFinder application is running.

Use Specifies the instruments used for this acquisition.

Start Device Specifies the instrument that will initiate communication with the 
other instruments. This is usually the autosampler.

Start When Ready Starts the specified device when all the instruments are ready to 
acquire data. When this is cleared, individual instruments can start 
at different times and then must wait for the last instrument to be 
ready.

Priority Sequence With multiplexing enabled, places the batch immediately after the 
currently acquiring batch. 

Without multiplexing enabled, specifies one of the following 
priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the 
currently acquiring batch. 

• Next Available Sample places the batch immediately after the 
currently acquiring sample.

Post-run system 
state

Specifies the system state after it acquires the last batch.
On (default), Standby, or Off.

Buttons

Hide/Show Details Collapses or expands the acquisition details of the Submit Options 
dialog box.

OK Begins the selected processes.

Cancel Closes the Submit Options dialog box without submitting any 
tasks.

Table 61. Submit Options dialog box parameters  (Sheet 2 of 2)

Parameter Description 
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Figure 74. Batch View

Table 62. Batch View shortcut menu commands  (Sheet 1 of 2)

Command Description

Add sample Adds a single empty row to the sample grid.

Insert sample Inserts a single empty row to the sample grid above the selected row.

Insert copy sample Copies the currently selected row and inserts a copy above the row.

Reinject selected samples Creates a copy of the selected sample and appends INJ001 to the file name. Additional 
reinjections of the same sample are numbered INJ002, INJ003, and so forth.

Remove selected samples Removes selected samples from the sample grid.

Import samples Opens the Sample Import Tool. See “To import samples into the list” on page 266.

Browse in raw file Opens a dialog box where you can select a raw data file to use for the sample row.

Map raw files to samples Opens a dialog box where you can select raw data files to use for the sample rows.

Copy down Copies the value in the selected row to all rows below it. This command is available only 
when you have selected a value that can be copied down.

Fill down Enters sequential values in the column starting with the value in the selected row and 
ending with the last row in the column. This command is available only when you have 
selected a value that can be filled down.

Modify columns Opens the Modify Columns dialog box. See “Column Display” on page 286.

Copy Copies the data in the selected rows or columns to the Clipboard. Use this command to 
copy sample information to another application, such as an Excel spreadsheet. You cannot 
paste this data back into the Batch View sample list.
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Copy With Headers Copies the data in the selected rows or columns and the associated column headers to the 
Clipboard. Use this command to copy sample information to another application, such as 
an Excel spreadsheet. You cannot paste this data back into the Batch View sample list. For 
example: 

Paste Pastes a single column of copied data from another application, such as an Excel 
spreadsheet, into the selected column.

Undo Last Paste Removes the last pasted item in the Batch View. 

Export to CSV file Opens the Save As dialog box where you can save the current sample list to a .csv file.

Table 62. Batch View shortcut menu commands  (Sheet 2 of 2)

Command Description

Copy With Headers 
from TraceFinder

Paste into Excel spreadsheet
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Working in Data Review View
In the Data Review view, you can view the data generated by the master method. Use the Data 
Review view to verify the data for a sample-specific compound before you generate reports. 
You can use the functions in the Data Review view to investigate and edit the quantification 
values in a batch. 

 To open the Data Review view

1. Do one of the following (to open Data Review mode):

From the dashboard, click Data Review.

–Or–

Click Data Review in the navigation pane of the current mode.

2. In the Data Review navigation pane, click Data Review (to open the Data Review view).

The Data Review view for the currently selected batch opens. 

The Data Review view uses a samples list and one of two modes: Quan Mode or Qual Mode. 
The Qual Mode is available only for Unknown/TIC sample types. When you view the data 
for an Unknown/TIC sample type, you can switch between Qual Mode and Quan Mode. 

This section includes the following topics:

• Samples List

• Quan Mode

• Qual Mode
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Samples List 

Use the samples list to select a particular sample. For detailed descriptions of the columns in a 
samples list, see “Samples list” on page 292.

Status indicators for each sample indicate if the sample is unacquired, acquired, currently 
acquiring, or processed. 

The samples list includes the following features:

• Column Display

• Status Indicators

• Sample Flags

• Compound Flags

• Inactive and Excluded Compounds

The samples list is the same in both Quan Mode and Qual Mode and displays all the 
quantitative data for the samples of a batch. 

• In Quan Mode, the samples list works with the Compounds pane to select a unique 
sample and compound combination, which then has its textual and graphical values 
displayed in the Quan Mode pane. The list of compounds that are available for a specific 
method is displayed in the Compounds pane.

From the samples list, you can make a compound active or inactive. Switching a 
compound to inactive status does not remove its data and calculated values from the 
result set. Instead, the TraceFinder application masks the appearance of that compound 
for that particular sample and grays the compound in the Compounds list. For a 
calibration standard, the application no longer uses the data file’s calibration point for the 
calibration and removes it from the graphical view of the calibration curve displayed in 
the Qualification pane. It is no longer part of the result set. 

• In Qual Mode, the samples list works with the peaks pane to select a unique sample and 
peak combination, which then has its textual and graphical values displayed in the Qual 
Mode pane.
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Column Display

The samples list can contain many columns of information. You can scroll to see all the 
columns of information, and you can customize which columns you want to display and their 
display order.

Use the following procedures:

• To scroll the samples list

• Status Indicators

• To customize the column display

 To scroll the samples list

Use the scroll bar at the bottom of the samples list to view all the information. 

When you use the horizontal scroll bar at the bottom of the samples list, the Status and 
Filename columns stay fixed while the other columns scroll right and left. 

 To temporarily customize the column display

1. To resize a column, drag the header separator on the right side of the column.

2. To move a column, drag the column header.

The Status, Sample Level, Sample Type, and Filename columns can be swapped with each 
other, but they must always be the first four columns in the sample list.

You cannot save these changes. When you restart the TraceFinder application, the Data 
Review view displays your columns in the order specified in the Modify Columns dialog 
box. 
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 To customize the column display 

1. Right-click the Data Review sample list and choose Modify Columns from the shortcut 
menu.

The Modify Columns dialog box opens.

2. Use the arrow buttons to move all the columns you want to display to the Displayed 
Columns pane.

All the columns you select are displayed after the Status, Sample Level, Sample Type, and 
Filename columns.

Parameter Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

Moves the selected column to the Available Columns pane. You cannot 
move the Status, Sample Level, Sample Type, or Filename columns.

Moves all columns except Status, Sample Level, Sample Type, and 
Filename to the Available Columns pane.

Moves the selected column name in the Displayed Columns pane one 
row up in the column order. You cannot move the Status, Sample Level, 
Sample Type, or Filename columns.

Moves the selected column name in the Displayed Columns pane one 
row down in the column order. You cannot move the Status, Sample 
Level, Sample Type, or Filename columns.
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3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use the Up and Down buttons to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Batch View sample 
list; the last column in the list represents the rightmost column in the Batch View 
sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. When you have completed your changes, click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Data Review view.

You can use the drag-and-drop method to temporarily reorder the columns in your 
sample list, but you cannot save this order. When you restart the TraceFinder application, 
the Data Review view displays your columns in the order specified in the Modify 
Columns dialog box. 

Status Indicators

Status indicators show the current status of each sample during the acquisition and 
processing:

• Orange for samples that are currently acquiring
• Blue for samples that have not been acquired
• Yellow for samples that have been acquired and not processed
• Green for samples that have been acquired and processed

Note  You cannot move the Status, Sample Level, Sample Type, or Filename 
columns.

Status indicators
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Sample Flags 

The Flags column in the samples list displays a caution flag if the sample is not in compliance 
with the method criteria. 

Sample caution flags remain static when you switch between compounds for chromatogram 
review until a change is completed, for example, when a compound is manually integrated 
and no longer falls outside the accepted criteria.

To display a summary of problems found in the sample, click the caution flag. The summary 
does not list compounds that are not found in Unknown sample types. 

Compound Flags

Flags are displayed in these situations:

• When a compound has violated (or is activated by) any of the values set in the method 
(See “Editing the Flags Page” on page 159.) 

• For compounds that are not found

• For compounds that are not found in Cal Std or Chk Std sample types

• For compounds that are outside the specified ion ratio range

Sample flags
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The compounds list is sorted first by flag indicators and then by compound names. 
Compound flags indicate the following:

• Red flags for compounds that have ion ratio failures or method validation failures

• Orange flags for compounds that are below the LOQ, below the LOD, or between the 
LOD and LOQ values specified in the method

• Green flags for compounds that are over the LOR amount specified in the method

• No flag for compounds that have no errors or where no report options are selected

Inactive and Excluded Compounds

Use the Active and Excluded columns to control which compounds are used for calculating 
the calibration curve and for reporting.

Use the following procedures:

• To make a sample active or inactive

• To exclude a calibration point

 To make a sample active or inactive

1. Select the sample in the samples list.

All compounds in the selected sample are displayed in the Compounds pane. Inactive 
compounds are grayed out.

2. In the Compounds pane, select the compound whose active/inactive status you want to 
change.

3. In the samples list, select or clear the Active check box.

Use the horizontal scroll bar at the bottom of the table to scroll to the Active column.

Inactive
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 To exclude a calibration point

In the samples list, select the Excluded check box for the sample.

Use the horizontal scroll bar at the bottom of the table to scroll to the Excluded column.

When a value is no longer used for calibration, it is displayed as an empty box in the 
graphical view of the calibration curve.

Excluded 
calibration 
point
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Figure 75. Samples list

Cells in the samples list that should not have a value, such as the theoretical concentration for 
an unknown, are shaded and empty. Cells that should have a value, but none exists, report 
N/A (not available). Results for compounds that are not detected display N/F (not found).

Table 63. Samples list columns  (Sheet 1 of 3)

Parameter Description

Status • Orange for samples that are currently acquiring
• Blue for samples that have not been acquired
• Yellow for samples that have been acquired and not processed
• Green for samples that have been acquired and processed

Flags Displayed only when a compound within the sample has an error. 

Filename Name of the raw data file that contains the sample data.

Sample Type Defines how the TraceFinder application processes the sample data. Each sample is classified 
as one of the following sample types:

Environmental and Food Safety: Matrix Blank, Cal Std, Chk Std, LCS, LCSD, MDL, 
Method Val, MS, MSD, Unknown, Unknown/TIC, Solvent

General Quantitation: Matrix Blank, Cal Std, Chk Std, Unknown, Unknown/TIC, Solvent
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Sample Level The level defined for a calibration sample or quality control sample.

Sample ID A user-defined alphanumeric string that identifies a sample.

Sample Name A user-defined name that identifies a sample.

Comment A user-defined comment for the sample.

Vial Position The tray vial number used for the autosampler acquisition.

Injection Volume The injection volume in microliters of sample to be injected. 

When you are using an autosampler, you can set the default injection volume in the 
Autosampler dialog box in the Instrument View. The minimum and maximum injection 
volumes that you can use depend on the Autosampler you configure. The usable range 
depends on the injection mode and might be smaller than the range displayed.

The Injection Volume value set in the master method overwrites the value in the instrument 
method.

Range: 0.1 through 5000 μL

Integration Mode Indicates whether the peaks have been manually integrated or integrated from the original 
method.

Height The distance from the peak maximum to the peak base, measured perpendicular to the 
ordinate. When the Resp Ratio is specified as Height, this column displays an asterisk 
(*Height).

Area The area obtained by integrating peak intensities from the start to the end of the peak. 
When the Resp Ratio is specified as Area, this column displays an asterisk (*Area).

Actual RT Actual retention time for the compound. Retention time is the time after injection when a 
compound elutes and the total time that the compound is retained on the chromatograph 
column.

Expected RT Expected retention time for the compound.

Calc Amt The amount present in the sample, as determined using the calibration curve and the 
response ratio.

Theo Amt Theoretical amount of the compound expected in the sample. 

Resp Ratio The ratio of the Response value to the IS Response value. If the Response is specified as Area 
in the processing method, the units of both Response and IS Response are counts-sec. If the 
Response is specified as Height in the processing method, the units of both Response and IS 
Response are counts.

IS Amt Amount of internal standard.

IS Resp Response of the internal standard.

Table 63. Samples list columns  (Sheet 2 of 3)

Parameter Description
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Active Displays or hides a compound for a particular sample. When a calibration standard is 
marked inactive, the application no longer uses the data file’s calibration point for the 
calibration and removes it from the graphical view of the calibration curve displayed in the 
Qualification pane. It is no longer part of the result set. 

Excluded Turns a compound on or off in the Calibration curve of the Qualification pane. 

%Diff The calculated amount minus the expected amount, divided by the expected amount, and 
then multiplied by 100.

%RSD Standard deviation of the multiple samples of one level, multiplied by 100, and divided by 
the average of the multiple samples of that level. This calculation is based on the calculated 
amounts.

%CV Coefficient of Variance. Standard deviation of the multiple samples of one level, multiplied 
by 100, and divided by the average of the multiple samples of that level. This calculation is 
based on the areas of the peaks.

Channel Specifies the channel on which the sample was run. If the sample is not acquired, the value is 
Pending. This column is displayed only when you enable multiplexing.

Table 63. Samples list columns  (Sheet 3 of 3)

Parameter Description
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Quan Mode

Use the Quan Mode and the associated Compounds pane to view quantitative information to 
complement the textual information for the selected sample. The Quan Mode displays 
quantitative peak and confirming ion information for selected compounds that are found in 
the processed samples.

In addition to the Samples list, the Quan Mode view uses the following panes:

• Compounds

• Quantification Peak

• Qualification

Samples list Compounds pane

Quantification Peak pane Qualification pane
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Compounds

The Compounds pane works with the samples list pane to display textual and graphical values 
for a unique file and compound combination.

Use the following procedures:

• To sort the compounds list

• To display peaks for a specific compound

• To display specific problems with a compound

• To display the internal standard for a compound

 To sort the compounds list

In the Compounds pane, right-click and choose one of the following sort styles from the 
shortcut menu:

Command Description

Sort by flag and 
alphabetical

Sorts the compounds first by flag and then within each flag 
group, sorts the compounds alphabetically.

Sort by flag and 
retention time

Sorts the compounds first by flag and then within each flag 
group, sorts the compounds by retention time.

Sort by alphabetical Sorts the compounds alphabetically (1-n followed by a-z).

Sort by retention time Sorts the compounds from shorter retention time to longer 
retention time.
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 To display peaks for a specific compound

1. In the samples list, select the sample.

The Compounds pane lists all compounds specified in the method.

2. In the Compounds pane, select the compound in the sample.

The Quantification Peak pane displays the peaks for the selected compound and its 
internal standard. 

 To display specific problems with a compound

Hold the cursor over the flag to display the problems with the compound.

Compound peak

Sample Compound

Internal standard
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 To display the internal standard for a compound

1. Right-click the Quan Peak pane and choose Show Internal Standard from the shortcut 
menu.

The Quantification Peak pane displays an ISTD pane with the internal standard for the 
selected sample and compound.

2. To hide the ISTD pane, right-click the Quan Peak or ISTD pane and choose Hide 
Internal Standard from the shortcut menu.

Note  By default, the ISTD pane is not displayed.
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Quantification Peak

The Quantification Peak pane displays the compound selected in the samples list and 
Compound pane. You can store two peak value sets (method and manual integration settings) 
with each compound in each file. These settings can result in a different set of stored values. 
The method values were originally calculated based on the processing method parameters. 
The manual values are a result of what has been edited. 

When the sample contains an internal standard, the chromatogram shows both the analyte 
and the internal standard in side-by-side panes.

Use the following procedures:

• To zoom in on a peak

• To manually integrate a quantification or qualification ion

• To manually add a peak

• To remove a manually created peak

• To switch between method and manual integration modes

• To change the displayed information for detected peaks

• To modify the peak detection settings

For a description of commands on the shortcut menu, see “Quantification Peak Shortcut 
Menu” on page 303.

 To zoom in on a peak

1. In the chromatogram plot, drag your cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 
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 To manually integrate a quantification or qualification ion

1. Place your cursor over one of the two peak delimiter tags in the Quantification Peak pane.

When the tag can be selected, the cursor changes to a crosshair-style cursor. You can zoom 
in on the baseline to make it easier to select the tag. 

2. Drag the peak delimiter tag to another location and automatically update the peak values 
(area, height, and so forth) into the result set. 

Both the Quantification Peak pane and the Integration mode column in the 
Quantification Data pane reflect the change between method and manual modes. The 
generated reports for these data identify the manual modifications.

 To manually add a peak

1. Right-click anywhere in the Quantification Peak pane, and choose Add Peak from the 
shortcut menu.

If a peak is already detected, the Add Peak command is not enabled. 

2. Click to indicate the left and right base points for the peak. 

The application places the peak delimiter tags at these locations and automatically 
updates the peak values (area, height, and so forth) in the result set. 

 To remove a manually created peak

Right-click the chromatogram plot, and choose Remove Peak from the shortcut menu.

The application removes the manually added peak.

Note  Because a Blank Report displays only the quan mass, when you manually 
integrate a confirming ion, the manual integration flag in the report is displayed on 
the quan mass.

Manually added 
base points
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 To switch between method and manual integration modes

Right-click the chromatogram view and choose Method Integration Settings or Manual 
Integration Settings from the shortcut menu. 

Initially, the method and manual integration settings that are stored for a compound and 
file are identical. When you switch modes, the saved result set does not change. However, 
when manual data are available, the chromatogram plots and the result set update as you 
switch between method and manual modes. 

As you switch between modes, each pane reflects the changes. The generated reports for 
these data identify the manual modifications.

 To change the displayed information for detected peaks

1. Right-click the quantification chromatogram plot and hold the cursor over Peak Labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and cleared for labels that are 
not displayed.

3. To remove a label, select the label type again and clear it.

Label settings are globally applied to quantification peaks, confirming peaks, and internal 
standard peaks. 

 To modify the peak detection settings

1. Right-click the chromatogram view and choose Peak Detection Settings from the 
shortcut menu. 

The Peak Detection Settings dialog box opens. Use the Peak Detection Settings dialog 
box to adjust detection settings that were specified in the method.

Note  Because a Blank Report displays only the quan mass, when you manually 
integrate a confirming ion, the manual integration flag in the report is displayed on 
the quan mass.

Tip  The labels do not always update on all peak displays. To update all labels, select a 
different compound, and then reselect the compound whose labels you changed.
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Figure 76. Peak Detection Settings dialog box

2. Edit any of the detection settings.

For detailed descriptions of all detection settings, see “Detection” on page 121.

3. To save your changes to this compound in all samples in this batch, click Apply to All. 
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Quantification Peak Shortcut Menu

The Quantification Peak shortcut menu includes the following commands: 
 

Table 64. Quantification Peak shortcut menu commands 

Command Description

Method Integration Settings Displays method integration settings.

Manual Integration Settings Displays manual integration settings.

Add Peak
–or–
Remove Peak
–or–
Cancel Add Peak

Adds a peak, removes a peak, or cancels an add peak 
operation in progress.

Confirming Ion List Select the confirming ions to be viewed.

Peak Labels Displays or hides the peak labels (Label Area, Label 
Retention Time, Label Height, or Label Signal to Noise).

Show Peak Info Displays peak information for the selected compound. 
For example:

Reset Scaling Resets the original scaling after a zoom operation.

Peak Detection Settings Opens the Peak Detection Settings dialog box for the 
selected compound. 
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Qualification

The Qualification pane displays the compound selected in the Quantification Data pane and 
Compounds pane. 

The Qualification pane has five pages: 

• Calibration Curve 

• Spectra 

• QED Spectra

• Confirming Ions 

• Ion Overlay 

Calibration Curve

The Calibration Curve page displays a graphical view of the calibration curve for the selected 
compound and key statistical values for evaluating the quality of the calibration. 

Use the following procedures:

• To manually exclude a calibration point

• To zoom in on an area

For a description of commands on the shortcut menu, see “Calibration Curve Shortcut 
Menu” on page 306.
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 To manually exclude a calibration point

In the samples list, select the Excluded check box for the sample.

Use the horizontal scroll bar at the bottom of the table to scroll to the Excluded column.

When a value is no longer used for calibration, it is displayed as an empty box in the 
graphical view of the calibration curve.

 To zoom in on an area

1. In the Calibration Curve plot, drag your cursor to delineate a rectangle around an area. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the calibration curve plot and choose 
Reset Scaling from the shortcut menu. 

Changes to the calibration settings immediately apply to the entire results set, but you 
save them only when you save the batch.

Excluded 
calibration 
point
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Calibration Curve Shortcut Menu

The Calibration Curve shortcut menu includes the following commands: 

Spectra 

The Spectra page displays a comparison of the spectra found in the data and the method 
reference. 

 To zoom in on an area

1. Drag your cursor to delineate a rectangle around an area. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the spectra plot and choose Reset Scaling 
from the shortcut menu. 

Table 65. Calibration Curve shortcut menu commands

Command Description

Standard Type Sets the standard type to External or Internal. 
Calibration Curve Type Sets the calibration curve type to one of the following:

• Linear: Allows all settings with this exception: When Origin 
is set to Include, all Weighting values are grayed out and 
Weighting is set to Equal.

• Quadratic: Allows all settings with this exception: When 
Origin is set to Include, all Weighting values are grayed out 
and Weighting is set to Equal.

• Average RF: Allows no Weighting or Origin selections. All 
Weighting and Origin values are grayed out. Weighting is set 
to Equal, and Origin is set to Ignore. 

Response Via Sets the response to Area or to Height.
Weighting Sets the weighting to equal, 1/X, 1/X^2, 1/Y, or 1/Y^2.
Origin Sets the origin to Ignore, Force, or Include.
Units Sets the units.
Done with Settings
Reset Scaling Resets the original scale in the calibration curve pane.
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QED Spectra 

The QED spectra display the averaged QED spectra from the raw data file and the datastore 
match. If the sample contains no QED data, the page is blank.

 To zoom in on an area

1. Drag your cursor to delineate a rectangle around an area. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the spectra plot and choose Reset Scaling 
from the shortcut menu. 
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Confirming Ions

The Confirming Ions page displays a graphical view of all qualifying/confirming ions for the 
selected sample and compound and displays calculated ion ratios and ion ratio acceptance 
windows. A red border indicates that an ion ratio is outside of its window. Depending on the 
method option settings, another ion view is available on the Ion Overlay page. See “Ion 
Overlay” on page 312.

A red border indicates that an ion ratio is outside of its window.

Use the following procedures:

• To manually add a peak

• To remove a manually created peak

• To zoom in on a peak

• To change the displayed information for detected peaks

• To display the peak information window

For a description of commands on the shortcut menu, see “Confirming Ions Shortcut Menu” 
on page 311.
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 To manually add a peak

1. Right-click the chromatogram plot and select Add Peak from the shortcut menu.

If a peak is already detected, the Add Peak command is not enabled. 

2. Click to indicate the left and right base points for the peak. 

The application places the peak delimiter tags at these locations and automatically 
updates the peak values (area, height, and so forth) in the result set. 

 To remove a manually created peak

Right-click the chromatogram plot, and choose Remove Peak from the shortcut menu.

The application removes the manually added peak.

 To zoom in on a peak

1. In the chromatogram plot, drag your cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view.

2. To restore the method default view, right-click the chromatogram plot and choose Reset 
Scaling from the shortcut menu.

 To change the displayed information for detected peaks

1. Right-click the chromatogram plot and hold the cursor over Peak Labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and cleared for labels that are 
not displayed.

3. To remove a label, select the label type again and clear it.

Label settings are globally applied to quantification peaks, confirming peaks, and internal 
standard peaks. 

Tip  The labels do not always update on all peak displays. To update all labels, select a 
different compound, then reselect the compound whose labels you changed.

Manually added 
base points
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 To display the peak information window

1. Right-click the quantification and confirming ion chromatogram plots.

2. Choose Show Peak Info from the shortcut menu.

Information in this window includes the data stream processed for this ion, consisting of 
a particular detector, filter (if applicable), and trace. For example, an MS detector might 
show a filter of “+ c Full ms [35.00-500.00]” and a Mass Range trace. 

This window also shows the peak area and height, along with the retention times of the 
peak integration and the peak apex. 
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Confirming Ions Shortcut Menu

The Confirming Ions shortcut menu includes the following commands: 

Table 66. Confirming Ions shortcut menu commands

Command Description

Method Integration Settings Displays method integration settings.

Manual Integration Settings Displays manual integration settings.

Add Peak - Remove Peak - 
Cancel Add Peak

Adds a peak, removes a manually added peak, or cancels an 
add peak operation in progress.

Range Calc Method: Manual Selects the method used to calculate the ion ratio range 
windows: Manual, Average, Weighted average, or Level.

Range Calc Level Range based on the calibration level.

Target Ratio: Specifies the theoretical ratio of the confirming ion's 
response to the quantification ion's response. 

Window Type: Specifies the Absolute or Relative calculation approach for 
determining the acceptable ion ratio range. 

Window: % Specifies the acceptable ion ratio range as a percentage. 

Peak Labels Displays or hides the peak labels (Label area, Label retention 
time, Label height, or Label signal to noise).

Show Peak Info Displays peak information for the selected compound. For 
example:

Reset Scaling Resets the original scaling after a zoom operation.

Peak Detection Settings Opens the Peak Detection Settings dialog box for the 
selected compound. See “Peak Detection Settings dialog 
box” on page 302.
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Ion Overlay 

The Ion Overlay page represents an overlay of the entire ion set—quantification and 
qualifying/confirming—for the selected sample and compound. Use this page to graphically 
review the peak apex alignment and co-eluting peak profiles. 

 To zoom in on a peak

1. Drag your cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the chromatogram plot and choose Reset 
Scaling from the shortcut menu. 
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Qual Mode

Use the Qual Mode and the associated peaks pane to view qualitative information that 
complements the textual information for the selected Unknown/TIC sample. The Qual 
Mode view displays detected peaks for the selected sample. From the Qual Mode view, you 
can manually add peaks. The Qual Mode view is available only for Unknown/TIC sample 
types.

In addition to the Samples list, the Qual Mode view displays data in the following panes:

• Peaks Pane

• Chromatogram Navigation Pane

• Qual Peak Pane

• Spectra Pane (Reference and Selected)

• Ranking Pane

Samples list Peaks pane

Chromatogram 
navigation pane Qual peak pane  Spectra pane  Ranking pane

Tip  To resize the panes, drag the separators that divide the panes.
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Peaks Pane

The peaks pane works with the samples list to display graphical values for a unique sample 
and peak combination. For detailed descriptions parameters on the peaks pane, see “Peaks 
pane” on page 316.

 To display peaks for a specific compound

1. From the samples list, select a sample. 

The peaks pane lists the retention times for peaks identified in the selected sample, the 
values for the best match methods for each peak, and the compound match.

The number of peaks that are listed is specified in the method. You can change the 
number of identified peaks in the Method Template Editor. See “Creating a Method 
Template” on page 188.

2. From the peaks pane, select a peak in the sample.

The TraceFinder application displays the selected peak in the qual peak pane.

When you select a data-dependent sample, the peak can be from either a full scan or a 
QED spectrum of an SRM-filtered chromatogram.

Note  If you choose a sample other than an Unknown/TIC sample, the TraceFinder 
application returns you to Quan Mode. 
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The TraceFinder application displays the Spectra pane with two sections:

• The Qual Data pane shows spectra data for the peak in the raw data file.

• The Qual Library pane shows actual spectra for the identified library compound.

The TraceFinder application locates the selected peak in the navigation chromatogram.

 To remove a peak

1. Select a peak in the peaks pane.

2. Right-click and choose Remove Selected Peak from the shortcut menu.

The TraceFinder application removes the selected peak from the peaks list.

Note  There is no undo for this action, but you can manually add a peak to redefine a 
removed peak. See “Chromatogram Navigation Pane” on page 317.

Reference spectra 
from the library

Actual spectra for the 
compound
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Figure 77. Peaks pane

Table 67. Peaks pane parameters

Command Description

Filter Filter used to identify the peaks. Specified in the raw data 
file or the master method.

When your raw data file is data-dependent, the filter 
indicates this with a “d”:

Peak RT (min) Peak retention time. The time after injection when the 
compound elutes. The total time that the compound is 
retained on the column. 

SI Search index method used to search the NIST library.

RSI Reverse search index method used to search the NIST 
library.

MP Match probability.

Library entry Library compound that matches the identified peak.

Remove selected peak Shortcut menu command that removes the selected peak 
from the peaks list.

Data-dependent filter
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Chromatogram Navigation Pane

The chromatogram navigation pane displays all peaks in the selected sample. The peak 
selected in the peaks pane displays a red marker. 

For a description of commands on the shortcut menu, see “Chromatogram navigation pane 
shortcut menu commands” on page 318.

 To zoom in on a peak

1. In the chromatogram navigation pane, drag the cursor to delineate a rectangle around the 
peak. 

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram navigation pane and choose 
Reset Scaling from the shortcut menu. 

 To manually add a peak

1. Zoom in to make it easier to identify the peak you want to add to the results set.

2. Right-click the chromatogram navigation pane, and choose Add Peak from the shortcut 
menu.

3. Click to indicate the left and right base points for the peak. 

The TraceFinder application marks the peak in the chromatogram navigation pane.

The TraceFinder application places the peak delimiter tags at the base point locations and 
automatically updates the peak values in the peaks pane and qual peak pane. 
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Figure 78. Qual peak pane with a manually added peak

Figure 79. Chromatogram navigation pane 

 

Table 68. Chromatogram navigation pane shortcut menu commands

Command Description

Add peak Adds a peak.

Reset scaling Resets the original scaling after a zoom operation.

Manually added 
base points
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Qual Peak Pane

The qual peak pane displays the selected peak.

Use the following procedures:

• To zoom in on a peak

• To manually add a peak

• To remove a peak

• To switch between method and manual integration modes

• To change the displayed information for detected peaks

For a description of commands on the shortcut menu, see “Qual peak pane shortcut menu 
commands” on page 321.

 To zoom in on a peak

1. In the chromatogram plot, drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 

 To manually add a peak

1. Right-click anywhere in the qual peak pane, and choose Add Peak from the shortcut 
menu.

If a peak is already detected, the Add Peak command is not enabled. 

2. Click to indicate the left and right base points for the peak. 

The TraceFinder application places the peak delimiter tags at these locations and 
automatically updates the peak values (area, height, and so forth) in the result set. 

Manually added 
base points
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 To remove a peak

Right-click the chromatogram plot, and choose Remove Peak from the shortcut menu.

The TraceFinder application removes the peak displayed in the qual peak pane. All data 
for this peak are removed from the Qual Mode panes.

 To switch between method and manual integration modes

Right-click the chromatogram view and choose Method Integration or Manual 
Integration from the shortcut menu. 

Initially, the method and manual integration settings that are stored for a compound and 
file are identical. When you switch modes, the saved result set does not change. However, 
when manual data are available, the chromatogram plots and the result set update as you 
switch between method and manual modes. 

As you switch between modes, each pane reflects the changes. The generated reports for 
these data identify the manual modifications.

 To change the displayed information for detected peaks

1. Right-click the chromatogram plot and hold the cursor over Peak Labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and cleared for labels that are 
not displayed.

3. To remove a label, select the label type again and clear it.

Label settings are globally applied to qual peaks, confirming peaks, and internal standard 
peaks. 

Tip  The labels do not always update on all peak displays. To update all labels, select a 
different compound, and then reselect the compound whose labels you changed.
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Figure 80. Qual peak pane

The qual peak pane shortcut menu includes the following commands: 

Table 69. Qual peak pane shortcut menu commands

Command Description

Reset scaling Resets the original scaling after a zoom operation.

Method integration Displays method integration settings.

Manual integration Displays manual integration settings.

Peak labels Displays or hides the peak labels (Label Area, Label 
Retention Time, Label Height, or Label Signal to Noise).

Remove peak Removes the peak displayed in the Qual pane. 
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Spectra Pane (Reference and Selected)

The Spectra pane displays the reference spectra and the spectra for the selected sample. The 
top pane displays the reference spectra for the identified compound from the library; the 
bottom pane displays the spectra for the selected peak.

Figure 81. Spectra pane

 To zoom in on a peak

1. In the spectra plot, drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view. 

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 

Reference 
spectrum from 
the library

Actual spectrum 
for the selected 
peak
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Ranking Pane

The ranking pane displays the three best library matches for the selected peak. Use this pane 
to select a different library entry for the peak.

When you select a library entry other than the original entry, the TIC Report and TIC 
Summary Report indicate this with a “P” flag:

For a detailed description of ranking pane parameters, see “Ranking pane” on page 324.

 To change the library entry for a selected peak

In the ranking pane, select the check box for the library entry you want to use to identify 
the selected peak.

• In the Spectra pane, the reference spectra change to show the spectra for the selected 
library entry.

• In the peaks pane, the SI, RSI, MP, and Library Entry values update to reflect the 
selected library entry.

P flag

Selected library entry 
in the ranking pane

Reference 
spectrum 
for Acenaphthene 

Peaks pane for 
Acenaphthene
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Figure 82. Ranking pane

Table 70. Ranking pane parameters

Command Description

<Check box column> Indicates selected library entries for the selected peak.

Rank Indicates the order of best matches between the selected 
peak and library entries.

SI Search index method used to search the NIST library.

RSI Reverse search index method used to search the NIST 
library.

MP Match probability.

Library entry Library compound that matches the identified peak.
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Working in Report View
Use the Report View to display or generate reports for the currently selected batch in the Data 
Review mode. You must process each sample in the batch before you can view or generate a 
sample-level report for that sample. 

This section includes the following topics:

• Viewing Reports

• Generating Reports

• Working with Reports

• Working with Active View

Figure 83. Report View in Data Review mode

• View Only: Displays a PDF or Excel spreadsheet preview of the selected report type for 
the batch, sample, or compound. See “Viewing Reports” on page 326.

Preview reports for all Standard report types are always available. You must generate 
Custom and Target Screening report types before they are available in this list. 

The Report View page displays one of the following report outputs:

• Standard reports as PDF files

• Custom reports in XLSM format

• Target Screening reports as PDF files

• Generate Only: Creates all specified report output formats for the selected sample- or 
batch-level report. See “Generating Reports” on page 330. 

 To open the Report View

1. Click Data Review in the navigation pane from any mode.

2. In the Data Review navigation pane, click Report View.

The Report View for the currently selected batch opens.
Thermo Scientific TraceFinder User Guide 325



6 Using the Data Review Mode
Working in Report View
Viewing Reports

Use the View Only features to view all configured standard reports and any custom or target 
screening reports that you have generated. After you generate a report, the application displays 
the report in the View Only report list.

Use the following procedures:

• To select a report

• To select a sample

• To select a compound

• To select a sample and a compound

 To select a report 

1. Select the View Only option.

2. Click the Select a Report box. 

The report list opens, displaying all configured report types.

These reports reflect the Displayed Reports selections in the Configuration mode. To 
change the configured reports that are available in this view, see “Specifying the Reports 
Configuration” on page 58.

To sort the reports, click the column headers. The application maintains this sort order 
each time you open the Report View for this batch.

To help organize your reports, you can filter the list.

3. To limit the types of reports you want to display in the report list, select any combination 
of report filter options in the Filter Reports area.
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4. Double-click the name of the report.

The report list closes.

• When the selected report is a batch-level report, the application displays the report on 
the Report View page. 

• When the selected report includes separate reports for each sample, you must select a 
sample file. 

Follow the procedure “To select a sample” on page 328.

• When the selected report includes separate reports for each compound, you must 
select a compound. 

Follow the procedure “To select a compound” on page 328.

• When the selected report includes separate reports for each sample and each 
compound in the sample, you must select both a sample and a compound. 

Follow the procedure “To select a sample and a compound” on page 329.

Table 71. Filter Reports options

Option Behavior

Only show automated batch 
reports

Displays only reports that have an output format 
specified in the Automated Batch Reports area in the 
Batch View. See “Editing Report Output Formats” 
on page 274.

Standard reports Displays Standard report types.

Custom reports Displays all generated Custom report types. Custom 
reports are not available for viewing until you have 
generated the report. 

Target Screening reports Displays all generated Target Screening reports. 
Target Screening reports are not available for viewing 
until you have generated the report. 

Note  When you make changes to the method in the Local Method view, to the peaks 
in the Data Review view, or to the samples in the Batch View, you must regenerate the 
custom or target screening reports to see the effects of those changes. 
Thermo Scientific TraceFinder User Guide 327



6 Using the Data Review Mode
Working in Report View
 To select a sample

1. Click the Sample File box. 

The sample list displays all samples in the batch.

2. To show only samples that would be included in the selected report, select the Only 
Show Samples Relevant... check box.

For example, if you selected the Check Standard Report, the sample list displays only 
Chk Std samples.

3. Double-click the name of the sample.

The sample list closes. The Report View page displays the sample-level report.

 To select a compound 

1. Click the Compound list. 

The compound list displays the names and retention times of all compounds in the 
sample.

2. Double-click a single compound or All Compounds.

The compound list closes. The Report View page displays the compound-level report.

Note  Click the column headers to sort the samples. The application maintains this 
sort order each time you open the Report View for this batch.
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 To select a sample and a compound

1. Click the Sample File box. 

The sample list displays all samples in the batch.

2. To show only samples that would be included in the selected report, select the Only 
Show Samples Relevant... check box.

For example, if you selected the Check Standard Report, the sample list displays only 
Chk Std samples.

3. Double-click the name of the sample.

The sample list closes. 

4. Click the Compound list. 

The compound list displays the names and retention times of all compounds in the 
sample.

5. Double-click a single compound or All Compounds.

The compound list closes. 

The Report View page displays the compound-level report for the selected sample and 
compound. 

Tip  Click the column headers to sort the samples. The application saves this sort 
order in the Report View for this batch.
Thermo Scientific TraceFinder User Guide 329



6 Using the Data Review Mode
Working in Report View
Generating Reports

Use the Generate Only features to create sample-level reports. You cannot use the View Only 
features to view custom or target screening reports until you generate the report. When you 
make changes to the method in the Local Method view or to the peaks in the Data Review 
view, you must regenerate the custom or target screening reports to see the effects of those 
changes. 

Use the following procedures:

• To select a report

• To select a sample

 To select a report

1. Select the Generate Only option.

2. Click the Select a Report box.

The report list opens.

All configured sample-level report types are displayed in the list. You cannot generate 
batch-level or compound-level reports from this view. To change the configured reports 
that are available in this view, see “Specifying the Reports Configuration” on page 58.

If you have many reports, you can filter the list.
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3. To limit the types of reports you want to display in the report list, select any combination 
of report filter check boxes in the Filter Reports area.

4. Double-click the name of the report.

The report list closes. You must select a sample file for the selected report. 

 To select a sample

1. Click the Sample File box. 

The sample list displays all samples in the batch.

2. To show only samples that would be included in the selected report, select the Only 
Show Samples Relevant... check box.

Option Behavior

Only show automated batch 
reports

Displays only sample-level reports that have an 
output format specified in the Automated Batch 
Reports area in the Batch View. See “Editing Report 
Output Formats” on page 274.

If you have only batch-level reports specified in the 
Batch View, selecting this option excludes all reports 
in the Report Name list.

Standard reports Displays sample-level Standard report types. 

Custom reports Displays sample-level Custom report types. 

Target Screening reports Displays sample-level Target Screening report types. 

Note  Click the column headers to sort the samples. The application saves this sort 
order in the Report View for this batch.
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For example, if you selected the Check Standard Report, the sample list displays only 
Chk Std samples.

3. Select the check box for each sample you want to include in the report.

4. Click Generate.

The Report Selection Confirmation dialog box opens.

5. In the What Action Would You Like to Perform area, select the types of reports you want 
to create.

6. Click Continue.

The application submits the selected samples to the report queue.

When you have already generated this report in the Batch View or Acquisition Mode, the 
new report is time-stamped to differentiate it from the original report.

7. To view the report you generated, follow the instructions in “Viewing Reports” on 
page 326.

Note  Click the column headers to sort the samples. The application saves this sort 
order in the Report View for this batch.

Note  The application automatically selects required output formats. These options 
are not editable. 

Note  When you make changes to the method in the Local Method view, to the peaks in 
the Data Review view, or to the samples in the Batch View, you must regenerate the 
custom or target screening reports to see the effects of those changes. 
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Working with Reports

Use the buttons on the Report View page to view, print, or export a report.

• A PDF report view is available for all Standard and Target Screening report types. 

• An Excel Macro-Enabled Workbook report view is available for any Custom report types 
that you have generated with the Generate XLSM option selected.

Use the following procedures:

• To print a standard or target screening report

• To export a standard report

• To search for text

• To enlarge the report text

 To print a standard or target screening report

1. Select the report you want to print from the Select a Report list.

2. (Optional) Select a sample from the Sample File list.

The application displays the report on the Report View page.
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3. Click the Print Report button, .

The Print dialog box for your default printer opens.

4. Follow the typical procedure to print from your printer.

Landscape reports automatically rotate to fit the paper.

 To export a standard report

1. Select the report you want to print from the Select a Report list.

2. (Optional) Select a sample from the Sample File list.

The application displays the report on the Report View page.

3. Click the Export Report button, .

The Export Report dialog box opens.

4. Locate the folder where you want to write the report file.

5. Type a file name for the exported report file.

6. Select a file type from the Save as Type list:

7. Click Save.

The TraceFinder application saves the file as the specified file type and writes the report 
file to the specified folder.
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 To search for text

1. Select a report from the Select a Report list.

2. (Optional) Select a sample from the Sample File list.

The application displays the report on the Report View page.

3. Click the Find Text button, .

The Find Text dialog box opens.

4. Enter your text and click Find Next.

When the TraceFinder application locates the text, it encloses the text in a red box.

 To enlarge the report text

1. Select a report from the Select a Report list.

2. (Optional) Select a sample from the Sample File list.

The application displays the report on the Report View page.

3. Click the Zoom button, , and select a zoom scale.
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Working with Active View

Use the Active View page to view quantitative data for each sample in a report. Data in the 
Active View are labeled with flag information. These flags are based on a comparison of the 
batch data to criteria defined in the master method.

 To display the Active View page

Click the Active View tab.

The Active View page displays quantitative data and QAQC error flags for each sample. 
See “Active View page” on page 337. 

 To display a report

1. Select a report type from the Select a Report list.

Only the report types created for the current batch are displayed in the list. 

2. (Optional) When the report type includes separate reports for each sample, select a 
sample file.

 To filter which compounds to display

Click the Showing button to display either all compounds or only compounds that are 
flagged for failing a QAQC test.
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Figure 84. Active View page

Table 72. Active View parameters  (Sheet 1 of 4)

Parameter Description

View Only The Active View pane is available only when View Only is selected.

Select a report Displays the report types created for the current batch. 

Sample file Used when the report type includes separate reports for each sample.

Total Rows The number of compound rows currently displayed in the pane. 

Showing Displays all compounds or only the flagged compounds.
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Column headings
Many column headings are specific to individual reports. See “Active View Report Contents” 
on page 341.

Status Indicates the status of the reported compound. 

• A yellow check mark indicates one of the following conditions:
– The compound was manually integrated.
– Any of the confirming peaks was manually integrated.
– The compound has quan flags. 

• A red check mark indicates that the QAQC checks failed.

• A green check mark indicates that none of these conditions exist.

When the compound is an internal standard, warnings are displayed only on the internal 
standard report. The Status column is blank for Manual Integration reports.

Compound Name Alphanumeric name assigned to the compound.

Compound Type Target Compound, Internal Standard, or Surrogate.

QAQC Flags Indicates that the QAQC check for the sample failed.

The QAQC column is not used for Manual Integration reports.

Quan Flags • Limit of Detection (LOD)
• Limit of Quantitation (LOQ)
• Limit of Reporting (LOR)
• Values between the limit of detection and the limit of quantitation, known as the J flag
• Upper Limit of Linearity (ULOL)

Quan flags do not apply to these sample types: Cal Std, Chk Std, Matrix Blank, or Solvent.

The Quan Flag column is not used for Manual Integration reports.

Manual Flags Indicates manually integrated peaks. 
• M indicates a manually integrated quan peak.
• m indicates a manually integrated confirming peak.

Depending on the selected report, the Active View page contains any or all of the following parameters:

Quan Peak m/z Mass-to-charge ratio for the selected quantitation peak.

Total Response The sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quan peak.

Quan peak RT Retention time for the quan peak.

Theoretical amount Theoretical amount of the compound. Reports N/A when not applicable.

Concentration

Confirming n Mass Mass of the confirming peak.

Table 72. Active View parameters  (Sheet 2 of 4)

Parameter Description
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Confirming n 
Response

Response of the confirming peak.

Confirming n Manual 
Flag

Indicates a manually integrated confirming peak.

Confirming n Ion 
Ratio Flag

Indicates that the ion ratio is out of range.

Confirming n Ion 
Ratio

Actual ratio of the confirming ion response to the quan ion response.

Confirming n Range Acceptable range for the confirming ion.

Retention Time The time after injection when the compound elutes. The total time that the compound is 
retained on the column. 

Quan mass The mass-to-charge ratio used to determine the peak area and peak height of the compound.

Response Sum of all Quan Peak Response values for the compound.

Injection 
concentration

Calculated amount as the sample was injected, with no conversion applied.

Injection Units Injection units specified on the Calibration page in Method Development mode. See 
“Calibration” on page 151.

Sample Concentration The injected concentration multiplied by the conversion factor.

Sample Units Sample units specified on the Calibration page in Method Development mode. See 
“Calibration” on page 151.

QIon Mass range for the quan peak.

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Manual Integration reports

m/z Mass-to-charge ratio for the quan peak.

Method RT Apex retention time for the method-integrated peak.

Method Peak Height Height of the method-integrated peak.

Method Peak Area Area of the method-integrated peak.

Manual RT Apex retention time for the manually integrated peak.

Manual Peak Height Height of the manually integrated peak.

Manual Peak Area Area of the manually integrated peak.

Table 72. Active View parameters  (Sheet 3 of 4)

Parameter Description
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Internal Standard reports

Std Response Average of the internal standard’s response as found in the calibration file.

Minimum Response Minimum response time as specified on the ISTD page in Method Development mode. See 
“ISTD” on page 166.

Maximum Response Maximum response time as specified on the ISTD page in Method Development mode. See 
“ISTD” on page 166.

Sample Response Area found in the sample.

Std RT Average retention time as found in the calibration file.

Min RT Minimum retention time as specified on the ISTD page in Method Development mode. See 
“ISTD” on page 166.

Max RT Maximum retention time as specified on the ISTD page in Method Development mode. See 
“ISTD” on page 166.

Sample RT Retention time found in the sample.

Graphical data

Quan Peak 1

Calibration curve Displays a graphical view of the calibration curve for the selected compound and key 
statistical values for evaluating the quality of the calibration. 

Spectra Displays a comparison of the spectra found in the data and the method reference. 

QED Spectra Displays the averaged QED spectra from the raw data file and the datastore match. If the 
sample contains no QED data, the page is blank.

Confirming Ions Displays a graphical view of all qualifying/confirming ions for the selected sample and 
compound, and displays calculated ion ratios and ion ratio acceptance windows.

Table 72. Active View parameters  (Sheet 4 of 4)

Parameter Description
340 TraceFinder User Guide Thermo Scientific



 6 Using the Data Review Mode
Working in Report View
Active View Report Contents

Each standard report that uses the Active View displays values that are common to all reports:

• Common Active View report columns

In addition to the common values, the following reports display additional active view 
features:

• Blank Report Active View columns

• Calibration Report Active View columns

• High Density Sample Report 1 and High Density Sample Report 1 Long Active View 
columns

• High Density Sample Report 2 and High Density Sample Report 2 Long Active View 
columns

• High Density Sample Report 3 and High Density Sample Report 3 Long Active View 
columns

• Internal Standard Summary Report Active View columns

• Ion Ratio Failure Report Active View columns

• Manual Integration Report Active View columns

• LCSLCSD Report Active View columns (Environmental and Food Safety only)

• Method Detection Limit Report Active View columns (Environmental and Food Safety 
only)

• Method Validation Report Active View columns (Environmental and Food Safety only)

• MSMSD Report Active View columns (Environmental and Food Safety only)

• Quantitation Report Active View columns

• Solvent Blank Report Active View columns
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Table 73. Common Active View report columns

Column Description

Status Indicates the status of the reported compound. 

• A yellow caution sign indicates one of the following 
conditions:

– The compound was manually integrated.

– Any of the confirming peaks was manually integrated.

– The compound has quan flags. 

– The compound has a QAQC failure.

• A green check mark indicates that none of these conditions 
exists.

When the compound is an internal standard, warning flags are 
displayed only on the internal standard report. 

Compound name Alphanumeric name assigned to the compound.

Compound type Target Compound, Internal Standard, or Surrogate.

QAQC flags Indicates that the QAQC check for the sample failed. 

This column is not included on the Method Validation and 
MDL reports.

Quan flags • Limit of Detection (LOD)
• Limit of Quantitation (LOQ)
• Limit of Reporting (LOR)
• Values between the limit of detection and the limit of 

quantitation, known as the J flag
• Upper Limit of Linearity (ULOL)

Quan flags do not apply to these sample types: Cal Std, Chk Std, 
Matrix Blank, or Solvent. 

This column is not included on the Calibration report.

This column is not included on the Calibration Curve report.

This column is not included on the Method Validation, Method 
Detection Limit, LCS, or LCSD reports.

Manual flags Indicates manually integrated peaks. 
• M indicates a manually integrated quan peak.
• m indicates a manually integrated confirming peak.
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Table 74.  Blank Report Active View columns

Column Description

Retention Time Retention time for the quan mass. The time after injection when 
the compound elutes. The total time that the compound is 
retained on the column. 

Quan Mass Mass range for the quan peak.

Response Sum of all Quan Peak Response values for the compound.

Inj Conc Calculated amount as the sample was injected, with no 
conversion applied.

Inj Units Injection units specified on the Calibration page in Method 
Development mode. See “Calibration” on page 151.

Sample Conc Calculated amount multiplied by the conversion factor.

Sample Units Sample units specified on the Calibration page in Method 
Development mode. See “Calibration” on page 151.

Table 75.  Calibration Report Active View columns  (Sheet 1 of 2)

Column Description

Curve Type The type of curve used when calibrating the compound 
(linear, quadratic, or average response factor).

Average RF The average response factor. Applicable if curve type is 
Average RF.

Average Response The average response for the internal standard across all 
calibration points. Applies only to Internal Standard sample 
types.

A0 The value with no X. Applies only to linear and quadratic 
curves. 

A1 The X value. Applies only to linear and quadratic curves.

A2 The X^2 value. Applies only to quadratic curves. 

R^2 The minimum correlation coefficient (r2) for an acceptable 
calibration (when in linear or quadratic mode). 
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RSD Relative standard deviation. Applies only to internal 
standards and targets calibrated with an average RF curve.

Level The column specifies the level name; the field value 
specifies the data point used in calibration. This field can be 
Response Factor for external calibration, Response Ratio for 
internal linear or quadratic, or Relative Response Factor for 
Internal Average RF. There is one column for each level in 
the curve. If the batch uses an extended calibration, there 
might be more columns than calibration standards in the 
current batch.

Table 76. High Density Sample Report 1 and High Density Sample Report 1 Long Active View 
columns 

Column Description

m/z Mass-to-charge ratio for the quan peak.

Total Response The sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quan peak.

Quan Peak RT Retention time for the quan peak.

T Amount Theoretical amount of the compound. Reports N/A when not 
applicable.

Conc Calculated (injected) amount.

Table 77. High Density Sample Report 2 and High Density Sample Report 2 Long Active View 
columns  (Sheet 1 of 2)

Column Description

m/z Mass-to-charge ratio for the quan peak.

Total Response Sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quan peak.

Quan Peak RT Retention time for the quan peak.

T Amount Theoretical amount of the compound. Reports N/A when 
not applicable.

Conc Calculated (injected) amount.

Confirming 1 Mass Mass of the confirming peak.

Confirming 1 Response Response of the confirming peak.

Confirming 1 Manual Flag Indicates a manually integrated confirming peak.

Table 75.  Calibration Report Active View columns  (Sheet 2 of 2)

Column Description
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Confirming 1 Ion Ratio Flag Indicates that the ion ratio is out of range.

Confirming 1 Ion Ratio Actual ratio of the confirming ion response to the quan ion 
response.

Confirming 1 Range Acceptable range for the confirming ion.

Table 78. High Density Sample Report 3 and High Density Sample Report 3 Long Active View 
columns

Column Description

m/z Mass-to-charge ratio for the quan peak.

Total Response Sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quan peak.

Quan Peak RT Retention time for the quan peak.

T Amount Theoretical amount of the compound. Reports N/A when 
not applicable.

Conc Calculated (injected) amount.

Confirming 1 Mass Mass of the confirming peak.

Confirming 1 Response Response of the confirming peak.

Confirming 1 Manual Flag Indicates a manually integrated confirming peak.

Confirming 1 Ion Ratio Flag Indicates that the ion ratio is out of range.

Confirming 1 Ion Ratio Actual ratio of the confirming ion response to the quan ion 
response.

Confirming 1 Range Acceptable range for the confirming ion.

Confirming 2 Mass Mass of the confirming peak.

Confirming 2 Response Response of the confirming peak.

Confirming 2 Manual Flag Indicates a manually integrated confirming peak.

Confirming 2 Ion Ratio Flag Indicates that the ion ratio is out of range.

Confirming 2 Ion Ratio Actual ratio of the confirming ion response to the quan ion 
response.

Confirming 2 Range Acceptable range for the confirming ion.

Table 77. High Density Sample Report 2 and High Density Sample Report 2 Long Active View 
columns  (Sheet 2 of 2)

Column Description
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Table 79.  Internal Standard Summary Report Active View columns

Column Description

Std Response Average of the internal standard’s response as found in the 
calibration file.

Minimum Response Minimum response time as specified on the ISTD page in 
Method Development mode. See “ISTD” on page 166.

Maximum Response Maximum response time as specified on the ISTD page in 
Method Development mode. See “ISTD” on page 166.

Sample Response Area found in the sample.

Std RT Average retention time as found in the calibration file.

Min RT Minimum retention time as specified on the ISTD page in 
Method Development mode. See “ISTD” on page 166.

Max RT Maximum retention time as specified on the ISTD page in 
Method Development mode. See “ISTD” on page 166.

Sample RT Retention time found in the sample.

Table 80.  Ion Ratio Failure Report Active View columns

Column Description

Quan Ion The ion for quan peak.

Qual Ion The ion for the confirming peak.

Quan Ion Response Response of the quan ion.

Qual Ion Response Response of the qual ion.

Ratio The ratio of the confirming ion response to the quan ion 
response.

Range The acceptable range.

Table 81. Manual Integration Report Active View columns

Column Description

m/z Mass-to-charge ratio for the quan peak.

Method RT Apex retention time for the method-integrated peak.

Method Peak Height Height for the method-integrated peak.

Method Peak Area Area for the method-integrated peak.

Manual RT Apex retention time for the manually integrated peak.

Manual Peak Height Height of the manually integrated peak.

Manual Peak Area Area of the manually integrated peak.
346 TraceFinder User Guide Thermo Scientific



 6 Using the Data Review Mode
Working in Report View
Table 82.  LCSLCSD Report Active View columns (Environmental and Food Safety only) 

Column Description

Spike Amount Lab control theoretical concentration.

LCS Concentration Lab control spike concentration.

LCS % Received Lab control concentration percentage.

Lower Limit % Recovery lower limit as specified in the master method. See 
the Limits section in “Editing the Flags Page” on page 159.

Upper Limit % Recovery upper limit as specified in the master method. See 
the Limits section in “Editing the Flags Page” on page 159.

LCSD Concentration Lab control spike duplicate concentration.

LCSD % Received Lab control spike duplicate concentration percentage.

RPD Lab control relative percentage difference.

Max RPD Lab control spike maximum relative percentage difference 
(set in method).

Number of Rec Failures Number of recovery failures for lab control spike 
concentration and lab control spike concentration 
duplicate.

Number of RPD Failures Number of relative percentage difference failures for lab 
control spike concentration and lab control spike 
concentration duplicate.

Note  For LCSLCSD batch reports, the application displays the active view peak graphics 
only when you click a field pertaining to a sample, such as the LCS or LCSD 
concentration fields. 

Table 83. Manual Integration Report Active View columns

Column Description

m/z Mass-to-charge ratio for the quan peak.

Method RT Apex retention time for the method-integrated peak.

Method Peak Height Height for the method-integrated peak.

Method Peak Area Area for the method-integrated peak.

Manual RT Apex retention time for the manually integrated peak.

Manual Peak Height Height of the manually integrated peak.

Manual Peak Area Area of the manually integrated peak.
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Table 84.  Method Detection Limit Report Active View columns (Environmental and Food Safety 
only)

Column Description

Avg Conc The average of the concentration for the compound across 
all samples.

Std Dev The standard deviation of the concentration.

t-stat The t-statistic value defined as the ratio of a coefficient to its 
standard error. 

% RSD %RSD of concentrations

MDL Method detection limits. The calculated limit of detection.

Note  For Method Detection Limit batch reports, the application displays the active view 
peak graphics only when you click a field pertaining to a sample. These numbered fields 
are to the right of the MDL column.

Table 85.  Method Validation Report Active View columns (Environmental and Food Safety only)

Column Description

Avg Conc The average of the concentration for the compound across 
all samples.

Theo Conc Values for each compound that represent the expected 
theoretical concentration of that compound in the sample 
as defined in the master method. See the Meth Val section 
in “Editing the Flags Page” on page 159.

% Diff The percentage difference calculated as 
([MethodValidationMeanValue minus the Theo Conc] 
divided by the Theo Conc) multiplied by 100.

Min Conc Calculated by (Min recovery percent * Theo Conc) divided 
by 100.

Max Conc Calculated by (Max recovery percent * Theo Conc) divided 
by 100.

% RSD %RSD of concentrations

Max % RSD The maximum relative standard deviation (RSD) of the set 
of observed concentrations for a component across the set 
of method validation samples (when in average RF mode) as 
defined in the master method. See the Meth Val section in 
“Editing the Flags Page” on page 159. 

Calculated Amount <Sample 
Name>

This field is reproduced for every Method Val sample.
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Table 86.  MSMSD Report Active View columns (Environmental and Food Safety only)

Column Description

Unknown Concentration Concentration of the unknown sample.

Spike Amount Matrix spike theoretical concentration.

MS Concentration Matrix spike concentration.

MS % Received Matrix spike concentration percentage.

Lower Limit % Recovery lower limit as specified in the master method. See 
the Limits section in “Editing the Flags Page” on page 159. 

Upper Limit % Recovery upper limit as specified in the master method. See 
the Limits section in “Editing the Flags Page” on page 159.

MSD Concentration Matrix spike duplicate concentration.

MSD % Received Matrix spike duplicate concentration percentage.

RPD Matrix spike relative percentage difference.

Max RPD Maximum relative percentage difference as specified in the 
master method. See the Lab Control section in “Editing the 
Flags Page” on page 159.

Number of Rec Failures Number of matrix spike and matrix spike duplicate failures.

Number of RPD Failures Number of relative percentage difference failures.

Note  For MSMSD batch reports, the active view peak graphics are shown only when you 
click a field pertaining to a sample, such as Unknown, MS, or MSD concentration fields. 

Table 87.  Quantitation Report Active View columns  (Sheet 1 of 2)

Column Description

RT Retention time for the peak. The time after injection when 
the compound elutes. The total time that the compound is 
retained on the column. 

QIon Mass range for the quan peak.

Response Sum of all quan peak response values for the compound.
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Injected Concentration Calculated amount as the sample was injected, with no 
conversion applied. 

As each additional sample is processed, calibration data 
change; therefore, except for the final sample in a batch, a 
report in active view or report view shows different values 
from a physical (PDF, XML, or printed) report created at 
the end of processing. To avoid this discrepancy, do one of 
the following:

• For the standard Quantitation Report or Quantitation 
Report - 2, observe the active or report view for only 
the last sample in the batch.

• For the custom Quantitation Report, make the report a 
batch-level report.

Injected units Injection units specified on the Calibration page in Method 
Development mode. See “Calibration” on page 151.

Sample Conc Calculated injection amount multiplied by the conversion 
factor. See the Injected Concentration description.

Sample units Sample units specified on the Calibration page in Method 
Development mode. See “Calibration” on page 151.

Table 88. Solvent Blank Report Active View columns

Column Description

RT Retention time for the quan peak. The time after injection when 
the compound elutes. The total time that the compound is 
retained on the column. 

QIon Mass range for the quan peak.

Response Sum of all Quan Peak Response values for the compound.

Method Method of evaluation defined in the method.

Upper Limit Defined in the method.

Table 87.  Quantitation Report Active View columns  (Sheet 2 of 2)

Column Description
350 TraceFinder User Guide Thermo Scientific



 6 Using the Data Review Mode
Working in the Local Method View
Working in the Local Method View 
A local method is a copy of a master method associated with a batch. You can edit only the 
local copy of the method, or you can edit the master method and overwrite the local copy 
with the edited master method.

In the Local Method view, you can edit the local method parameters. A local method is a copy 
of a master method associated with a batch. Local methods are named 
BatchName_MasterMethodName. 

 To open the Local Method View

1. Do one of the following:

From the dashboard, click Data Review.

–Or–

Click Data Review in the navigation pane.

2. In the Data Review navigation pane, click Local Method.

The Local Method view for the currently selected batch opens. 

You can edit many of the method parameters in a local method. Editing the local method 
does not affect parameters in the master method.

For detailed descriptions of method parameters, see “Working with Master Methods” on 
page 88.

3. Enter any local changes to the method.

4. When you have finished editing the local method, choose File > Save.

5. To process the batch or create new reports with the edited local method, return to the 
Batch View and submit the batch.

 To overwrite the local method with the master method in the Batch View

In the Batch View, click Update.

The application overwrites the local method with the master method of the same name. 
You can use this feature to overwrite an edited local method with the original master 
method or to overwrite the local method with an updated master method.
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Figure 85. Local Method View
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A

Reports

This appendix contains information about standard and custom reports.

The report engine can generate several different types of reports designed to meet the needs of 
the laboratory, the laboratory's customers, and key regulatory agencies that might review the 
results. The reports listed in this appendix meet the requirements of various methods and 
worldwide regulatory agencies and are designed to help track the performance of the system 
and method. The TraceFinder application can produce both standard reports and custom 
reports.

Specifying Reports
As a user in the ITAdmin or LabDirector role, you can configure a list of reports that are 
available for the Method Development or Acquisition mode. 

For detailed information about configuring reports in the Configuration mode, see 
“Specifying the Reports Configuration” on page 58.

For detailed information about specifying reports when you create a method in the Method 
Development mode, see “Editing the Reports Page” on page 173.

For detailed information about viewing batch reports in the Acquisition mode, see “Selecting 
and Reviewing Reports” on page 233.

Contents

• Specifying Reports

• Report Flags

• Sample Standard Reports
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Standard Reports

For each standard report you generate, you can create a version in hardcopy print, as a PDF 
(.pdf ) file, or in an XML (.xml) output format. In addition to the report type, you can specify 
a report description for each of your reports. The default report description is the report 
name.

The TraceFinder application can generate the following types of standard reports:

• Batch Report 
• Batch Report Rev 1
• Blank Report 
• Calibration Report 
• Check Standard Report 
• Chromatogram Report 
• Compound Calibration Report 
• Compound Calibration Report - Alternate
• Confirmation Report 
• Confirmation Report 2
• High Density Calibration Report 
• High Density Internal Standard Report
• High Density Internal Standard Report Long
• High Density Sample Report 1 
• High Density Sample Report 1 Long
• High Density Sample Report 2 
• High Density Sample Report 2 Long 
• High Density Sample Report 3 
• High Density Sample Report 3 Long
• Internal Standard Summary Report 
• Ion Ratio Failure Report 
• LCSLCSD Report (Environmental and Food Safety only)
• Manual Integration Report 
• Method Detection Limit Report (Environmental and Food Safety only)
• Method Report 
• Method Validation Report (Environmental and Food Safety only)
• MSMSD Report (Environmental and Food Safety only)
• Quantitation Report 
• Quantitation Report - 2
• Solvent Blank Report 
• Surrogate Recovery Report 
• TIC Report 
• TIC Summary Report 

To view an example of each type of standard report, see “Sample Standard Reports” on 
page 357.
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Specifying Reports
Custom Reports

For each custom report you generate, you can create a hardcopy printout or an Excel 
Macro-Enabled Workbook (.xlsm) output file. The default report description is the report 
name. 

A user in the ITAdmin or LabDirector role can configure custom reports to generate a single 
report for an entire batch or to create separate reports for each sample. Rather than creating 
separate reports for each sample, this method uses data from only the last sample to create a 
single report for the entire batch.

The TraceFinder application includes the following custom reports:

• AltCalibrationReport
• Alternate BatchReport
• Alternate CalibrationReport
• Alternate ConfirmationReport
• Alternate MatrixSpikeReport
• Alternate SampleReport
• Alternate SummaryReport
• BatchReport
• BlankReport 
• CalibrationDensityReport 
• CalibrationReport 
• CheckStandardReport 
• CompoundCalibrationReport 
• ConfirmationReport 
• ConfirmationReport2
• HighDensitySampleReport1Long
• HighDensitySampleReport2Long
• HighDensitySampleReport3Long
• HighDensitySampleReport4
• HighDensitySampleReport5
• QuantitationReport
• SteroidAnalysisReport

Target Screening Reports

• Target Screening Long Report
• Target Screening Summary Report
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Report Flags
When generating or viewing a report, you might see one of the following quantification or 
calibration flags listed on the page. 
 

A flags failure is identified by an asterisk (*), a shaded row, or the word Fail.

Values on a report that are the result of a manual integration use an uppercase M to signify a 
manually integrated quantification ion and a lowercase m to signify a manually integrated 
qualifying/confirming ion. On alternate reports, manual integration uses a black box around 
the value. 

Table 89. Quantification flags

Flag Definition

b Compound was observed at a concentration in a Matrix Blank sample above the 
specified limit. 

s Compound was observed at a response in a solvent blank sample above the specified 
limit. 

J Compound was observed at a concentration above the limit of detection, but below 
the limit of quantitation. 

I or * Confirming/qualifying ion ratio for a compound was observed outside the target 
ratio range or the coelution between quantification and confirming/qualifying ion 
was larger than acceptable limit. 

C Compound was observed at a concentration above the specified carryover limit. 
? Compound was observed at a concentration above the specified linearity limit. 
D Compound was observed at a concentration below the specified limit of detection. 
Q Compound was observed at a concentration below the specified limit of 

quantitation. 
POS Compound was observed at a concentration above the specified cutoff. 

Table 90. Calibration flags

Flag Definition

D Calibration for this compound exceeded the specified maximum percent relative 
standard deviation (%RSD). 

F Response factor for this compound was below the specified minimum response 
factor (Min RF). 

R Calibration for this compound was below the specified minimum correlation 
coefficient (r2). 

A Back calculation of the calibration points for this compound exceeded the 
specified maximum percent difference (Max %D). 

X Calibration point for this compound was excluded from the overall calibration 
by manual selection. 

X(ISNF) Calibration point for this compound was excluded from the overall calibration 
because its associated internal standard was not found. 
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Sample Standard Reports
This section shows samples of the following standard report types: 

• Batch Report
• Batch Report Rev 1
• Blank Report
• Calibration Report
• Check Standard Report
• Chromatogram Report
• Compound Calibration Report
• Compound Calibration Report - Alternate
• Confirmation Report
• Confirmation Report 2
• High Density Calibration Report
• High Density Internal Standard Report
• High Density Internal Standard Report Long
• High Density Sample Report 1
• High Density Sample Report 1 Long
• High Density Sample Report 2
• High Density Sample Report 2 Long
• High Density Sample Report 3
• High Density Sample Report 3 Long
• Internal Standard Summary Report
• Ion Ratio Failure Report
• LCSLCSD Report (Environmental and Food Safety only)
• Manual Integration Report
• Method Detection Limit Report (Environmental and Food Safety only)
• Method Report
• Method Validation Report (Environmental and Food Safety only)
• MSMSD Report (Environmental and Food Safety only)
• Quantitation Report
• Quantitation Report - 2
• Solvent Blank Report
• Surrogate Recovery Report
• TIC Report
• TIC Summary Report

Tip  To easily view reports in landscape format, choose View > Rotate View > Clockwise 
from the Adobe Acrobat viewer menu. 
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 A Reports
Sample Standard Reports
Calibration Report 
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,� ,� ,- �.-
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��������

�������+�

����0����� ���0

+1���������

�������

/���� �.-

2��/!

3 ��+�"3 ��� & ��� ���-��$ 14�-��� ��4444

3���
���� & ��� (�##4�$ 1-��#(�- ��4444

����������� & ��� ���(��$ 15�-���� ��4444

!�����6���� & ��� 5�4�5�# 1(��45�� ��444$

,�������"/3 & ��� 5�###�# 1��4'5�� ��444�

����������� & ��� -�4$(�$ ���4#�- ��444�

�+�����7��� & ��� ��#$5�$ 1��'-$�- ��4444

,�������"/3- & ��� ��(�#�$ 1-�#((�� ��4444

3 ��+� & ��� '�(#(�# 14�('$�� ��4444

���
��+� & ��� $�'�4�# -�#�'�1- ��4445 ,,

���������� & ��� '��5�( 1'�--��1� ��4444

3!�/ & ��� ��$$4�$ 1(���4�� ������
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8 & ��� ��$$#�$ 15�(�� ������
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�����
� �� & ��� 4�-�5�# 15��'5�� ��4444

����������
�� & ��� -�$#'�$ (��#��� ��4444

������������ & ��� 4�#�-�# 1��$#-�� ��4444
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������� & ��� '�544�# 1-����� ��4444
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�������7��� & ��� -�(�5�$ 1(�5-4�� ��4445

(13�"�����6���� & ��� -�'�(�$ 1$�#55�� ��4444

,���������� & ��� ��#'$�$ 1��-(#�- ��4444

�+�� ���� & ��� ��4���# 1-��4(�� ��4444

%
��������� & ��� ��5�#�$ 1(��#(�� ��4445

���
����
���"3, & ��� -�#$-�$ 1#�(-��� ��4444

,������� & ��� 4�����# 15���'�� ��4444

,7���
��"��"3, & ��� ���--�# 1��5�5�� ��444(

�������7�� & ��� ��-5$�$ 1'�'$5�� ��4445

/���7��� & ��� $�'#��# 1#��#5�� ��444�

����� ��"9/: & ��� -�'##�$ 1��$�4�� ��4444

���������� & ��� #��--�$ 1#��5-�� ��4445


��������� & ��� ��#4��$ 1'�5�5�� ��444�

�����6���� & ��� �����$ 1-�-5'�- ��4445
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��"/3 & ��� ��$--�# 14�'#(�1� ��4445 ,,
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����� & ��� 5�#'��$ 1-�'��- ��4445

����� �� & ��� '�$�'�$ 1����5�- ������

/��6�����7��� & ��� ��(�#�# 1��5('�� ��4445
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������+� & ��� #�-$��$ 1#�5��� ��4444

%
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�
�����"/��6� ��� & ��� (�5'��$ 1���((�- ��4445

���6����7��"!� & ��� #�45��# 1��-�4�� ��4445
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�����"/��6��� & ��� -�4$4�$ 1(�54�� ������

,���7��� & ��� (�'�4�$ 1���(�- ������

���������� & ��� 4�'5$�# (�5$5�� ��444'

���7���� & ��� ��5((�# 1#��##�� ������

������ +� & ��� 5�-(#�$ '�5$-�� ��4444

!����� & ��� 5�#4$�# 1��-�5�� ��4444

���6����7�� & ��� $�$�(�# 14���$�� ��4444

�
����������������� & ��� -�4#��# 1��'�� ��444'

,7���
��"�� & ��� ��4�-�# 1��$5$�� ������


��� ���� & ��� ��(((�# 15�5-��1� ��4444

��������� & ��� $���(�$ 1��'�-�- ��4444

�+�����
���� & ��� #��5(�# 1��(�(�� ��4444

,7� +������� & ��� ��4##�$ 1(�-'5�- ������

�������+�����0�����

������������6��0�	�!;�/!<��;���������6�����<��;�.-<�,;,�����<=;> ������<�=9�/��:;> ����������������/%!�?���@��6�����
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A Reports
Sample Standard Reports
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3 ��+�"3 ��� & #(��4�4 5-(4��5 �'-#-'-( -(5�(4�# (45-���( '����(5� ��$'-#44#

3���
���� & ��'�(-- (#5##�4 '4('��5 ����4#5� �'$'-'$# -$(�5�-# #�'4-���

����������� & �#5(4�4( -5��#��( $$��(�#� 5(�(#�5� �#�(-5(5� -�$#5�$�� #�5�4-�-4

!�����6���� & �4$�#'- (�$#�(� ��-#�#� ��#(�5�$ �'�$(54- -#-5'��$ #�44#5(5

,�������"/3 & �5��554 (#(�5(( ''$$$-$ ���'('5# �'##5��$ -#$-4�-# #'�$$-$$

����������� & #45�$5' 4��#�(� -(#-'5�( ((#-�-4� '-(-$5(( ��44�5-�- -((�#��'5

�+�����7��� & 5-�$�# �#4�5(- -5$��$� #-5$'#� '4��#$� ��$'5�(# �4�5$-�4

,�������"/3- & -��(�'' $-#��## ��-'(�'4 �$-('#'4 -$�(#�4- (4�$#4$$ �(5(4-�4

3 ��+� & �('�(-� -$'(�#� #4$-'�# �$((#�5 �-#-''#� �4-��-�� ('���54�

���
��+� & -�(�$(� #4(45�� 4��$-4$ �(#$--(5 --�5(5-# ($(4���' ��4(�'�-

���������� & (4�$'# 5�--(5 �'-'-'' -(-#4#� (5�'$4( $4�$44' ���-$#��

3!�/ & �''-4$� (���(#5 '�#4$�� 4-�$#�$ �$(5�4�# -(5#$�(' #'�#�(�4

$13�"%
8 & �$'(��' (�-#'�� '��('�( 4�$�4�4 �#�$5�-( --'#�-�4 #�-##($�

%
�����
� �� & #�(5(4 4���55 �5-(4�� -''-('� ##54((5 '�4��($ �-'''(#�

����������
�� & -'�''-( $(--($4 ��-�-(�( �$#�$##' -$'5��5' #�###��- 5�4��('�

������������ & �4'�'�# (5-$�'' �((4(�$ ���'54�� �5#$�4-' -5-�5#5- $(4$��($

����
������� & ��##(� �(����- -��$��� #��$5'' '5#($�( ��(4�'�# -��(#�#-

%
�������7��� & -(4$((� #�$'(�$ 4-(5$'# �('4��-4 -((4�(�- ($$44�'$ ��((#$��

(13�"�����6���� & $'(�'55 ���4�5(� -��(-�$� (�$$5�5- $�5(54'5 �4�5('5- �#5�-�-��

,���������� & ������ �#54�'� -5$��'' #-54'$# ��#(--4 ��5���(� -�-54�'$

�+�� ���� & (���#� �$'�(� �#4�455 -(�''4# (�55(�5 $5�5'(4 ��(�'�#�

%
��������� & 4#�(�� �5#-(�� ($5�-#� $$$��#- 4�4�$$- �(4#(�$' -�4$#��'

���
����
���"3, & $�($$-� 4��('-$ �54�-54- -4���'#( #�5'$'$# �($$�#�5 �(4-4-���

,������� & �4���55 (5#-#'' �(�''4' �����5-4 ��455#�� -5�-�(5- $$�-�'�4

,7���
��"��"3, & �'$(��' (-�44�5 '(���-- 4(5��4- �$��4##- --�'�'5� #-�(�-��

�������7�� & �(5-(-4 -$4�$�# $�(#4�� �$#($#' �-#-4�$� �5$'(#�( (#(((�4�

/���7��� & '��$5' ��$(5#� -�4$�-( (-4�'$( $(#'-�- �5#'-#- �(4-�5(4

����� ��"9/: & $$����- ��$$4�$� -�'4��'4 (�445$($ $�$-�4#4 �'�5#��� �(5$'(�--

���������� & -�(��--# (55��(�� �'�#-�(5 ��#5�(��# �5(-��$## -5��4(-5' $(5('54('


��������� & �'��4$� (�#-((( $4(�''� 54���(4 �###'''� -�'4�(-� #��544(�

�����6���� & �(�#(4� �#�(4$4( -���-4'' #���4�(4 '4(�5��4 ��#$-#$�( -���5��(5

�������
��"/3 & �-�(�� (��''� $5'(�- 5'45�# �$-5$$' -#($#�# #�''55#

%����
����� & #(4#(�5 5'#-55- �''��#�4 -$-54'(� #-''�$'$ '$�(-5�$ �-5'5�4�5

����� �� & '$(#5�� �-4�$4'$ -$'�'5'' (5��55�$ '(5�'4$� 44$5��$( �4�'5�4#�

/��6�����7��� & -�445� $'-4'� ��#�5�$ �'$'4$- -�-�5�4 #�'�4�� 5�#5$$#

�������
��"/3- & 5(�-'5 ��#5�$5 (#55$## $(#$$'- 54�$55# �('4-4$5 -'�#'4'(

������+� & ##�((�' 5'-#�-( ���#(4-� -$'�-'�$ #-$$'(�# '$4#((5' �(���4#(4

%
�������� & #4�-'� �-#5#�4 (-�(#�( #5-$(4( �5(�4## �--4-'4$ -(55��#5

�
�����"/��6� ��� & #�$4�(( ��'$'�5 �$(5--#' -(�5#(�� (5(($5�' $5-�''�� ��(�-$-4-

���6����7��"!� & ��$-#'$ �45'�-( (45(��� $�4-4�- 4��#((# �##5(�'' -'4$�4��

�������+�����0�����

������������6��0�	�!;�/!<��;���������6�����<��;�.-<�,;,�����<=;> ������<�=9�/��:;> ����������������/%!�?���@��6�����

���*��%+��	�,;,*���0����<��;������<�&;&��������<�;�����������������<�����	�,�������������+���6���������������������������������
���/%!����������
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 A Reports
Sample Standard Reports
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������������������

������������ 

�!�"�#�$��

��������"�!�"�#�$��

��������

%&���'(�)���

%&���'(�

%
��������

������������!���/������������*�����������/�������!E�������

��=�3&"���(����- ��=�3&"���(���� (F��F-����'	�'	((����=�3&$

�-=�3&"���(����( �-=�3&"���(���� (F��F-����'	-'	-4���-=�3&$

�#=�3&"���(����# �#=�3&"���(���� (F��F-����'	#'	-(���#=�3&$

�'=�3&"���(����$ �'=�3&"���(���� (F��F-�����	�'	�����'=�3&$

���=�3&"���(����' ���=�3&"���(���� (F��F-�����	-'	�������=�3&$

��'=�3&"���(����� ��'=�3&"���(���� (F��F-�����	#'	�$����'=�3&$

�(-=�3&"���(����5 �(-=�3&"���(���� (F��F-����5	�'	�(���(-=�3&$

�������+�����0�����

������������6��0�	�!;�/!<��;���������6�����<��;�.-<�,;,�����<=;> ������<�=9�/��:;> ����������������/%!�?���@��6�����

���*��%+��	�,;,*���0����<��;������<�&;&��������<�;�����������������<�����	�,�������������+���6���������������������������������
���/%!����������
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A Reports
Sample Standard Reports
Calibration Density Report 
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 A Reports
Sample Standard Reports
Check Standard Report
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A Reports
Sample Standard Reports
Chromatogram Report 
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 A Reports
Sample Standard Reports
Compound Calibration Report 
�
�
0
A
�B
��
6�
�

�
�
�
�
�
�
�
	

�
�
���

�
��
�
�

�
�
�
�

�

�
�
�

�
�
�
�
�

��
�
�

�
�
�
�
��

�
�
�

�

�
�
�
�
�
�
�
�
��
�
�

�
�
�

�
�

�
�
�

�
�
�
�
�
�
�
�

 
�
�!
�
�

�
"
"
#
�
�
�
"

$
�
��
�
	
�

�
�
��

)
���

�
"
"
#
�
�
�
"
*
�
+
�
*
�
,
�
-
"
"

�
"
"
#
�
�
�
"
.!
�
�/

�
+
�
*
�
,
�
-
"
"

+
��
�
��
%�

�
�

�
�
�
�
�
�
�
	

�
�
�
�
�

�
�
�!

&
�
�

�'

&
�
�
�
�
�

'
�	

&
�
�
�
�
�

�
�
(
�
�

�
�
�
�

�
�
�
	

�
��
!

�
�
��
�

)

�
*

)

�
'
+

'
�	

&

�
�

�
�
�
�
�
�
�
�

%
�
!
��



�'

&

�
�

"
+
�
6
�

�
�
.�
�

"
,
-
�
,
�
�

,
�
-
�
�
."
�
�

�
�
.�
"

�
�
 

�
.&

�
.&

�
+
�
6
�

,
�
.�
�

�
�
-
,
"
�
"

,
�
-
-
�
.�
-
,

,
�
.-
-

�
�
 

�
.&

�
.&

,
+
�
6
�

-
�
.�
�

�
"
�
,
�
,
"

-
,
�
-
,
.�
�
�

-
�
.�
�

�
�
 

�
.&

�
.&

�
+
�
6
�

"
�
�
.�
�

"
�
,
�
�
-
"
-

-
�
,
�
�
.,
-
�

"
�
�
.-
,

�
�
 

�
.&

�
.&

"
�
+
�
6
�

�
�
�
.�
�

"
�
�
-
�
-
,
�

-
�
�
�
,
.,
�
"

�
�
,
.�
�

�
�
 

�
.&

�
.&

"
�
+
�
6
�

�
�
�
.�
�

�
,
�
-
�
�
�
-

�
-
-
,
�
.�
�
�

�
"
"
.-
,

�
�
 

�
.&

�
.&

�
�
+
�
6
�

�
,
�
.�
�

,
"
,
,
,
-
�
-

�
-
�
"
�
.,
�
,

�
,
�
.�
,

�
�
 

�
.&

�
.&

$
�
�
�
�
��/

�
�
��
0

�
��
	
�

�
�
���

�
��
�
�

)
��
0
�
�

+

1
�
'
+
2

)

1

�
�
�
�
�
�
�
�

%
�
!
��

2

�

1

�

'
3
�
�

�
	
2

&

1

&
�
�
�
�
�

Thermo Scientific TraceFinder User Guide 367



A Reports
Sample Standard Reports
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 A Reports
Sample Standard Reports
Compound Calibration Report - Alternate
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A Reports
Sample Standard Reports
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 A Reports
Sample Standard Reports
Confirmation Report 
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A Reports
Sample Standard Reports
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A Reports
Sample Standard Reports
LCSLCSD Report (Environmental and Food Safety only)
IMPORTANT  When the Sample ID is the same for an unknown sample and an LCS or LCSD sample, the unknown 
sample is included in the LCSLCSD report. The report information for the unknown sample displays as zeros.

LCSLCSD Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 1

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
5ppb-002SampleID002 D008 New Dilutions 6/26/2007 H6/27/2007 1:25:44 AMN/ATray1:16
500ppt-002SampleID002 D002 New Dilutions 6/26/2007 H6/26/2007 9:47:43 PMQCTray1:9
Cal002SampleID002 D002 New Dilutions 6/26/2007 H6/26/2007 6:09:47 PMc2Tray1:3
5ppb-001SampleID008 D008 New Dilutions 6/26/2007 H6/27/2007 12:54:35 AMN/ATray1:15
500ppt-001SampleID008 D008 New Dilutions 6/26/2007 H6/26/2007 9:16:35 PMQCTray1:8

Compound Spike Amt
Lower 
Limit % 

Upper
Limit % % Rec RPD

Max 
RPD

Rec 
Fails

RPD 
Fails

LCSD 
Conc

SampleID002

DIA 0.500 50.00 150.00 0.00 50.00 50.00 0 04.712
DEA 0.500 50.00 150.00 0.00 50.00 50.00 0 05.065
Cyanazine 0.500 50.00 150.00 0.00 50.00 50.00 0 05.127
Simazine 0.500 50.00 150.00 0.00 50.00 50.00 0 04.862
Atrazine 0.500 50.00 150.00 0.00 50.00 50.00 0 05.184
Propazine 0.500 50.00 150.00 0.00 50.00 50.00 0 03.829

Compound Spike Amt % Rec
Lower 
Limit % 

Upper
Limit % % Rec RPD

Max
RPD

Rec 
Fails

RPD 
FailsLCS Conc

LCSD 
Conc

SampleID008

DIA 0.500 4.754 0.00 50.00 150.00 0.00 0.00 50.00 0 04.712
DEA 0.500 4.960 0.00 50.00 150.00 0.00 0.00 50.00 0 05.065
Cyanazine 0.500 5.218 0.00 50.00 150.00 0.00 0.00 50.00 0 05.127
Simazine 0.500 4.839 0.00 50.00 150.00 0.00 0.00 50.00 0 04.862
Atrazine 0.500 5.178 0.00 50.00 150.00 0.00 0.00 50.00 0 05.184
Propazine 0.500 3.829 0.00 50.00 150.00 0.00 0.00 50.00 0 03.829

Manually integrated
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 A Reports
Sample Standard Reports
Manual Integration Report 

������������	���
�����
���

���������

�����������

����� ������������

����������

��������

��	����� �!

"��#�� ���$����

�����%�

���
�)
���

���$����*�+�*�,�-��

���$����.#��/

�+�*�,�-��

�������)
���+���&��
���������'��)
�������&��
����+(
������

��!)�*�*$�������+ ��!)�*�*$������� �,��,!����+����������!)�*�-

�-*$*����� ����

�,+�!�!��

�����%�����	���
��

8
�/����

$�
	���

8����

�����������	���
��

8
�/����

$�
	���

8���� .,.��.�!

�.�,

���,����

�.�,

!�.-��-�

�,/�����.�+
Thermo Scientific TraceFinder User Guide 385



A Reports
Sample Standard Reports
Method Detection Limit Report (Environmental and Food Safety only) 
Method Detection Limit Report

Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Method Detection Limit Summary
Compound Avg Conc Std Dev t-stat % RSD MDL

DIA D-5 290218 0 0.00  IS

DIA 0.095 0.000 0.000 0.00 <<<0.000

DEA D-7 1704578 0 0.00  IS

DEA 0.065 0.000 0.000 0.00 <<<0.000

Cyanazine D-5 2204710 0 0.00  IS

Cyanazine 0.062 0.000 0.000 0.00 <<<0.000

Simazine D-10 513521 0 0.00  IS

Simazine 0.168 0.000 0.000 0.00 <<<0.000

Atrazine D-5 2292164 0 0.00  IS

Atrazine 0.023 0.000 0.000 0.00 <<<0.000

Propazine -1069.216 0.000 0.000 0.00 <<<0.000

Propazine D-14 826 0 0.00  IS

Manually integrated
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 A Reports
Sample Standard Reports
Method Detection Limit Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 2 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

1Compound
Method Validation Report Data

DIA D-5 290218
DIA 0.095
DEA D-7 1704578
DEA 0.065
Cyanazine D-5 2204710
Cyanazine 0.062
Simazine D-10 513521
Simazine 0.168
Atrazine D-5 2292164
Atrazine 0.023
Propazine -1069.216
Propazine D-14 826

Manually integrated
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A Reports
Sample Standard Reports
Method Detection Limit Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 3 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
Cal007SampleID007 D007 New Dilutions 6/26/2007 H6/26/2007 8:45:28 PMN/ATray1:1

Manually integrated
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Sample Standard Reports
Method Report 
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A Reports
Sample Standard Reports
Method Validation Report (Environmental and Food Safety only)
Method Validation Report

Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Method Validation Summary
Compound Avg Conc Theo Conc % Diff Min Conc % RSD Max % RSDMax Conc

DIA D-5 295652  IS0.00

DIA 0.358 0.500 -28.34 0.250 20.000.750 0.00

DEA D-7 1778658  IS0.00

DEA 0.602 0.500 20.45 0.250 20.000.750 0.00

Cyanazine D-5 2224244  IS0.00

Cyanazine 0.565 0.500 12.90 0.250 20.000.750 0.00

Simazine D-10 505462  IS0.00

Simazine 0.607 0.500 21.49 0.250 20.000.750 0.00

Atrazine D-5 2334865  IS0.00

Atrazine 0.512 0.500 2.46 0.250 20.000.750 0.00

Propazine 0.757 0.500 51.41 0.250 20.00 <<<0.750 0.00

Propazine D-14 272050  IS0.00

Manually integrated <<< = Failure
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 A Reports
Sample Standard Reports
Method Validation Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 2 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

1Compound
Method Validation Report Data

DIA D-5 295652
DIA 0.358
DEA D-7 1778658
DEA 0.602
Cyanazine D-5 2224244
Cyanazine 0.565
Simazine D-10 505462
Simazine 0.607
Atrazine D-5 2334865
Atrazine 0.512
Propazine 0.757
Propazine D-14 272050

Manually integrated <<< = Failure
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A Reports
Sample Standard Reports
Method Validation Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 3 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
500ppt-003SampleID003 D003 New Dilutions 6/26/2007 H6/26/2007 10:18:49 PMN/ATray1:10

Manually integrated <<< = Failure
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 A Reports
Sample Standard Reports
MSMSD Report (Environmental and Food Safety only)
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 A Reports
Sample Standard Reports
Quantitation Report - 2
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 A Reports
Sample Standard Reports
Solvent Blank Report 
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A Reports
Sample Standard Reports
Surrogate Recovery Report
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 A Reports
Sample Standard Reports
TIC Report
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A Reports
Sample Standard Reports
TIC Summary Report 
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B

Using Copy Down and Fill Down

This appendix describes the Copy Down and Fill Down commands that you can use to make 
entering column values easier.

• Use the Fill Down command for the Filename, Sample Name, Sample ID, and Vial 
Position columns.

• Use the Copy Down command for the Sample Type, Vial Position, Injection Volume, 
Conv Factor, Sample Level, and Comment columns.

Use the following procedures:

• To automatically copy column values

• To automatically enter sequential column values

• To use Copy Down or Fill Down for a range of samples

 To automatically copy column values

1. Select the cell whose value you want to copy to all cells below it.

Observe the difference between a selected and non selected cell. 

2. Right-click and choose Copy Down from the shortcut menu.

The value is copied to all rows below the selected row. 

 To automatically enter sequential column values

1. Enter a value for the first row of the fill down sequence.

This does not have to be the first sample row. You can begin the fill down procedure from 
any row in the sequence.

Selected 

Not selected 
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B Using Copy Down and Fill Down
2. Select the cell whose value is the first in the fill down sequence.

Observe the difference between a selected and non selected cell. 

3. Right-click and choose Fill Down from the shortcut menu.

The application enters sequential column values starting with the value in the selected 
row and ending with the last row in the column. 

You can repeatedly use the Fill Down command to create multiple sequences.

When you use the Fill Down command for the Vial Position column with an autosampler 
configured, the TraceFinder application knows the number of vial positions configured in 
your autosampler and numbers the positions accordingly. 

Selected 

Not selected 
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 B Using Copy Down and Fill Down
 To use Copy Down or Fill Down for a range of samples

1. To select a range of sample values, do one of the following:

Drag your cursor to select a contiguous group of sample values.

–Or–

Hold down the SHIFT key to select a contiguous group of sample values.

2. Right-click and choose the appropriate command from the shortcut menu.

The column values are copied or entered sequentially starting with the value in the first 
selected row and ending with the last selected row. 
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C

Using Filter Criteria

The filter criteria tool is available from the compound datastore in the Configuration mode 
and the acquisition list in the Method Development mode. 

 To filter the compound list

1. To display only a filtered list of compounds, click the funnel button, , in the column 
header.

For each column, a list of filterable criteria is displayed. In all columns, your filter choices 
are All, Blanks, and NonBlanks. Other filter criteria are specific to the individual 
columns.

2. To create a custom filter based on compound values in a specific column, choose Custom 
from the column list.

The Enter Filter Criteria dialog box opens. See “Enter Filter Criteria” on page 408.

3. From the Operator list, select an operator.

4. From the Operand list, select an operand.

5. When all conditions are defined, click OK.

The complete filter string is displayed at the bottom of the dialog box, for example, 
chemical formula = Blanks.
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C Using Filter Criteria
Enter Filter Criteria
Enter Filter Criteria
The Enter Filter Criteria dialog box is specifically named for the column on which you are 
filtering. In this example, the selected column is the Compound Name column.

Figure 86. Enter Filter Criteria dialog box

Table 91. Enter Filter Criteria dialog box parameters

Parameter Description

And 
conditions

Requires meeting all filter criteria.

Or 
conditions

Requires meeting any of the specified filter criteria.

Add a 
condition

Adds a new, empty condition to the filter criteria.

Delete 
condition

Deletes the selected condition. Click the box at the left of the row to select 
the condition.

Operator The mathematical function applied to the operand.

Operand The arguments to which the operator is applied.
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Index
Symbols
.csv, defined  2
.meth, defined  2
.pmd, defined  2
.raw, defined  2
.xml, defined  2
# background scans parameter  75, 138
% Test parameter  155

A
Account number parameter  34
Acquire a new raw data file parameter  96
Acquisition command  25
Acquisition List page, Master Method View  114
Active parameter  120
Active View page  336
Add a condition parameter  408
Add a mass as new confirming ion command  148
Add command  80
Add compound command  52
Add Confirming Ion command  54
Add Group command  172
Add Quan Peak command  53
Add this mass to existing quan mass ranges command  148
Add to CDS command  98
Add user parameter  35
Amount parameter  151
And conditions parameter  408
Apply command  80
Area noise factor parameter  77, 140
Area scan window parameter  78, 141
Area tail extension parameter  78, 141
Area Threshold, event type  81
Assay type parameter  111
Associate a Raw Data File dialog box  99
Associate a Raw Data File parameter  99
automated background subtraction options  108
Automatically create the master method parameter  96

Autosampler Arm Configuration parameter  70
Avalon detection algorithm  71
Avalon Event List dialog box  80

B
background subtraction options  108
Background subtraction range option parameter  112
Baseline window parameter  77, 140
Batch Level parameter  59, 176
Batch view  262
Batch/Template Selection view  220
batches

Acquisition mode  216
calibration  238
Data Review mode  262
development batch  207

Best match method parameter  196
Blank page, Master Method View  163
Bunch Factor, event type  81

C
cal1-caln parameter  153
Calibration Curve page  304
Calibration Levels page, Master Method View  152
Calibration method parameter  196
Calibration page, Flags page, Master Method View  161
Calibration page, Master Method View  151
calibration standard (Cal Std) sample type, definition  259
Cancel changes parameter  35
Cancel command  80
Carryover limit parameter  160
CAS No parameter  120
Category parameter

Acquisition List  116
Compound Datastore  48

caution flags  289
Change command  80
check standard (Chk Std) sample, definition  259
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Index: C
Chemical Formula parameter
Acquisition List  116
Compound Datastore  48

Chk Std page, Master Method View  162
Collision Energy parameter

Acquisition List
confirming ion  118
quan peak  117

Compound Datastore
quan peak  49

compound datastore
confirming ion  50

commands
Acquisition  25
Add  80
Add a mass as new confirming ion  148
Add compound  52
Add Confirming Ion  54
Add Group  172
Add Quan Peak  53
Add this mass to existing quan mass ranges  148
Add to CDS  98
Apply  80
Cancel  80
Change  80
Configuration  26
Continue to Method  98
Copy down  403
Data Review  25
Delete  80
Enable Target Screening  83
Enable User Security  66
Exit TraceFinder  9
Fill down  403
Help, dashboard  25
Hide Internal Standard  298
Import Compounds  51
Import Published Method  198
Load Compound Datastore  46
Log Off  25
Methods  26
Modify Columns

Batch View  269
Data Review View  287

New Compound Datastore  46
Real Time Status  25
Reset scaling  148
Save As Compound Datastore  47
Save Compound Datastore  46
Set this mass as a new quan peak  148
Set this mass as quan mass  148
Show Internal Standard  298
Update confirming ion ratios with this spectrum  148

comma-separated values, defined  2
Compound Datastore Name parameter, Save Compound 
Datastore  47

Compound Datastore view  48
Compound Datastore, administration  44
compound datastore, enabling  67
Compound Name parameter

Acquisition List  116
Compound Datastore  48

Compound parameter
Calibration  151
Calibration levels  153
Calibration page  161
Chk Std page  162
Identification  119
ISTD page  166
Lab Control page  168
Limits page  160
Matrix Blank page  163
Matrix Spike page  170
Method Val page  169
QC levels page  155
Solvent Blank page  165
Surrogate page  167

Compound type parameter
Calibration  151
Identification  120

compound types
internal standards  119
quan  119
surrogates  119
target  119

Compounds page, Master Method View  114
compounds, importing to compound datastore  51
Configuration command  26
Configuration navigation pane  28
Confirming Ions page  308
Confirming n Ion Ratio Flag parameter  339
Confirming n Ion Ratio parameter  339
Confirming n Manual Flag parameter  339
Confirming n Mass parameter  338
Confirming n Range parameter  339
Confirming n Response parameter  339
Constrain peak width parameter

Genesis
application configuration parameters  74
method development  137

ICIS
application configuration  77
method development  140

Continue to Method command  98
Copy down command  403
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Index: D
Correct surrogates parameter  181
Create Master Method dialog box  89
Create method parameter  86
Create PDF parameter, standard reports  176
Create XLSM parameter  176
Create XML parameter, standard reports  176
Curve type parameter

Calibration  151
Method Template Editor  196

custom reports, list of  6
CV Test (%) parameter  166

D
dashboard parameters  25
Data Review command  25
Data Review view  284
Decimal places to be reported parameter  180
Delete command  80
Delete condition parameter  408
Detection method parameter

Avalon
application configuration  79
method development  142

Genesis
application configuration  73
method development  137

ICIS
application configuration  76
method development  140

Detection page, Master Method View  121
Detector parameter, Detection  133
Development Batch view  207
dialog boxes

Add Library  11
Associate a Raw Data File  99
Avalon Event List  80
Create Master Method  89
Edit Compound Dependent Parameters  98
Import an Xcalibur Method  97
Invalid Compound Datastore not saved  46
Open Chromatograph Reference Sample  109
Open Compound Datastore  46
Save Compound Datastore  47
Select Compounds to Add  103
Thermo Library Manager  11
Thermo Xcalibur Instrument Setup  107
Thermo Xcalibur Roadmap  10

Disable Cluster Off, event type  82
Disable Cluster On, event type  82
Display compounds above set limit parameter  180
Display Quan flags and legend parameter  180

Displayed Reports parameter
Environmental and Food Safety  65
General Quantitation  62

E
Edit Compound Dependent Parameters dialog box  98
Edit user parameter  35
Email address parameter  34
Enable Multiplexing Support parameter  70
Enable peak threshold parameter  196
Enable Target Screening command  83
Enable tune time tracking parameter  181
Enable User Security command  66
Enable valley detection parameter

application configuration  74
method development  137

Enabled parameter  34
End Threshold, event type  81
Energy Ramp parameter

application configuration  49
method development  117

Event parameter  80
Event types  81
Example parameter  176
Exclude matching quan peaks parameter  198
Exit TraceFinder command  9
Expected RT parameter, Detection  131
Expected width parameter

application configuration  74
method development  137

Experiment Type parameter
Acquisition List  116
Compound Datastore  48

experiment types  55
Export SRM data parameter  87
Extracted Ion Chromatogram  55

F
feature summary  3
file types, supported  2
Fill down command  403
Filter parameter, Detection  133
Finish view  237
Flag values above Carryover parameter  181
Flag values above LOR parameter  181
Flag values above ULOL parameter  181
Flag values below LOD parameter  181
Flag values below LOQ parameter  181
Flag values between LOD and LOQ parameter  181
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Index: G
Flags page, Master Method View  159
Force Cluster Off, event type  82
Force Cluster On, event type  82
Full name parameter  34

G
General page

Background subtraction range option  112
editing  106
Injection volume parameter  112
Instrument method parameter  112
Ion range calc method parameter  112
Number of scans to subtract parameter  112
Qualitative peak processing template parameter  112
Set chromatogram reference sample parameter  112
Set Reference sample parameter  112
Stepoff value parameter  112

General page, Master Method View  106
Genesis detection algorithm  71
Groups page, Master Method View  171

H
Help command, dashboard  25
Hide Internal Standard command  298

I
ICIS detection algorithm  71
Identification page, Master Method View  119
Import an Xcalibur Method dialog box  97
Import Compounds command  51
Import parameter

Environmental and Food Safety  65
General Quantitation  62

Import Published Method command  198
Import Xcalibur Processing Method parameter  97
Include compound peak spectrum as reference spectrum 
parameter  196

Include confirming ions parameter  196
Injection amount parameter  96
Injection concentration parameter  339
Injection Units parameter  339
Injection volume parameter  112
Installed Reports parameter

Environmental and Food Safety  65
General Quantitation  62

installing
NIST and QED libraries  10
TraceFinder  8

Instrument method parameter
General page  112
Method Forge  96

Instrument view  200
instruments, supported  viii
Invalid Compound Datastore not saved dialog box  46
Ion Overlay page  312
Ion range calc method parameter  112
Ionization parameter

Acquisition List  116
Compound Datastore  48

ISTD page, Master Method View  166
ISTD parameter  151
IT Administrator role  36

L
Lab Control page, Master Method View  168
lab control sample (LCS) type, defined  259
lab control sample duplicate (LCSD) type, defined  259
Lab name parameter  111
Lens parameter

application configuration  49
method development  117

Level parameter  155
licenses, types of  ix
Limit library hits parameter  196
Limit the retention time range parameter  196
Limits page, Master Method View  160
Load Compound Datastore command  46
Local Method view  351
LOD (Detection limit) parameter  160
Log Off command  25
logging on to TraceFinder  8
Login parameter  9
logon screen  9
LOQ (Quantitation limit) parameter  160
LOR (Reporting limit) parameter  160

M
Manual Flags parameter  338
Manual injection parameter  96
Mass parameter

confirming ion
Acquisition List  118
Compound Datastore  50

quan peak  49, 117
Master Method View

Acquisition List page  114
Blank page  163
Calibration Levels page  152
412 TraceFinder User Guide  Thermo Scientific



Index: N
Calibration page  151
Chk Std page  162
Compounds page  114
Detection page  121
Flags page, Calibration page  161
General page  106
Groups page  171
Identification page  119
ISTD page  166
Lab Control page  168
Limits page  160
Matrix Spike page  170
Method Val page  169
QC Levels page  154
Ratios page  149
Real Time Viewer page  156
Reports page  173
Solvent Blank page  165
Spectrum page  144
Surrogate page  167

Master Method View, Flags page  159
matrix blank sample type, defined  259
matrix spike (MS) sample type, defined  259
matrix spike duplicate (MSD) sample type, defined  259
Matrix Spike page, Master Method View  170
Max Amt Diff (%) parameter  161
Max Conc parameter  164
Max recovery (%) parameter

ISTD page  166
Lab Control page  168
Matrix Spike page  170
Method Val page  169
Surrogate page  167

Max RF Diff (%) parameter  162
Max RPD parameter

Lab Control page  168
Matrix Spike page  170

Max RSD (%) parameter
Calibration page  161
Method Val page  169
Surrogate page  167

Max RT (+min) parameter, ISTD page  166
method detection limits (MDL) sample type, defined  259
Method parameter

Matrix Blank page  164
Solvent Blank page  165

Method Template Editor  195
Method Val page, Master Method View  169
method validation sample type, defined  259
Method view  89

methods
importing Xcalibur  97
instrument  200
local  351
master  88
Method Template Editor  195
startup and shutdown  237

Methods command  26
Min peak height (S/N) parameter

Genesis  75, 138
ICIS  78, 141

Min peak width parameter  78, 141
Min recovery (%) parameter

ISTD page  166
Lab Control page  168
Matrix Spike page  170
Method Val page  169
Surrogate page  167

Min RF parameter  162
Min RT (-min) parameter  166
modes

choosing  22
defined  25

Modify Columns command
Batch View  269
Data Review View  287

Multiplet resolution parameter  78, 141
multiplexing, enabling  70

N
Name the master method parameter  96
Negative Peaks, event type  81
New Compound Datastore command  46
New instrument method parameter  87
New sample list parameter  87
NIST library, installing  10
Noise method parameter  78, 141
Number of Scans to Subtract parameter  108
Number of scans to subtract parameter  112

O
Only select top peaks parameter  196
Open Chromatograph Reference Sample dialog box  109
Open Compound Datastore dialog box  46
Open instrument method parameter  87
Open method parameter  86
Open Qual Browser parameter  87
Operand parameter  408
Operator parameter  408
Or conditions parameter  408
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Index: P
Origin parameter
Calibration  151
Method Template Editor  197

Overwrite parameter
Method Forge dialog box  96
Save Compound Datastore dialog box  47

P
parameters

# background scans  75, 138
% Test  155
Account number  34
Acquire a new raw data file  96
Active  120
Add a condition  408
Add user  35
Amount  151
And conditions  408
Area noise factor  77, 140
Area scan window  78, 141
Area tail extension  78, 141
Assay type  111
Associate a Raw Data File  99
Automatically create the master method  96
Autosampler Arm Configuration  70
Background subtraction range option  112
Baseline window  77, 140
Batch Level  59, 176
Best match method  196
cal1-caln  153
Calibration method  196
Cancel changes  35
Carryover limit  160
CAS No  120
Category

Acquisition List  116
Compound Datastore  48

Chemical Formula
Acquisition List  116
Compound Datastore  48

Collision Energy
Acquisition List

confirming ion  118
quan peak  117

compound datastore
confirming ion  50

quan peak
Compound Datastore  49

Compound
Calibration  151
Calibration levels  153
Calibration page  161
Chk Std page  162
Identification  119
ISTD page  166
Lab Control page  168
Limits page  160
Matrix Blank page  163
Matrix Spike page  170
Method Val page  169
QC levels page  155
Solvent Blank page  165
Surrogate page  167

Compound Name
Acquisition List  116
Compound Datastore  48

Compound type
Calibration  151
Identification  120

Confirming n Ion Ratio  339
Confirming n Ion Ratio Flag  339
Confirming n Manual Flag  339
Confirming n Mass  338
Confirming n Range  339
Confirming n Response  339
Constrain peak width

Genesis  137
ICIS  77, 140

Correct surrogates  181
Create method  86
Create PDF, standard reports  176
Create XLSM  176
Create XML, standard reports  176
Curve type

Calibration  151
Method Template Editor  196

CV Test (%)  166
dashboard  25
Decimal places to be reported  180
Delete condition  408
Detection method

Avalon  79, 142
Genesis  73, 137
ICIS  76, 140

Detector  133
Display compounds above set limit  180
Display Quan flags and legend  180
Displayed Reports

Environmental and Food Safety  65
General Quantitation  62

Edit user  35
Email address  34
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Index: P
Enable Multiplexing Support  70
Enable peak threshold  196
Enable tune time tracking  181
Enable valley detection

application configuration  74
method development  137

Enabled  34
Energy Ramp

application configuration  49
method development  117

Event  80
Example  176
Exclude matching quan peaks  198
Expected RT, Detection  131
Expected width

application configuration  74
method development  137

Experiment Type
Acquisition List  116
Compound Datastore  48

Export SRM data  87
Filter, Detection  133
Flag values above Carryover  181
Flag values above LOR  181
Flag values above ULOL  181
Flag values below LOD  181
Flag values below LOQ  181
Flag values between LOD and LOQ  181
Full name  34
Import

Environmental and Food Safety  65
General Quantitation  62

Import Xcalibur Processing Method  97
Include compound peak spectrum as reference 

spectrum  196
Include confirming ions  196
Injection amount  96
Injection concentration  339
Injection Units  339
Injection volume  112
Installed Reports

Environmental and Food Safety  65
General Quantitation  62

Instrument method
General page  112
Method Forge  96

Ion range calc method  112
Ionization

Acquisition List  116
Compound Datastore  48

ISTD  151
Lab name  111

Lens
application configuration  49
method development  117

Level  155
Limit library hits  196
Limit the retention time range  196
LOD (Detection limit)  160
Login  9
LOQ (Quantitation limit)  160
LOR (Reporting limit)  160
Manual Flags  338
Manual injection  96
Mass

confirming ion
Acquisition List  118
Compound Datastore  50

quan peak  49, 117
Max Amt Diff (%)  161
Max Conc  164
Max recovery (%)

ISTD page  166
Lab Control page  168
Matrix Spike page  170
Method Val page  169
Surrogate page  167

Max RF Diff (%)  162
Max RPD

Lab Control page  168
Matrix Spike page  170

Max RSD (%)
Calibration page  161
Method Val page  169
Surrogate page  167

Max RT (+min), ISTD page  166
Method

Matrix Blank page  164
Solvent Blank page  165

Min peak height (S/N)
Genesis  75, 138
ICIS  78, 141

Min peak width  78, 141
Min recovery (%)

ISTD page  166
Lab Control page  168
Matrix Spike page  170
Method Val page  169
Surrogate page  167

Min RF  162
Min RT (-min)  166
Multiplet resolution  78, 141
Name the master method  96
New instrument method  87
New sample list  87
Noise method  78, 141
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Index: P
Number of Scans to Subtract  108
Number of scans to subtract  112
Only select top peaks  196
Open instrument method  87
Open method  86
Open Qual Browser  87
Operand  408
Operator  408
Or conditions  408
Origin

Calibration  151
Method Template Editor  197

Overwrite
Method Forge dialog box  96
Save Compound Datastore dialog box  47

Password
logon screen  9
user administration  34

Path  96
Peak height (%)

Genesis  74, 137
ICIS  77, 140

Peak noise factor  77, 140
Peak S/N cutoff  75, 138
Percentage  164
Phone number  34
Polarity

Acquisition List  117
Compound Datastore  49

Precursor Mass
Acquisition List  116–117
Compound Datastore  49–50

Print, standard reports  176
Product Mass

Acquisition List  116–117
Compound Datastore  49–50

QAQC Flags  338
QC1-QCn  155
QIon  339
Qualitative peak processing template  112
Quan Flags  338
Quan mass  339
Quan peak m/z  338
Quan peak response  338
Quan peak RT  338
R^2 threshold  161
Ranges, compound detection  134
Raw filename  96
Recent Files (master methods)  87
Reference compound  120
Remove user  35
Report concentration  180
Report Name, standard reports  176
Report noise as  75, 138

Report Title, standard reports  176
Response  339
Response via

Calibration  151
Method Template Editor  197

Retention Time  339
RMS  78, 141
Role  34
RT

Acquisition List  117
Calibration  151
Calibration levels  153
Calibration page  161
Chk Std page  162
Compound Datastore  49
Identification  119
ISTD page  166
Lab Control page  168
Limits page  160
Matrix Blank page  163
Matrix Spike page  170
Method Val page  169
QC levels page  155
Solvent Blank page  165
Surrogate page  167

S/N threshold  74, 137
Sample comment  96
Sample Concentration  339
Sample file  337
Sample Units  339
Save changes  35
Select a custom template  96
Select a report  337
Select batch location  87
Select Compounds from CDS  103
Sensitivity

Avalon  79
Genesis  73, 137
ICIS  76, 140, 142

sensitivity  196
Separate ion overlay display  180
Set Chromatogram Reference Sample  109
Set chromatogram reference sample  112
Set Reference sample  112
Shade row when sample is outside of evaluation criteria  

180
Show chromatogram on Quantitation Report  180
Showing  337
Smoothing

Avalon  79
Genesis  73, 137
ICIS  76, 140, 143

Specify default ion ratio ranges  196
Standard type  151
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Index: P
Status  338
Stepoff value  112
Tailing factor

Genesis  74, 138
ICIS  77, 140

Theo Conc
Lab Control page  168
Matrix Spike page  170
Method Val page  169
Surrogate page  167

Theoretical amount  338
Time  80
Total response  338
Total rows  337
Trace, Detection  133
Tune file lifetime  181
ULOL (Linearity limit)  160
Units  151
Upper Limit  165
Use alternate calibration report format  180
Use an existing raw data file  96
Use as RT Reference  120
Use autosampler  96
Use data dependent scans  198
Use Genesis algorithm for qual processing  197
Use Method Forge  90, 93
Use the default template  96
Use these libraries  196
Username  9, 34
Valley rise (%)  75, 138
Valley S/N  75, 138
Value  80
Vial position  96
View width, Detection  72, 131
Weighting

Calibration  151
Method Template Editor  197

Window
Acquisition List  117
Compound Datastore  49
Detection  72, 131

Password parameter
logon screen  9
user administration  34

password, administrator  8
Path parameter  96
Peak height (%) parameter

Genesis  74, 137
ICIS  77, 140

Peak noise factor parameter  77, 140
Peak S/N cutoff parameter  75, 138
Percentage parameter  164
Phone number parameter  34

Polarity parameter
Acquisition List  117
Compound Datastore  49

P-P Threshold, event type  81
Precursor Mass parameter

Acquisition List  116–117
Compound Datastore  49–50

Print parameter, standard reports  176
procedures

acquisition mode
access real-time display  246
add samples to the samples list  224
assign a specific channel to a sample  229
create a batch template  223
export reports to a folder  234
import samples into the sample list  227
insert samples into the samples list  225
pause all batches in a queue  253
preview a standard report  233
re-inject a sample from  228
remove a batch from a queue  255
remove a pending batch from a queue  255
remove a pending sample from a queued batch  256
remove a single batch from a queue  254
remove all batches in a queue  254
remove all pending batches in a queue  254
remove pending samples from a queued batch  256
remove samples from the samples list  228
save a to-be-run batch  240
select a previously acquired batch  222
select a ready-to-acquire batch  221
select a template for a new batch  221
specify a calibration batch  238
specify device states  239
specify startup or shutdown methods  237
start a new batch  220
start an acquisition  240
view output files  243

configuration mode
access the Configuration mode  27
add a compound to the datastore  52
add a confirming ion to a quan peak  54
add a quan peak to a compound  53
add a user  30
change the default drive  40
choose a drive  40
copy the folder hierarchy from another drive  43
create a new compound datastore  46
create projects or subprojects  42
delete projects or subprojects  42
edit user information  31
enable multiplexing  70
enable user security  66
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hide a drive from display  41
import compounds  51
import new report types  59
open a compound datastore  46
open the Application Configuration view  56
open the Compound Datastore editor  45
open the Defaults page  68
open the Project Administration view  39
open the User Administration view  30
open the User Security page  66
refresh the drives display  41
remove a compound  52
remove a confirming ion  54
remove a user  33
remove all empty folders  43
save a datastore  46
save a datastore to a new name  47
specify common detection parameters  71
specify default laboratory and instrument names  69
specify default mass precision and intensity scale  69

data review mode
access the Data Review mode  261
add samples to the samples list  265
change the displayed information for a detected 

peaks  309
change the displayed information for detected peaks  

301, 320
change the library entry for a selected peak  323
copy a sample in the samples list  267
create a new batch  264
customize the column display  269, 287
display peaks for a specific compound  297, 314
display specific problems with a compound  297
display the internal standard for a compound  298
display the peak information window  310
edit sample values  268
edit samples in a batch  272
edit the batch-level output formats  275
edit the sample-level output formats  274
enlarge the report text  335
exclude a calibration point  291
export a report  334
insert samples in the samples list  266
make a compound active or inactive  290
manually add a peak

chromatogram pane  317
confirming ions  309
qual peak pane  319
quantification peak  300

manually exclude a calibration point  305
manually integrate a quan or qual ion  300
modify the peak detection settings  301
open a recent batch  272
open a saved batch  271

open the Data Review mode  284
open the Local Method View  351
open the Report View  325
print a report  333
reinject a sample  268
reinject a sample from a previously acquired batch  

272
remove a manually created peak

confirming ions  309
quantification peak  300

remove a peak from the peaks pane  315
remove a peak from the qual peak pane  320
remove samples from the samples list  267
scroll the samples list  286
search for text  335
select a compound  328
select a report

generating reports  330
viewing reports  326

select a sample
generating reports  331
viewing reports  328

sort the compounds list  296
submit all samples in the batch  278
submit selected samples  279
switch between method and manual integration

qual mode  320
quan mode  301

temporarily customize the column display
Batch view  270
Data Review view  286

zoom in on a peak
chromatogram navigation  317
confirming ions  309
ion overlay  312
qual peak  319
quantification peak  299
spectra pane  322

zoom in on an area
calibration curve  305
QED spectra  307
spectra  306

getting started
choose a node  22
display a log of instrument errors  23
install the NIST library  10
install the QED library  10
install the TraceFinder application  8
log on to the TraceFinder application  8
monitor the instrument status  23
start the TraceFinder application  8
watch the real-time display from the dashboard  24
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Index: Q
method development mode  152
access the Method Development mode  85
acquire selected samples  212
acquire the batch  212
add a compound to the list  115
add a mass as a new compound  126
add a mass as a new confirming ion  128
add a mass to the existing quan mass ranges  125
add a quan peak  126
add a quan peak to an existing compound  146
add compounds to the method  100, 122
add confirming ions to an existing compound  147
add ions to get an accumulated signal  146
add sample to the development batch  208
apply current peak detection settings

to all peaks in method  135
to all peaks that use the same detection mode  135

associate a raw data file with the method  99
automatically select compounds to create a new 

method  90
calculate and report semi-quantitative results  183
calibrate the compounds  191
change the compound reference spectrum  125
change the quantitation mass used for a quan peak  

144
copy a sample  209
correct surrogates  179
create a group  171
create a method template  188
create a new instrument method  201
create a new multiplexing instrument method  203
delete a compound from the list  115
edit the instrument method parameters  107
enter a note for the method  194
enter column values  210
export SRM data to an XML file  199
filter the displayed compounds  119, 122
identify the peaks  190
import a master method  198
import an instrument method  206
import an Xcalibur method  97
insert samples into the development batch  209
manually select compounds to create a new method  

93
open a saved master method  104
open a saved master method from the Recent Files 

list  105
open an instrument method  205
open the Development Batch view  207
open the Instrument View  200
open the Qual Browser  213
remove all samples from the samples list  211
remove selected samples from the samples list  211
replace a confirming ion  128

replace a quan mass  125
resize or reorganize the columns  211
save the method template  194
save the new method  128
select compounds from the datastore  102
set automated background subtraction options  108
specify a chromatogram reference sample  109
specify a location for development batch data  208
specify general information for a master method  106
specify ion ratio criteria  149
specify mass tolerance  110
specify no maximum concentration  163
specify peak criteria  189
specify QC levels and concentrations  154
specify qualitative peak processing  193
specify quantitation flag options  178
specify quantitation limits  177
specify ranges of ions for detection and integration  

132
specify standard report types and output formats  173
specify the default parameters  182
specify the exact mass window  184
specify the Exactive parameters  184
specify the ion ratio calculation method  184
specify the maximum concentration as a percentage  

163
specify the maximum concentration as an absolute 

value  163
specify user interface options  178
track the use of the tune file  179
update confirming ion ratios  144
zoom in the chromatogram or spectrum displays  147

Product Mass parameter
Acquisition List  116–117
Compound Datastore  49–50

Project Administration view  39
projects and subprojects, creating  39

Q
QAQC Flags parameter  338
QAQC role  38
QC Levels page, Master Method View  154
QC1-QCn parameter  155
QED library, installing  10
QED Spectra page  307
QIon parameter  339
Qual Mode  284
Qualitative peak processing template parameter  112
Quan Flags parameter  338
Quan mass parameter  339
Quan Mode  284
Quan peak m/z parameter  338
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Quan peak response parameter  338
Quan peak RT parameter  338
quan report settings, specifying  177, 182

R
R^2 threshold parameter  161
Ranges parameter, compound detection  134
Ratios page, Master Method View  149
Raw filename parameter  96
Real Time Status command  25
Real Time Viewer page, Master Method View  156
real-time display  246
Recent Files parameter (master methods)  87
Reference compound parameter  120
reference spectra  322
Remove user parameter  35
Report concentration parameter  180
report formats, specifying  173
Report Name parameter, standard reports  176
Report noise as parameter  75, 138
Report selection view  233
Report Title parameter, standard reports  176
Report View  325
reports

Acquisition mode  233
configuring  58
Data Review mode  325
flags defined  356
listed  5
sample PDFs  357
viewing landscape in PDF  357

Reports page, Master Method View  173
Reset scaling command  148
Response parameter  339
Response via parameter

Calibration  151
Method Template Editor  197

Retention Time parameter  339
RMS parameter  78, 141
Role parameter  34
RT parameter

Acquisition List  117
Calibration  151
Calibration levels  153
Calibration page  161
Chk Std page  162
Compound Datastore  49
Identification  119
ISTD page  166
Lab Control page  168
Limits page  160

Matrix Blank page  163
Matrix Spike page  170
Method Val page  169
QC levels page  155
Solvent Blank page  165
Surrogate page  167

S
S/N threshold parameter  74, 137
Sample comment parameter  96
Sample Concentration parameter  339
Sample definition view  224
Sample file parameter  337
sample types, defined  259
Sample Units parameter  339
Save As Compound Datastore command  47
Save changes parameter  35
Save Compound Datastore command  46
Save Compound Datastore dialog box  47
Select a custom template parameter  96
Select a report parameter  337
Select batch location parameter  87
Select Compounds from CDS parameter  103
Select Compounds to Add dialog box  103
Selected Reaction Monitoring  55
Sensitivity parameter

Avalon  79
Genesis  73, 137
ICIS  76, 140, 142

sensitivity parameter  196
Separate ion overlay display parameter  180
Set Chromatogram Reference Sample parameter  109
Set chromatogram reference sample parameter  112
Set Reference sample parameter  112
Set this mass as a new quan peak command  148
Set this mass as quan mass command  148
Shade row when sample is outside of evaluation criteria 
parameter  180

Shoulders On, event type  82
Show chromatogram on Quantitation Report parameter  180
Show Internal Standard command  298
Showing parameter  337
SIM experiment type  55
Single Ion Monitoring  55
Smoothing parameter

Avalon  79
Genesis  73, 137
ICIS  76, 140, 143

Solvent Blank page, Master Method View  165
Specify default ion ratio ranges parameter  196
420 TraceFinder User Guide  Thermo Scientific



Index: T
Spectra page  306
Spectrum page, Master Method View  144
SRM data, exporting  199
SRM experiment type  55
standard reports

listed  6
standard reports, list of  5
Standard type parameter  151
Start Threshold, event type  81–82
starting TraceFinder  8
Status parameter  338
Stepoff value parameter  112
Supervisor role  37
supported file types, defined  2
supported software and hardware  viii
Surrogate page, Master Method View  167
system requirements  viii

T
Tailing factor parameter

Genesis  74, 138
ICIS  77, 140

Tangent Skim, event type  82
target screening reports, list of  6
Technician role  37
templates

batch  223
method  188

Tension, event type  82
Theo Conc parameter

Lab Control page  168
Matrix Spike page  170
Method Val page  169
Surrogate page  167

Theoretical amount parameter  338
Thermo Xcalibur Instrument Setup dialog box  107
Time parameter  80
Total response parameter  338
Total rows parameter  337
Trace parameter, Detection  133
Tune file lifetime parameter  181

U
ULOL (Linearity limit) parameter  160
Units parameter  151
Unknown sample type, defined  259
Unknown/TIC sample type, defined  259
Update confirming ion ratios with this spectrum command  
148

Upper Limit parameter  165
Use alternate calibration report format parameter  180

Use an existing raw data file parameter  96
Use as RT Reference parameter  120
Use autosampler parameter  96
Use data dependent scans parameter  198
Use Genesis algorithm for qual processing parameter  197
Use Method Forge parameter  90, 93
Use the default template parameter  96
Use these libraries parameter  196
user accounts, creating  30
User Administration view  30
user roles and permissions  36
user roles, defined  36
user security, enabling  66
Username parameter  9, 34

V
Valley rise (%) parameter  75, 138
Valley S/N parameter  75, 138
Value parameter  80
Vial position parameter  96
View width parameter, Detection  72, 131
views

Batch  262
Batch/Template Selection  220
Compound Datastore  48
Data Review  284
Development Batch  207
Finish  237
Instrument  200
Local Method  351
Method  89
Project Administration  39
Report selection  233
Report View  325
Sample definition  224
User Administration  30

W
Weighting parameter

Calibration  151
Method Template Editor  197

Window parameter
Acquisition List  117
Compound Datastore  49
Detection  72, 131

workflow
acquisition mode  218
general  4

X
XIC experiment type  55
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